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Notice

While reasonable efforts were made to ensure that the information in this
document was complete and accurate at the time of printing, Avaya Inc.
can assume no liability for any errors. Changes and corrections to the
information in this document may be incorporated in future releases.

Documentation disclaimer

Avaya Inc. is not responsible for any modifications, additions, or deletions
to the original published version of this documentation unless such
modifications, additions, or deletions were performed by Avaya.
Customer and/or End User agree to indemnify and hold harmless Avaya,
Avaya's agents, servants and employees against all claims, lawsuits,
demands and judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation to the extent
made by the Customer or End User.

Link disclaimer

Avaya Inc. is not responsible for the contents or reliability of any linked
Web sites and does not necessarily endorse the products, services, or
information described or offered within them. We cannot guarantee that
these links will work all of the time and we have no control over the
availability of the linked pages.

Warranty

Avaya Inc. provides a limited warranty on this product. Refer to your
sales agreement to establish the terms of the limited warranty. In
addition, Avaya’s standard warranty language, as well as information
regarding support for this product, while under warranty, is available
through the following Web site:

http://www.avaya.com/support

Preventing toll fraud

"Toll fraud" is the unauthorized use of your telecommunications system
by an unauthorized party (for example, anyone who is not a corporate
employee, agent, subcontractor, or person working on your company's
behalf). Be aware that there may be a risk of toll fraud associated with
your system and that, if toll fraud occurs, it can result in substantial
additional charges for your telecommunications services.

Avaya fraud intervention

If you suspect that you are being victimized by toll fraud and you need
technical assistance or support, call Technical Service Center Toll Fraud
Intervention Hotline at +1-800-643-2353 for the United States and
Canada. For additional support telephone numbers, see the Avaya Web
site:

http://www.avaya.com/support

Providing telecommunications security

Telecommunications security (of voice, data, and video communications)
is the prevention of any type of intrusion to (that is, either unauthorized or
malicious access to or use of) your company's telecommunications
equipment by some party.

Your company's "telecommunications equipment” includes both this
Avaya product and any other voice/data/video equipment that could be
accessed via this Avaya product (that is, "networked equipment").

An "outside party" is anyone who is not a corporate employee, agent,
subcontractor, or person working on your company's behalf. Whereas, a
"malicious party" is anyone (including someone who may be otherwise
authorized) who accesses your telecommunications equipment with
either malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time-multiplexed
and/or circuit-based) or asynchronous (character-, message-, or
packet-based) equipment or interfaces for reasons of:

. Use (of capabilities special to the accessed equipment)

. Theft (such as, of intellectual property, financial assets, or
toll-facility access)

. Eavesdropping (privacy invasions to humans)

. Mischief (troubling, but apparently innocuous, tampering)

. Harm (such as harmful tampering, data loss or alteration,
regardless of motive or intent)

Be aware that there may be a risk of unauthorized intrusions associated
with your system and/or its networked equipment. Also realize that, if
such an intrusion should occur, it could result in a variety of losses to your
company (including, but not limited to, human and data privacy,
intellectual property, material assets, financial resources, labor costs, and
legal costs).

Your responsibility for your company's telecommunications
security

The final responsibility for securing both this system and its networked
equipment rests with you, an Avaya customer's system administrator,
your telecommunications peers, and your managers. Base the fulfillment
of your responsibility on acquired knowledge and resources from a
variety of sources, including, but not limited to:

. Installation documents

System administration documents

. Security documents

. Hardware-/software-based security tools

. Shared information between you and your peers

. Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and
your peers should carefully program and configure:

. Your Avaya-provided telecommunications systems and their
interfaces

. Your Avaya-provided software applications, as well as their
underlying hardware/software platforms and interfaces

. Any other equipment networked to your Avaya products.

Trademarks
Avaya is a trademark of Avaya Inc.

All trademarks identified by the ®or ™ are registered trademarks or
trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners.

Third-party royalty-free license agreements

This product and future updates and service packs to this product may
contain third-party royalty-free technology which is provided to you under
terms and conditions which are different from your Avaya product license
agreement. A file containing these third-party royalty-free licenses,
3plirdme.txt or a similar name, is in the root directory of the product
CD. Your use of this technology described in this file will be subject to the
terms and conditions of such other license agreements, and not the
Avaya product license agreement.

Document ordering information:
Avaya Publications Center

Voice: +1-207-866-6701

1-800-457-1764 (Toll-free, U.S. and Canada only)
Fax: +1-207-626-7269
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Haverhill, MA 01835 USA
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E-mail: totalware@gwsmail.com
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For the most current versions of documentation, go to the Avaya support
Web site:

http://www.avaya.com/support

COMPAS

This document is also available from the COMPAS database. The
COMPAS ID for this document is 107108.

Avaya support

Avaya provides a telephone number for you to use to report problems or
to ask questions about your contact center. The support telephone
number is 1-800-242-2121 in the United States. For additional support
telephone numbers, see the Avaya Web site:

http://www.avaya.com/support
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Before You Begin

This section includes the following topics:

e Typographical Conventions on page 9.

e Notes, Tips, and Cautions on page 10.

e Contacting Technical Support on page 10.

e Product Documentation on page 11.

e Educational Services on page 13.

Typographical Conventions

This guide uses the following font conventions:

Font Type Meaning

command This font signifies commands, information that you enter into the
computer, or information contained in a file on your computer.

commandvariable | This font indicates variables in a command string.

italics This font is used to add emphasis to important words and for
references to other chapter names and manual titles.

link Blue underlined text in online documents indicates a hypertext
jump to related information.
To view the related material, click the blue underlined text.
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Before You Begin

Notes, Tips, and Cautions

Note:
A note calls attention to important information.

A Important:

An important note calls attention to a situation that has the potential to cause
serious inconvenience or other similar repercussions.

Tip:
A tip offers additional how-to advice.

A\ cauTiON:

A caution points out actions that may lead to data loss or other serious
problems.

Contacting Technical Support

If you are having trouble using Avaya software, you should:
1. Retry the action. Carefully follow the instructions in written or online documentation.

2. Check the documentation that came with your hardware for maintenance or hardware-
related issues.

3. Note the sequence of events that led to the problem and the exact messages
displayed. Have the Avaya documentation available.

4. If you continue to have a problem, contact Avaya Technical Support by:

e Logging in to the Avaya Technical Support Web site http://www.avaya.com/support/

e Calling or faxing one of the following numbers from 8:30 a.m. to 8:30 p.m. (Eastern
Standard Time), Monday through Friday (excluding holidays):

- Toll free in the U.S. and Canada: 1-888-TECH-SPT (1-888-832-4778)
- Direct line for international and domestic calls: 1-512-425-2201
- Direct line for faxes: 1-512-997-4330

10 Avaya Agent User Guide
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Product Documentation

e Sending email with your question or problem to crmsupport@avaya.com. You may
be asked to email one or more files to Technical Support for analysis of your
application and its environment.

Note:

If you have difficulty reaching Avaya Technical Support through the above
URL or email address, please go to http://www.avaya.com for further
information.

Product Documentation

Most Avaya product documentation is available in both printed and online form. However,
some reference material is available only online, and certain information is available only in
printed form. A PDF document with detailed information about all of the documentation for
the Avaya Interaction Center is included in the Doc directory on the product CD-ROM. This
PDF document is also included on the separate documentation CD-ROM.

Readme File

The Readme file is a PDF file included on the Avaya Interaction Center software CD-ROM.
This file contains important information that was collected too late for inclusion in the
printed documentation. The Readme file can include installation instructions, system
requirements, information on new product features and enhancements, suggested work-
arounds to known problems, and other information critical to successfully installing and
using your Avaya software. Avaya may also deliver an Addendum to the Readme, which
will be posted on the Avaya Technical Support Website. The Readme Addendum will
contain similar information uncovered after the manufacture of the product CD-ROM.
Review the Readme file and the Readme Addendum before you install your new Avaya
software.

Electronic Documentation

The electronic documentation (in PDF or HTML format) for each Avaya Interaction Center
product is installed automatically with the program. Electronic documentation for the entire
Avaya product suite is included on the product CD-ROM and the documentation CD-ROM.

You can also view the documentation set online at http://www.avayadocs.com.
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Before You Begin

Printed Documentation

You can purchase printed copies of these manuals separately. For details, see Document
ordering information: on the back of this manual’s title page.

License to Print the Electronic Documentation

Online copies of documentation are included on the CD-ROM that accompanies every
software release. An Avaya customer who has licensed software (a “Licensee”) is entitled
to make this online documentation available on an internal network or “intranet” solely for
the Licensee's use for internal business purposes. Licensees are granted the right to print
the documentation corresponding to the software they have purchased solely for such
purposes.

Right-To-Print License Terms

Documents must be printed “as-is” from the provided online versions. Making changes to
documents is not permitted. Documents may be printed only by any employee or
contractor of Licensee that has been given access to the online documentation versions
solely for Licensee's internal business purposes and subject to all applicable license
agreements with Avaya. Both online and printed versions of the documents may not be
distributed outside of Licensee enterprise or used as part of commercial time-sharing,
rental, outsourcing, or service bureau use, or to train persons other than Licensee's
employees and contractors for Licensee's internal business purposes, unless previously
agreed to in writing by Avaya. If Licensee reproduces copies of printed documents for
Licensee's internal business purposes, then these copies should be marked “For internal
use only within <Licensee> only.” on the first page or cover (where <Licensee> is the name
of Licensee). Licensee must fully and faithfully reproduce any proprietary notices contained
in the documentation. The copyrights to all documentation provided by Avaya are owned
by Avaya and its licensors. By printing any copy of online documentation Licensee
indicates its acceptance of these terms and conditions. This license only governs terms
and conditions of printing online documentation. Please reference the appropriate license
agreement for terms and conditions applicable to any other use, reproduction,
modification, distribution or display of Avaya software and documentation.
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Educational Services

Avaya University provides excellent training courses on a variety of topics. For the latest
course descriptions, schedules, and online registration, you can get in touch with us:

e Through the web at http://www.avaya-learning.com/logon form.asp

e Over the telephone at 800-288-5327 (within the U.S.) +001 303-406-6089 (outside of
the U.S.)

e Through email at Avaya.U.Helpdesk@accenture.com
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Avaya Agent and Web Agent Overview

Chapter 1: Overview

The Avaya Agent, and its integrated component the Web Agent, are installed on your
computer desktop as part of the Avaya™ Interaction Center (Avaya IC) software suite. The
Avaya Agent and Web Agent make it possible for you to interact with your contact center’s
customers. You may use one or more of the following features of the Avaya Agent and the
Web Agent: Telephony, Email Management, Web Management, Outbound List
Processing, and Avaya™ Outbound Contact Management.

This chapter describes how the Avaya Agent and the Web Agent are displayed on your
desktop so you can use these features.

This section contains the following topics:
e Avaya Agent
e Web Agent

Avaya Agent and Web Agent Overview

Depending upon the features available in your contact center, you can use Avaya Agent
and Web Agent to interact with customers in the following ways:

e Use Telephony to speak with customers who call your company.

e Use Outbound Contact Management to speak with customers that you or the software
call on the telephone.

e Use Outbound List Processing to speak with customers that you call on the telephone.
e Use Email Management to read and reply to customer emails.

e Use Web Management to "chat” with customers over the Web by exchanging text
messages and Web pages. If desired, you can speak to these customers on the
telephone while in a chat session with them, or share Internet browsers with them.

Note:

In this manual, the illustrations show the Avaya Agent displayed on the right
side and across the bottom of the desktop. Avaya Agent may look different
on your desktop. Contact your system administrator if you need help
understanding the setup of Avaya Agent that you see on your desktop.
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Avaya Agent

The Avaya Agent is the application that allows you to handle incoming and outgoing
contacts with customers. The Avaya Agent is displayed as a framework that surrounds the
desktop on your computer monitor. You may see one or all of the following components on
the Avaya Agent on your desktop:

e Media tab, which contains:

- Task lists where you receive telephone calls, emails, and chat requests assigned to
you

- Softphone for speaking with customers who have called (inbound calls)
e Outbound Contact tab for automated outbound calling
e Outbound Lists tab for manual outbound calling

e Contact History Browser tab, which is located on the Contact History Browser, for
information about previous contacts your customers have had with your company

e Prompter tab, which is located on the Contact History Browser, for scripts telling you
what to say to customers

e EDU Viewer (Electronic Data Unit Viewer) for information about your current contacts

The Web Agent opens within the Avaya Agent framework when you handle emails and
chat sessions. For overview information about the Web Agent, see Web Agent on page 22.

You may also work with other applications, such as Siebel Call Center, which open within
the Avaya Agent framework. Similarly, you can set other applications that you work with,
such as Microsoft Word, to open within the Avaya Agent framework.

Tip:
Press Alt+Tab to proceed through these applications while looking at the
contact information displayed in the Avaya Agent. To move the Avaya Agent
behind the other applications, select the check box beside Always on Top
in the Avaya Agent menu to remove the check mark. For information on this
option, see Avaya Agent Menu on page 18.
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Avaya Agent in the desktop may look like this:

Lo ————— 4
Media | Outhound Contact |
Lite @ L— 5
(agentien] Max 0Voice 1 Email 1 Chat
3—b CTI - Nat Logged In l— 6
1. Contact History Browser (or Prompter) 2
2' EDU Viewer Initiate Transfer — 7
3' Media tab Consult Conference
4. Avaya Agent button — ‘
5. Status Control bar in Media pane 0"9'"4 1 g
6. Phone task list
7. Softphone buttons
- . 4 »
8. Email task list >
9. Chat task list oL
[T T tiam %ﬂm 9
< | B
C_ T
% Subject |created | Type é
% AVAYA
= [ ]
#sart| | 8@ © &G | -';JA\Iaya Agent " nyaya Web Agent l «AE 925am
1

Using Avaya Agent with Multiple Languages

You may be able to communicate with customers in more than one language. The main
features of Avaya Agent and Web Agent where you can use multiple languages are:

e Unified Agent Directory

e Email

e Chat

e Spell checking of email and chat contents
e Auto-Sync and Page Push

e Global Resources and Agent Resources
e Email Templates

e Suggested Responses

e Web Self-Service database

e DataWake
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Avaya Agent Menu

You access the Avaya Agent menu by clicking the Avaya Agent button at the top of the
right pane. The Avaya Agent menu includes the options described in the following table:

Menu Item

Action

Always on top

When this item has a check mark, it ensures that the Avaya Agent
always remains on top of other applications on your desktop. If
you want the Avaya Agent to go behind other applications, select
this menu item to remove the check mark.

Change Password

If this option is available, you can select it to change your Avaya
Agent password. If it is not available, you will be prompted to
change your Avaya Agent password when the current one expires.

Help Displays the Avaya Agent online help.
About Avaya Agent | Displays information about this Avaya Agent application release.
Minimize Minimizes the Avaya Agent. To restore the Avaya Agent, click the
Avaya Agent icon on the Windows task bar.
Exit Closes Avaya Agent, the Web Agent, and all open Avaya focuses.
Avaya Agent Tabs
The Avaya Agent usually displays the following three tabs that you can click to use a set of
features:
e Media Tab

e Outbound Contact Tab

e Outbound Lists Tab

Media Tab

The Media tab is usually displayed whenever you log in to Avaya Agent. When this tab is
displayed, you can handle your incoming voice, email, and chat contacts.

The tab contains a Status Control bar with icons or buttons that indicate or control your
current agent state and the status of your media channels. The Status Control bar displays
an Agent button and a button (or icon) for each inbound media channel (Voice, Email, and
Web Chat) for which you are enabled. (A button is different from an icon. You can press a
button, which has a frame around it, to control your status. An icon does not have a frame
around it and you cannot press it.)
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Tip:
The buttons are only available if you are working in manual mode. For more
information, see Setting Manual Mode on page 54.

The text below the Status Control bar displays the following information:
e Your login ID

e Your channel load in the media channels (the maximum number of customer contacts of
each media channel that you can handle at a time)

In the example below, the agent (jerry) is currently available for Voice, Email, and Chat.
This agent can handle up to one voice contact, one email contact, and one chat contact at
the same time.

gy =T

2 —p | edia

lotd @

4 —p |[ierr_l.J] Max 1 Vaoice 1 Email 1 Chat

Avaya Agent button

Media tab

Status Control bar with Agent button, Voice icon, Email icon, and Chat icon)
Your login ID and Voice, Email, and Chat channel loads

hPoON=

Outbound Contact Tab

Avaya™ Qutbound Contact Management (Outbound Contact) automates outbound calling
activities. The software runs outbound jobs by automatically dialing customer telephone
numbers and displaying customer information for you.

For information about using Outbound Contact, see Chapter 7: Handling Outbound
Contact Calls on page 193.

Outbound Lists Tab
Your company may ask you to use Outbound List Processing to call customers in a list.
The Outbound Lists tab is usually beside the Media tab.

For information about using Outbound List Processing, see Chapter 8: Managing
Outbound Lists on page 215.
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Task Lists

Depending on your company and your responsibilities, you may see any or all of the
following task lists in the Media pane of your Avaya Agent:

e Phone task list, described in Using the Phone Task List and Softphone on page 82

e Email task list, described in Using the Email Task List on page 99
e Chat task list, described in Using the Chat Task List on page 132

When incoming contacts are assigned to you, they are displayed in the appropriate task
list. The task list also displays relevant information, such as the time the contact was
assigned to you and the state of the contact. Some of the information is indicated by the
icons that represent the contacts.

Tip:
If you select a contact and hold your mouse over it for a moment, you will
see a "tooltip" with some of the same information about the contact. This
tooltip may be easier to read than the information within the task list and it
may contain additional information.

To begin responding to an incoming contact, you must double-click the contact in the task
list.

Softphone

Softphone makes it possible for you to perform standard telephone operations using your
computer instead of a physical telephone. Your Softphone interface is in the Media pane of
Avaya Agent. This interface contains the Phone task list and the telephony buttons that you
use to manage your incoming and outgoing voice contacts.

For information on the Softphone, see Using the Phone Task List and Softphone on
page 82.

Contact History Browser and EDU Viewer

You use the Contact History Browser and the EDU Viewer (Electronic Data Unit Viewer) to
locate information about the contacts in your task lists. Each tab in the Contact History
Browser contains the history of a contact in your task lists. Each tab in the EDU Viewer
contains current information about a contact in your task lists.

An EDU is a set of information about an active contact (voice, email, or chat). The EDU
Viewer displays an EDU for each contact that you are currently handling.
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The bottom frame of the Avaya Agent also contains buttons that you use to access the
following:

e Contact History Filter — Filters the records in the Contact History Browser to
y& access only the historical information you need for the current customer contact.

ﬁ e Active Contact Viewer — Displays information about any other active contacts
from the same customer. Usually these are email contacts assigned to other
agents.

Prompter Scripts

Your system administrator develops Prompter scripts to assist you while you handle
contacts. Each script is designed to provide a consistent method for you and other agents
to communicate with customers. It ensures that you obtain information from customers and
give them other information, as your company requires. Prompter scripts may contain
statements for you to say to customers. They may also contain option buttons and text
fields you use to indicate a customer’s answers, and a selection of reasons that explain the
customer’s question and how you handled the contact.

You may use Prompter scripts to do the following:

e Collect information about customers

e Provide answers and information to customers

e Enter wrap-up information about a contact with a customer
e Contact a customer for a marketing or sales campaign

Each answer that a customer gives determines the next step in a Prompter script. For
example, if a customer calls with a problem about a product they purchased from your
company, the script is different for a customer who has a valid product warranty than for a
customer who does not.

A Prompter script may be displayed automatically at certain times, for example when you
answer a customer contact or when you press the Next Call button in the Outbound Lists

pane.
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As shown in the following example from a Prompter wrap-up script, Prompter scripts are

displayed in the Prompter pane. In the out-of-the-box Avaya Agent, the Prompter pane is
displayed in the frame that runs across the bottom of your desktop.

narmme
éﬁfgﬁip e Prev | Mext |
L History Please select the Category:
001 - Auto Insurance
[ 002 - Home Insurance
010 - Mew Mortgage
[T 011 - Eefinance

| aPrompter  Cortact

Web Agent

The Web Agent is the component of Avaya IC that makes it possible for you to interact with
customers using Email Management or Web Management. With Web Management, you
conduct a chat session with customers. While in a chat session, you can use the following
features:

e Text Chat (exchanging typed messages with your customer in real-time)

e Voice Chat (talking to your customer, using either Chat & Phone or Chat & VoIP)

e Shared Browsing (viewing the same Web pages with your customer, using the Auto
Sync, Page Push, and Collaborative Form Filling features)

Customers send an email or initiate a chat session by clicking an appropriate button on
your company’s Web site. According to your availability for email or chat, some of these
emails and chat requests are assigned to you as email contacts or chat contacts. When
you double-click a contact in your Email task list or your Chat task list, the Web Agent is
displayed. The Web Agent is where you compose your email responses and conduct your

chat sessions.
When you log in to Avaya Agent, you log in to the Web Agent automatically.
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The Avaya Agent with the Web Agent and an active chat contact in the desktop looks like
this:

ﬂnvaya Web Agent : — (ol x| ﬁ !M‘I,l l[‘nlj
Contact Resources Tools Help Media IUulbuund Contact
| F‘% o

= [

agentl] Max 0%oice 1 Email 1 Chat
|

- WM:,‘ 6
S5 Filter by ~ | |2 Conference Comment: Please help Maria find some running shoes on our site | =l
Resources (2 Question: ﬁ Answer Mg Hald
B Agent resources Can someone help me navigate your website? = AVAyA
B Global resources — Initiate Tiransfer 7
(€1 Email templates = o o
- s
Call Connected — o e
Caller English
1 . System: Please wait for the next available agent...

Call Connected. [agent2]

agent2: Sure. What are you interested in looking at?

Maria: I'm looking for running shoes

agent2: Please hold on. I'n going to transfer you to an expert in running shoes
Maria: good - thanks!

Call Connected. [agentT]

J MNarme Duration | Wail

‘ | | Qrigin | A
4 Ep @ srni@aulsboand.... 1
=] E‘_; ﬁ johng@myhome.... D
4 »
Interaction Center Wweb Mail

Message

> & e 00:05... 00
Hello, Maria. What kind of running shoes can | help you find? el 9
= ||l
| LU | e say H ey e
| [@ webACD|@ Email|@ Chat[6f Default[€ agent1 181 Avaya Web Agent (c}1999-2002 Avaya, Inc.
2 §  sniaisbmdavayacom bas | ishna@myheme. cam | Ju Maria |iohng@myhome.com | 4]
é Subject |created | Tvne ﬁ Zﬁ;;:g:lguh:asrni:fmd some running |~
3 — g Created [2003-05-02 21:14:34
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letomer Information
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1. Web Agent

2. Contact tab (for Contact History Browser)

3. Prompter tab (for Prompter scripts)

4. Contact History Browser (switches to Prompter when you click Prompter tab)

5. EDU Viewer

6. Phone task list

7. Softphone buttons

8. Email task list

9. Chat task list

The appearance of the Web Agent changes, according to what you are doing. This section
explains the features of the Web Agent window while you are handling email or chat
contacts, under the following topics:

e The Web Agent While Handling Email
e The Web Agent While Handling Chat
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e The Web Agent in Supervisor Mode
e The Web Agent Status Bar
e The Web Agent Information Bar

e Web Agent Menus
e The Web Agent Toolbars

The Web Agent While Handling Email

If you are enabled for email, you will use the Web Agent together with the Avaya Agent to
handle email contacts from customers. You will use two email modes in the Web Agent:

e Email Preview — This is a read-only view of the customer’s email. If you click the Reply,
Reply to All, or Forward buttons in the email toolbar, the view changes to Compose
mode.

e Compose — This is where you write a reply to an email or originate an email.

You can switch between the two modes by clicking the Preview tab or the Compose tab. If
you are handling multiple emails simultaneously, each email will have its own Compose
tab for your reply.

The following sections describe the features of the Web Agent window while handling
email

e Features Common to Email Preview and Compose Modes

e Features of Email Preview Mode

e Features of Compose Mode
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Features Common to Email Preview and Compose Modes

The following illustration shows an email reply that an agent is composing in the Web

Agent.
=101x]
Contact Resources Tools Help
11— |
2 { o Praview &_;CUH’][JUSE| - 1 7
'_'EFMterbyiv } 8
[~ |[Resources -
@ B Agent resources Mormal Reply ‘ W
Returns & Exchanges| ||| This email will be sent to the customer )“— 9

@ Global resources

© (& Email templates il Header [Attachments |
To: LJUhn Smith <johnsmith@breakme. quintus.com>
3 Ce: ‘
|__ Bec: ‘

Subject: ‘RE: Howe do | return a pair of shoes | ordered?

= Hello, John,

On June 5, 2002 at 9:19 AM, John Smith <johnsmith@@breakme. quintus. corn > wrote:

—10

[¥] Preview content -
Shopping Mecea wants you to [+ =l just received my order but the shoes are too tight. Howe do | return them =
5 | retumns policy. 2 I =

ithin 30 days of your purcha >Thanks,
=John

Kl

O | I LS

6 —p |@ WebACD |@ Email |, super|g Default |© jerry}f—ﬁu Avaya Web Agent [c)1999-2002 Avaya, Inc

Main toolbar

Resource toolbar and filters

Unified Agent Directory (UAD) buttons
Resource area

Resource preview scroll box

Status Bar

Tabs for active email

Email Compose toolbar and drop-down menu
Information Bar

Message Composition area

CoOoNoRwWNA

—

The features of the Web Agent window that are common to the Preview and Compose
modes are as follows:

e Menu Bar — The names of three menus containing commands: Contact, Resources,
and Tools. Click the name of a menu to open it and display the commands.

e Main Toolbar — Buttons below the menu bar for quick access to frequently used
commands. The toolbar remains the same, whether you are currently in Email mode or
Chat mode. See The Main Toolbar on page 33.

e Resource Toolbar and Filters — Buttons for resource-related commands and a Filter
menu for displaying only the type of resources you want to see. See Resource
Toolbar on page 39.
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e Resource Area — Pane of window that contains resources, previously prepared text
responses, emails, and URLs (Internet addresses) that you can send to customers. It
may contain folders for each of the following: Agent Resources, Global Resources,
Email Templates, and Suggested Responses.

e Resource Preview Scroll Box — When you select a resource from a folder and then
select the Preview content check box, a scroll box displays the contents of the
resource.

e Information Bar — An area that displays important information about the current email. If
you switch to a chat contact, it displays information about your active chat. See The
Web Agent Information Bar on page 31.

e Status Bar — Icons that indicate certain aspects of your current Web Agent status. See
The Web Agent Status Bar on page 30.

Features of Email Preview Mode

The following areas are displayed only in Email Preview mode:

e Company Logo — Area that displays a logo that represents a company. If your contact
center supports different companies or tenants, the logo may change, according to the
Web site from which the customer sent the active email.

e Email Preview Toolbar — Toolbar with buttons that let you perform various actions to the
email, such as reply to, forward, defer, resolve, or transfer the email, open attachments
to the email, or view previous emails this customer sent to the contact center. See Email
Toolbar in Email Preview Mode on page 34.

e Customer Email Header Area — Information about the customer’s email, consisting of
the email address of the customer, any other addresses to which the email was sent, the
date and time the email was sent, and the subject that the customer entered for the
email. If you click the UAD buttons, you can find and add addresses of people in your
company. For detailed technical information about the active email, click the Header
check box.

e Customer Message Area — Box where you can read the customer’s email. You cannot
edit the text in the message in Email Preview mode.

Features of Compose Mode

The following areas are displayed only in Compose mode:

e Compose Toolbar — The Compose toolbar contains buttons that let you perform various
actions to your email reply, such as print, save a draft, cancel, add attachments, spell
check, see email history. See Email Toolbar in Email Preview Mode on page 34.

e Drop-down Menu and Send Button — The menu lets you choose whether this is a normal
reply, a message to an external agent, or a request to the customer for additional
information. (An external agent is a person outside the company who has been
designated as a subject matter expert who can help customers when agents request
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their assistance.) The Send button sends the email that is currently in the Message
Composition area to the addresses in the header fields.

e Outbound Email Header Area — Tab that displays information about the email you are
composing, with the addresses to which the email will be sent and the subject of the

message.

e Attachments Area — Tab that lets you attach files to the email and displays information
about any files you have attached.

e Message Composition Area — Area where you compose an email. It may contain the
message that you are replying to in addition to the message that you compose.

The Web Agent While Handling Chat

The following illustration shows the Web Agent window during a chat session.

2= Avaya Web Agent

] 4
1 —Pp» Contact Resources Tools Help
2 —» |
3 —eEBE B R R EEE [ |
4 — S Fiter by | S h |._°. New chat task from customer Sandy < I 7
[ | Resources ( Question: R et | 8
o B Agert resources Do you sell custom-made shoes? - ‘i AVAyA! - 9
B Global resources Ealpiiieliy Sollhel
©- (& Email templates =11 7
Call Connected. —
Caller missing phrase
jerry: Yes, we do. Il lead you to our Just-My-Size site and show you how to order shoes
made just  for you.
Sandy: Great!
AutoSync turned on
jerry: —10
5 = bt itest2 guintus comicmibvelcome ktml?nonescsllid=3cfd3ea1 00000000587 Th1 623200002 Sagentd=jerry
" our browser should have opened to the site now. - ]
| 11
| g Push URL | o Say <« — 12
6 —[@ WebACD[@ Email|@ Chat [©, super|g® Default [ jerry [ | Aovaya Web Agent (c)1999-2002 Avaya, Inc
1. Menu Bar 5. Resource area 9. Company logo
2. Main toolbar 6. Status Bar 10. Transcript area
3. Resource toolbar 7. Information Bar 11. Text entry area
4. Resource filters 8. Customer’s question 12. Send bar
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The features of the Web Agent window in Chat mode are as follows:

e Menus — The names of menus that contain commands. Click the name of a menu to
open it and display the commands.

e Main Toolbar — Buttons below the menu bar for quick access to frequently used
commands for email or chat. See The Main Toolbar on page 33.

e Resource Toolbar and Filters — Buttons for resource-related commands and a Filter
menu for displaying only the type of resources you want to see. See Resource
Toolbar on page 39.

e Resource Area — Pane that contains resources, which are previously prepared text
responses, emails, and URLs (Internet addresses) that you can send to customers. The
resource area may contain folders for Agent Resources, Global Resources, and Email
Templates.

e Resource Preview Scroll Box (not shown) — When you select a resource from a folder
and then select the Preview content check box, a scroll box displays the contents of
the resource.

e Company Logo — Area that displays a logo that represents a company. If your contact
center supports different companies or tenants, the logo may change, according to the
Web site from which the customer requested the current chat session.

e Chat Toolbars — The main chat toolbar contains buttons for controlling the current chat
session. Additional toolbars are added when you conduct a Chat & Phone or a Chat &
VolIP session. See Chat Toolbars on page 37.

e Send Bar — Buttons for sending a URL that opens in your customer’s browser and for
sending the text you entered in the Text Entry area to your customer.

e Information Bar — An area that displays important information about your active chat
session. If you switch to an email contact, it displays information about your active
email. See The Web Agent Information Bar on page 31.

e Customer’s Question — Area that displays the original question typed by the customer
on the Web site. This area also displays other information about the customer and the
site from which the customer requested the chat. This information can also help you
identify guest users (people who log on to the company Web site without a user
account).

e Transcript Area — Area that displays the chat conversation that has occurred so far
between you and the customer.

e Text Entry — Area where you enter text or URLs to send to the customer.

e Status Bar — Icons that indicate certain aspects of your current Web Agent status.
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The Web Agent in Supervisor Mode

If you are a supervisor, you can click the Switch to Supervisor Mode button whenever
you want to monitor a chat session. The Web Agent displays a Supervisor Mode panel, as
shown in the following illustration, showing all the chat sessions that agents in your
workgroup are currently conducting.

£y

Team
© agent33

® % &8 Default

1 £ agentaz 4
2 ——@| ¢ £ agentm
3 > 9 guest

.
EEEROED

2§ Fitter by | -

Workgroup

Agent

Customer

Current chat sessions

hobh=

When you select the session you want to monitor, the Transcript and Text Entry areas
display the chat session. See Monitoring a Chat Session (Supervisors Only) on page 164
for more information.
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The Web Agent Status Bar

@ WebACD|@ Email|@ Chat |©, super|gf ShoeSales |8 linda (T 3B 2

L R N~ N 2O N

1 2 3 4 5 6

Status of connection to WebACD Server
Status of connection to IC Email Server
Status of connection to the Chat Server
Your supervisor’s status and login ID
The name of your workgroup

Your status and login ID

Your current email contact load

Your current chat contact load

ONoGR®ON =

The bottom of the Web Agent, as shown in the above illustration, contains a Status Bar
with icons that show aspects of your current Web Agent status.

The following table describes the icons on the Web Agent Status Bar, from left to right.

Icon Description

Shows the status of your connection to the WebACD Server (Web

@ VWebACD Automatic Call Distribution Server) with the following colors:
e Red - Your Web Agent is not connected to the WebACD server.
WebACD e Orange — Your Web Agent is in the process of connecting to the
Connection WebACD server.
Status e Green — Your Web Agent is connected to the WebACD server.

|@ Email|

Email Server
Connection
Status

Shows the status of your connection to the Email Server, which
handles your email contacts. The colors are the same as for the
WebACD Server.

@ el

Chat Server
Connection
Status

This icon is only present when you are handling one or more chat
contacts. It shows the status of your connection to the Chat Server.
The colors are the same as for the WebACD Server.
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Icon Description
. If you are an agent, shows your supervisor’s login ID and indicates
L S'-IPEr| whether the supervisor is currently logged in. The supervisor icon
has a stripe on the shirt so you can distinguish it from your own icon.
Supervisor The shirt color indicates your supervisor’s login status, as follows:
Stagus and e Grey — Your supervisor is not online.
Login ID e Red with yellow stripe — Your supervisor is logged in.

If you are a supervisor, the Status Bar does not have a Supervisor
icon.

'?, ShoeSales

The name of the workgroup to which you belong. The icon does not
change color.

Chat channel
load

Workgroup
—_— Displays your login ID and your agent status with the following shirt
L |lﬂda| colors:

e Grey — You are not logged in to the Web Agent.
Agent Status and | ® Red/Yellow — You are logged in.
Login ID

Shows your availability for chat and, if you are available, your chat
2 channel load (the maximum number of chat customers you can

currently handle at the same time). Zero means that you are
currently unavailable to help chat customers. The icon does not
change color.

[=£]

Email channel
load

Shows your availability for email and, if you are available, your email
channel load (the maximum number of email customers you can
currently handle at the same time). Zero means that you are
currently unavailable to receive email contacts. The icon does not
change color.

The Web Agent Information Bar

g Mew chat task from customer Guest

The Web Agent has an Information Bar to call your attention to important information,
whether you are in an email contact or a chat contact. The Information Bar may display
messages like the following:

e New inbound email from a customer.

e New chat request from customer.
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e This email will be sent to customer.
e Response rejected during quality assurance.

e Transfer request successful.

Web Agent Menus

Contact Resources Tools

The Web Agent has three menus, available from the menu bar at the top of the window:
Contact, Resources, and Tools. Many of the menu options perform the same action as
buttons in the toolbars.

Tip:
You can use shortcut keys to access menus and their options quickly. To
open a menu, press the Alt key and then the letter that is underscored in the
menu name (Alt-T opens the Contact menu, Alt-R opens the Resources
menu, and Alt-O opens the Tools menu). When the menu opens, you can
use the shortcut key beside the option you want to select.

The menus are as follows:

e Contact menu — This menu displays commands related to chat and email contacts. The
Print command prints whatever is displayed in the current window to the default printer.
When you have an active chat contact, you can use the Auto Sync, JoinUs, and
Sametime (if installed) options. See Managing Chat Contacts on page 131 for
information on these features. You can use the Spell Check option at any time to check
an email or a chat. You can use options to transfer and wrap up a contact.

e Resources menu — A set of commands related to resources (pre-written text, URLs,
and emails) that you can send to customers. With one set of options, you can create,
delete, save, and view your own Agent resources. With the Expand all folders and
Collapse all folders options, you can determine whether you view all resource folders
or only the main folder (or folders). You can also use the Filter by drop-down list to limit
the display to the types of resources you want to see.

Tip:
The Resources toolbar above the Resource area has some additional
commands related to resources.

e Tools menu — This menu contains a set of commands that link to Web pages for agents
and customers, a set of two commands that relate to email, and the Preferences
command that lets you customize the look of the Web Agent and set various options
related to chat and email.
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The Web Agent Toolbars

The Web Agent has several toolbars containing buttons that you can click to perform
commands. The main toolbar is always present near the top of the Web Agent. The other
toolbars depend on your current customer interaction. The toolbars are as follows:

e The Main Toolbar

e Email Toolbar in Email Preview Mode

e Email Toolbar in Compose Mode
e Chat Toolbars

e Voice Chat Toolbars

e Resource Toolbar

Tip:
Any time you do not remember what a button does, hold your cursor over
the button for a moment. The Web Agent displays either the name or a
description of the button, as shown in the following illustration. It also shows
the keyboard shortcut that you can use to perform that command, such as

pressing the Control key, the Alt key, and then the letter “c” to switch to Chat
Management.

BB 5 4

5

e ] [l e Il | 1

Switch to Chat mode  Ctr+ar-c .EE] F

The Main Toolbar

BERb 5 &

You use the main toolbar in the Web Agent for both Email Management (email) and Web
Management (chat). The buttons in the main toolbar let you quickly access frequently used
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commands that are also available in the menus. The buttons in the main toolbar, from left

to right, are as follows:

Button Action
Switches the Web Agent to the Chat mode. If a chat contact is
=0 selected in the Chat task list, the current chat session is
displayed. If you are currently handling more than one chat
Chat session, you can switch from one session to another by

changing the chat contact that is selected in the Chat task list.

I8,

Chat & Phone

Switches the Web Agent to the Chat & Phone mode. This
makes it possible for you to speak with a customer over the
telephone while the customer remains in the chat session with
you.

Bt

Switches the Web Agent to the Chat & VolP Mode. This makes
it possible for you to speak with your customer through a
connection between your telephone and the customer’s Internet
connection. While you speak with each other, you and your

Chat & VolIP customer remain in the chat session together.
| Switches the Web Agent to the Email Mode. If an email contact
= is selected in the Email task list, the current email is displayed.
The email may be displayed in Email Preview mode or
Emnail Compose mode, depending on your latest view of this email. If

you are currently handling more than one email, you can switch
from one email to another by changing the email contact that is
selected in the Email task list.

i)

(Supervisors only. If you are not a supervisor, the button is
disabled.) In this mode, a panel displays icons for the chat
sessions that agents in your workgroup are currently
conducting.

Supervisor
o Opens your Internet browser and displays a page where you
o can search for documents to the frequently asked questions
(FAQs) on the Web Self-Service pages or submit your own
Agent Home documents to these pages. Submitted documents are reviewed

by an administrator and may be accepted or rejected.

Email Toolbar in Email Preview Mode

The email toolbar has a different set of buttons, depending on whether you are looking at
the customer’s email (in Email Preview mode) or composing an email reply (in Compose

mode).

S =& E kB
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When you click an email contact in your Email task list, the Web Agent displays the
customer’s email in Email Preview mode, as indicated by the tab above the email. This is a
read-only view of the email. The Email Preview toolbar is above the tab. The buttons in this
toolbar, from left to right, are as follows:

Button Action
5‘ Prints the currently displayed email to the default printer.
Print
Displays the Compose mode of the Web Agent window. The default
% window in Compose mode is a Normal Reply, which addresses your
reply to the sender of the email, and no one else. You can change this
to Send to External Agent or Request Additional Info to compose
Reply those special types of email.
= Displays the Compose mode of the Web Agent window and
addresses your reply to the sender of the email and to all the people
listed in the Cc (Copy) field of the message you are replying to.
Reply to All
: This icon indicates that the email has one or more attachments. Click
Em the icon to see the name of the attachment or attachments. If you click
View the name of an attachment, it usually opens in your browser or in a
Attachments program on your desktop, such as Microsoft Word. If the attachment
does not open, see your administrator.
= Forwards a copy of this email to the people whose addresses you
B enter in the To, Cc, and Bcc fields. See Forwarding an Email on
page 115 for information.
Forward
Lets you apply a status to the email. For example, you may use a
{E status of Dismiss if a customer sends you a “thank you” and all the
customer’s questions have been answered. See Resolving an
Email on page 122 for information.
Resolve
Displays a dialog box with information about the current email and any
ﬂ previous emails sent from the current customer’s email address. You
can also see copies of the emails. See Viewing Email History on
I page 101 for more information.
Email History
= Displays the Unified Agent Directory (UAD) so you can transfer this
- email contact. You can transfer it to a queue and let Avaya IC route
the email to the first available agent in that queue. You may also be
T ¢ able to transfer it to a particular agent, supervisor, or external agent.
ranster For information, see Transferring an Email Contact on page 112.
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Button Action
Puts the current email message on hold, giving you a chance to
% research the customer’s question or problem. Any reply that you have
composed is saved automatically as a draft. You can receive another
Def email contact to replace a deferred email.
eter For more information, see Deferring an Email on page 113.
Puts you in WrapUp state. While in WrapUp state, you cannot receive
EE{I another email contact to replace this contact. You may be asked to fill
out information about this email contact while you are in WrapUp
state. For more information, see Wrapping Up an Email Contact on
Wrap page 129.

Email Toolbar in Compose Mode

g &X dy 8

When you are viewing an incoming email in Email Preview mode and you click Reply or
Reply to All, the Web Agent displays the email in Compose mode, as indicated by the tab
above the email. This is where you compose your reply to the customer. Above the tab is
the Compose toolbar. The buttons in this toolbar, from left to right, are as follows:

Button Action
5‘ Prints the currently displayed email to the default printer.
Print
Saves a draft of the current email reply that you are composing. You
EJ can return to the email by clicking its Compose tab. The email
contact remains in your Email task list.
Save Draft
Displays a dialog box that asks if you want to save a draft of the reply
> you are composing. If you say No, your reply is deleted, and you must
compose a new reply for this email contact.
Cancel
- Displays a dialog box where you can locate a file and attach it to the
Em current email reply.
Attach
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Button Action

=l Displays a dialog box that helps you check the spelling of the current
DV email reply, interactively.

Note: You can set a preference to have this spelling dialog box come
up automatically after you click Send. See Setting Preferences on

Spell Check page 180.

Displays a dialog box with information about the current email and
any previous emails sent from the current customer’s email address.
- You can also see copies of the emails. See Viewing Email History on

A page 101 for more information.
Email History

Chat Toolbars

= Ee BBl B

When you are engaged in a chat session, the main chat toolbar is located on the right side
of the Web Agent above the chat transcript area. This toolbar contains buttons you use to
control the chat session. The buttons in the toolbar, from left to right, are as follows:

Button Action
= Prints the currently displayed chat messages to the default printer.
=
Print
(You see this button when Auto Sync is off.) Starts an Auto Sync session
so that your customer’s browser displays the same Web pages as your
browser as you navigate through Web pages. See Using Auto Sync on
Start Auto page 139 for more information.
Sync
— (You see this button when Auto Sync is on.) Stops an Auto Sync session.
=
Stop Auto
Sync
Starts a JoinUs session in which friends of your customer can join the
chat session. See Handling a JoinUs Conference on page 161 for more
information.
JoinUs
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Button Action
=[] Starts a Lotus Sametime session with your current chat customer. You
E]E can only use Sametime if it is installed and configured on your desktop.
See Setting Preferences on page 180.
Sametime
Displays a dialog box that helps you check the spelling of text that you
E?V have typed in the Text Entry area before you send it.

Note: You can set a preference to have this spelling dialog box come up

Spell Check automatically after you click Say. See Starting a Lotus Sametime
P Session on page 167.

Displays the Unified Agent Directory (UAD) so you can transfer this chat
to another agent or to a queue. For information, see Involving Other
E— Agents in a Chat Contact on page 152.

Transfer
= Displays the Unified Agent Directory (UAD) so you can invite one or more
- agents to join this chat. For information, see Involving Other Agents in a
Chat Contact on page 152.
Conference

This button is only active after you initiate a transfer or a conference of a
chat contact and before the second agent accepts the chat contact.
_ Cancels the transfer or conference of a chat and returns it to your

desktop. For information, see Cancelling the Transfer or Conference of a
Cancel Chat Contact on page 157.

Transfer/ -
Conference
Puts you in WrapUp state. While in WrapUp state, you cannot receive
EE{I another chat contact to replace this contact. You may be asked to fill out
information about this chat contact while you are in WrapUp state. For
Wrap more information, see Wrapping Up a Chat Contact on page 170.

Voice Chat Toolbars
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When you are in a chat session, you can handle two types of Voice Chat:

e Chat & Phone — You and your chat customer speak to each other over the telephone.

e Chat & VoIP — You speak to your chat customer over your telephone while your
customer speaks to you over the Internet.

Customers can request a Chat & Phone session or a Chat & VolP session on the company
Web site. In that case, the Web Agent will display the Chat & Phone toolbar or the Chat &
VolIP toolbar, according to the customer’s request.

If the customer does not request one of these two Voice Chat options on the Web site, but
you and your customer think that it will be helpful, you can initiate a Chat & Phone session




Web Agent
by clicking the Chat & Phone button. (Only the customer can initiate a Chat & VolP
session.)

When you are handling a Chat & Phone, you see the Chat & Phone toolbar. In the following illustration, the customer requested a Chat &
Phone.

2 3 4 5
11— Customer phone number: 555 234 5675
E Meny Chat & Phone contact from customer Mary .

(/ Question:
|I'|:| like some help browsing your site. Can you call me? -

Chat & Phone toolbar.

Request Phone Number button.
Cancel Request button.
Customer phone number field.
Initiate Phone Call button.

aRhwN=

When you are handling a Chat & VolIP, you see the Chat & VolIP toolbar. In the following
illustration of this toolbar, the customer requested a Chat & VolP.

2
1 —» | WolP Controls: \EI
g Flewy Chai & WolP contact from customer Mary .

} Question:
Il'd like some help browsing your site. Can you call rmewith VolP? -

- w

1. Chat & VoIP toolbar.
2. Initiate VoIP request button.
3. End VolIP button.

Resource Toolbar

e R[3e8
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Resources in the Web Agent are previously prepared text, emails, and URLs (Internet
addresses) that you can send to customers whenever the information is needed. This
saves you the time and the tedium that it would take to type the same information
repeatedly. The Resources toolbar sits above the Resource area on the left side of the
Web Agent. The buttons in this toolbar, from left to right, are as follows:

Button Action
:E] Saves the resources that you have created or modified.
Save
gé Hides all resource folders under the single folder that contains them.
Collapse All
Shows all resource folders and all their contents (subfolders and the
% resources themselves).
Expand All
When you select a resource and then click this button, the View
E[{ Resource dialog box opens to display the contents of the resource.
You cannot modify the resource.
View
When you select a resource and then click this button, the Edit
? Resource dialog box opens and lets you modify the contents of the
resource if you want.
Edit
When you select a resource and then click this button, the resource is
ﬁ deleted.
Delete




Chapter 2: Managing Avaya Agent

This chapter provides you with step-by-step instructions for tasks that you do in Avaya
Agent. These tasks apply to the three media channels (Voice, Email, and Chat).

This section includes the following topics:

e Logging In and Logging Out on page 41

e Accessing Avaya Agent on Citrix on page 47

e Setting Your Availability on page 51

e Viewing Customer and Contact Information on page 57

e Reloading Layouts in the EDU Viewer on page 62

e Using the Unified Agent Directory on page 63

Using Screen Pops on page 75

Wrapping Up Contacts on page 76

Note:
Depending on how your system administrator defined Avaya Agent for your
company, some of the Avaya Agent components discussed in this chapter
may not be available to you.

Logging In and Logging Out

You must log in to Avaya Agent for every work session and log out to end the session. You
must use a login ID and password to log in. You will be given a password to use when you
log in the first time. You will need to change that password to a new password that you
choose. You may need to choose a new password again within certain periods of time,
such as every 30 days.

Note:

You must log out at the end of every work session. If you do not log out at
the end of a work session, problems may occur. For example, you may not
be able to defer email contacts.
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If your Avaya IC system uses a feature called Business Advocate, you will have two
different sets of login IDs and passwords, one for Outbound Contact and one for your work
you do from the Media tab. When you switch between these two types of work, you must
log out of Avaya Agent and log back in with the other login ID and password.

A\ SECURITY ALERT:
Be sure to read the section System Security on page 44 for rules about
creating and using passwords.

Your Avaya Agent may use “free seating.” With free seating, your personal settings and
preferences are attached to your login ID and password. Therefore, you can log in to
different workstations at your contact center, and Avaya Agent will open with your personal
settings and preferences.

A cauTion:
With free seating, you should only log in to one workstation at a time. If you
want to change from one workstation to another, be sure to log out of the
first workstation before you log in to the second one.

When you log in to Avaya Agent, you also log in automatically to Web Agent, and to either
Avaya™ Outbound Contact Management (Outbound Contact) or the media channels
(Voice, Email, and Web Chat). See Agent Blending on page 210 for information about
switching between Outbound Contact and the media channels.

Logging In to Avaya Agent

If your contact center hosts Avaya Agent on Citrix, instead of your workstation, you must
access Avaya Agent on Citrix before you can log in. For more information, see Accessing
Avaya Agent on Citrix on page 47.

To log in to Avaya Agent:
1. Double-click the Avaya Agent icon on your desktop.

If your desktop does not have an Avaya Agent icon, select the Avaya Agent shortcut
from the Windows Start menu. For example, select Start > Programs > Avaya
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Interaction Center 7.0 > Interaction Center. Your Avaya Agent Login dialog box may
look like this:

Avaya Agent Login

Avaya Agent Login |

Ladgin |d: ||

Password: I

IC Data Source; Iinteractinn_center

Status Messages ©

Inttializing... This area displays messages
Loading Plug-ns... ~<&—— about your log-in status.
Connecting to Database...

4] |

Clear | ok | Bt |

2. In the Avaya Agent Login tab, enter your login ID and your password in the
appropriate text box.

Note:
If you plan to use Outbound Contact and you have a different login ID and

password for that, be certain to enter the correct login ID and password.
Note:

Type your password carefully. If you enter an incorrect password a certain

number of times, you may be locked out of the system. If this happens, see
your administrator.

A SECURITY ALERT:

Be sure to read the section System Security on page 44 for rules about
creating and using passwords.

Tip:

The IC Data Source field has been set for you. You can ignore this field
unless system administrators indicate that you should change it.
You may need to change your password.

Avaya Agent automatically adds your login ID and password to the appropriate text
boxes in the other tabs to log you in to the other channels.
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3. If your system includes Softphone, you may need to complete the additional fields in
the Softphone tab. These fields may include the following:

Field Name Field Description

Agent ID Logs you on to the telephone switch and makes sure that all
voice contacts assigned to your Agent ID are sent to your
telephone.

Agent Password | Confirms your identity to the Automatic Call Distributor (ACD)
telephone system.

Station ID Identifies the station or equipment number of your telephone.

4. Click OK.

Status messages show the progress of your login. If your login ID and password are
valid, Avaya Agent is displayed on your desktop.

Note:
To use Outbound Contact, you must log in to Avaya Agent at the workstation
that has the Phone Type assigned to your login ID. Contact your
administrator if you cannot log in to Outbound Contact.

5. Check your Avaya Agent Status Control Bar, located at the top right of your screen, to
confirm that you do not have all zeros for your channel loads. Your channel loads are
the number of contacts in a media channel (Voice, Email, or Chat) that you can handle
at the same time.

Note:
If your channel loads across all available channels are set to zero, contact
your system administrator to make sure that the servers are running. If the
servers are running, re-set your channel loads (see Setting Your Channel
Loads on page 55).

System Security

You have an important responsibility to help keep your system secure. Observe the
following rules to ensure the security of the system:

e When you are required to change your password, choose one that is easy for you to
remember but would be impossible for anyone to guess.

e You may need to follow certain rules about the length of the password and the number
and type of characters it contains.

e Ask your administrator if you need help creating your password.

e Never write down your password.
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e Never share your password with anyone.

e Contact your administrator immediately if you suspect any security problems, such as a
computer "virus," unusually slow response times, or other abnormal behavior of the
system.

Logging In and Out of Media Channels

When you log in to Avaya Agent, you log in to all the media channels (Voice, Email, or
Chat) for which you are enabled. However, you can also log in and out of individual media
channels if you want to limit your contacts to one or two channels at a particular time. For
example, you may want to log in to the voice channel and log out of email and chat
channels. Then you will receive new voice contacts only.

The login and logout options in the Avaya Agent pop-up menu change, depending on your
current state in a media channel. For example, if you are logged in to the Web Agent, you
see the Web Agent - Logout option in the menu, not the Web Agent - Login option.

Note:
When you log in to Outbound Contact, you cannot log in to the channels on
the Media tab. For more information, see Logging In to Outbound
Contact on page 196 and Logging out of Outbound Contact on page 210.

To log in or out of a media channel:

1. Right-click any blank area of Avaya Agent to display the pop-up menu, as shown
below.

Show Directory

Chat - Reset

Contack Hiskary Browser - Feset

EDUNiewer - Reload Layauks
EDLViewer - Reset

Email - Reset

Softphone - Logouk
Softphone - Reset

W'eb Agent - Lagouk

Note:

If you are logged in to a channel, the menu option for that channel says
Logout. If you are logged out of the channel, the menu option says Login.
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2. From the pop-up menu, click one of the following:

e Web Agent - Login (or Logout) — Lets you log in to (or log out of) the Web Agent so
that you can respond to chat and email contacts.

e Softphone - Login (or Logout) — Lets you log in to (or log out of) the voice
(telephony) channel so that you can respond to voice contacts.

Note:

Only log out of a media channel if instructed to do so by your administrator
or if you will be handling automated outbound calls using Outbound Contact.

3. In the Avaya Agent Login dialog box, enter your login 1D, password, and any other
information required for the media channel.

4. Click OK.

Logging Out of Avaya Agent

When you log out of Avaya Agent, you automatically log out of all your Avaya applications
also. You may need to enter the reason that you are logging out of Avaya Agent.

If your contact center hosts Avaya Agent on Citrix, instead of your workstation, you must
log out through the Avaya IC tools for Citrix. For more information, see Accessing Avaya

Agent on Citrix on page 47.

To log out of Avaya Agent:
1. Change your agent state to AuxWork.

If you log out in an Available state, Avaya Agent may automatically place you in an
Available state and deliver contacts to you when you log back in. For information on
how to change your agent state, see Changing Your Agent State on page 51.

2. Click the Avaya Agent button at the top of the Avaya Agent.
3. Select Exit from the Avaya Agent menu.

If you did not change your state to AuxWork, Avaya Agent displays a message
advising you to change your agent state.

4. If a Logout dialog box is displayed, select a reason. Then click OK.
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Accessing Avaya Agent on Citrix

If your contact center uses Citrix, Avaya Agent is on a Citrix server not on your workstation.
You use an Avaya IC tool to access Avaya Agent on the Citrix server. After you access the
server, you can work with Avaya Agent normally.

Avaya provides two tools that you can use to access Avaya Agent on the Citrix server. The
Web browser tool opens in Internet Explorer. The Executable tool opens as a dialog box.

The Avaya IC tools for Citrix:

e Connect you to Avaya Agent and the other agent applications that you need on the
correct Citrix server.

e Ensure that Avaya Agent sizes properly in the Citrix client interface.

e Ensure that you can properly exit from the Citrix server and the Citrix interface.
e Help you re-connect to the Citrix server if you encounter a problem.

This section includes the following topics:

e Using the Web Browser Tool on page 47

e Using the Executable Tool on page 49

A Important:
The Avaya IC tools for Citrix that you see on your desktop may look different
from the illustrations. The text for the links on the Web browser tool and the
text on the buttons in the Executable tool may have been customized for
your contact center. Contact your supervisor or system administrator if you
need help understanding the tools that you see on your desktop.

Using the Web Browser Tool

The Web browser tool displays as a Web page in Internet Explorer that you use to access
Avaya Agent on Citrix. After you use the Web browser tool, Internet Explorer displays
Avaya Agent and other agent desktop applications published on the Citrix server.

This section includes the following topics:

e About the Web Browser Tool on page 48.

e Accessing Avaya Agent with the Web Browser Tool on page 48.
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About the Web Browser Tool

The following illustration shows the default appearance of the Web browser tool. The table
below the illustration describes the function of each link in the Web browser tool.

/Z H:\Avaya_IC_613"Prerequisites’,backup’,citrix’,ICDesktopReset’BasicstartiCAgent.ht... [H=] B3

File Edit “ew Favorites Tools Help

dmEack - = - &) 74 | Qsearch GFavortes Meda (4 | B S B

-H A&

Addressl Hihcibriz Iz DeskiopReset| BasicSkartIC Agent. Hkm

=] @ |Links e

Force Beset <

Google - | || @psearchwet - | §3 | Bhasblocked Erucrl [ | 2
-

Start IC Agent m CTTETH Application mode < 1

EXIT - 2

3

a
€] [ &y computer 4
Item Default link text Description
1. Start IC Agent in CITRIX Click this link to access Avaya Agent or
Application mode another Avaya IC agent desktop
application on Citrix server.
2, EXIT Click this link to exit from the Web
browser tool and the Citrix interface.
3. Force Reset Click this link to force a reset of
application after failure.

Accessing Avaya Agent with the Web Browser Tool

A Important:

You must use the following steps in the correct sequence when you use the
Web browser tool to access Avaya Agent and other agent desktop
applications in the Citrix interface. If you do not follow this sequence, you
may have problems with the Citrix interface.
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For information about how to log in and log out of Avaya Agent, see Logging In and
Logging Out on page 41.

To access Avaya Agent with the Web browser tool:

1. In Internet Explorer, open the Web browser access page for the agent desktop
applications.

The link for the access page should be in your Favorites folder. If you cannot locate
the link, contact your Supervisor.

2. Click the Start link.
Avaya Agent on the Citrix server starts.
. Log in to the agent desktop application through Citrix.
. Handle contacts with customers and perform required tasks in Avaya Agent.
. Log out from Avaya Agent in Citrix.
. Click the Exit link to exit the Web browser tool.

o 0~ W

Using the Executable Tool

The Executable tool opens as a dialog box on your workstation. After you use the
Executable tool, the Citrix client interface opens a window that displays Avaya Agent and
other Avaya IC agent desktop applications published on the Citrix server.

This section includes the following topics:

e About the Executable Tool on page 50.

e Accessing Avaya Agent with the Executable Tool on page 50.
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About the Executable Tool

The following illustration shows the default appearance of the dialog box opened by the
Executable tool. The table below the illustration describes the function of each button in the
dialog box.

. IC61AgentDesktopClr M=l E3

Set Desktop For IC Agent

Feset Desktop to Original Size +_2

Item Default link text Description

1. Set Desktop For IC Agent Select this button to access Avaya
Agent or another Avaya IC agent
desktop application on Citrix server.

2, Reset Desktop to Original Size | Select this button to exit from the
Executable tool and the Citrix interface.

3. Force Reset Select this button to force a reset of
application after failure.

Accessing Avaya Agent with the Executable Tool

A Important:

You must use the following steps in the correct sequence when you use the
executable tool to access Avaya Agent and other agent desktop applications
in the Citrix interface. If you do not follow this sequence, you may have
problems with the Citrix interface.

For information about how to log in and log out of Avaya Agent, see Logging In and
Logging Out on page 41.

To access Avaya Agent with the Executable tool:

1. On your desktop, double-click the shortcut icon for access to the Executable tool and
Avaya Agent.

If you do not have a shortcut on your desktop, contact your Supervisor.
2. Select the Set Desktop For IC Agent button.
Avaya Agent on the Citrix server starts.

3. Log in to the agent desktop application through Citrix.
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4. Handle contacts with customers and perform required tasks in Avaya Agent.
5. Log out from Avaya Agent in Citrix.

6. Select the Reset Desktop to Original Size button to exit the Executable tool.

Setting Your Availability

At any point in time, you are either available or unavailable to handle contacts in the media
channels. If you are available, contacts are assigned to you by the system.

You can set two basic types of availability:

e Your channel loads — The maximum number of contacts you can handle in a media
channel at any one time. For example, if you have a channel load of 3 emails, you could
have a maximum of three emails assigned to you at one time.

e Your agent state — Whether you are available at a particular moment to handle contacts.
Agent states are Available, Aux-work (Busy), and Init. aux-work (Transition between
Available and Aux-work). Your agent state may apply to all media channels or to a single
media channel.

You can view or control your channel loads and your agent state through the Avaya Agent
Media pane, as shown below.

(iermy] Max 1 oice 1 Email 1 Chat

!

2

1. Right-click a channel button (voice, email, or chat) to change a channel load.
2. Current channel loads

Changing Your Agent State

You can make yourself available or unavailable to receive voice, email, or chat contacts or
to make outbound calls. Your current state of availability to handle contacts is called your
agent state.

The Agent button in the Status Control bar indicates your current agent state. If you are in
automatic mode, when you click the Agent button, you set your agent state for all channels
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simultaneously. See Changing State Across All Media Channels on page 53 for more

information.

A Important:

When using a physical phoneset in conjunction with Softphone, you should
avoid changing states using the physical phoneset. For example, if
Softphone is preset to enter the Ready state after a call ends, and you set
your physical phoneset to enter the WrapUp state after a call ends,
Softphone and your physical phoneset may be out of sync when you end a
call. To prevent this condition, try to use Softphone to change states.

If your administrator has given you permission to enter manual mode, you can also change
your agent state for single channels individually. This would allow you to click media
channel buttons to make yourself Available for one channel (Voice, for example), while you
are in Aux-work (Busy) for other channels (Email and Web Chat, for example). See
Changing State in a Single Media Channel on page 53 for more information.

The three agent states are shown in the following table:

Agent State Agent Description
Button
Available You are available to accept new contacts. In manual
mode, some media channels may be unavailable, as
shown by an X on the buttons.
Aux-work — You are busy and are unavailable to accept contacts.
(Busy) ﬁ{ In automatic mode, you are unavailable in all media

channels so the Agent button and all media channels
have an X. In manual mode, the Agent button and
any unavailable media channels have an X.

Click to enter Aux-work when you go to lunch, handle
Outbound Contact calls, research a customer’s
problem, or do any activity where you cannot handle a
contact. Wrapping up a contact is not considered Aux-
work.

Init. aux-work
(Transition)

52

You are in a transition state between Available and
Aux-work. For example, you have attempted to log
out with one or more contacts that need to be
wrapped up. In both automatic and manual modes,
the Agent button has a grey X when you are in this
state.

At your contact center, you may need to enter the
reason for entering Aux-work and wrap up all active
contacts on your desktop.

If you are using a DEFINITY telephone switch and the Auto-In or Manual-In work modes,
you can also change your agent state by pressing buttons on your physical telephone. For
information, see Using Softphone with DEFINITY Switches on page 86.
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For information on making yourself available for outbound calling through Outbound
Contact, see Joining Outbound Jobs on page 196.

For information about entering or changing the reason you are in Aux-work state, see
Entering Reason You Are Unavailable on page 56 or Using Softphone to Set a Reason for
Being Unavailable on page 85.

Changing State Across All Media Channels

Your mode of operation determines how much control you have over your agent state.
Depending on how Avaya Agent is configured, you may work in either of the following

modes of operation:
e Manual mode

e Automatic mode

In automatic mode, the Agent button is the only one you can click. Click the Agent button
until it changes to the desired agent state. The other media channels change to the same

state.
The Status Control bar for an agent in automatic mode set to Aux-work (Busy) in all media
channels looks like this:

[ B &

[iermy] Max 0 Woice 0 Email 0 Chat

Changing State in a Single Media Channel

If you are in manual mode, you can change your agent state for a single media channel.
For example, you can make yourself available for voice while you are unavailable (in Aux-

work) for chat.

To change your agent state for one media channel (manual mode only):

e Click the media channel button on the Status Control bar until the button changes to the
desired agent state:

- Available — The button does not have a yellow X.
- Aux-work (Busy) — The button has a yellow X.

- Init. aux-work (Transition) — The button has a grey X as your state changes between
Available and Aux-work.

OR
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e Right-click the media channel button in the Status Control bar. Then click the pop-up
menu option to change your agent state for that media channel.

The pop-up menu options change according to your agent state for each media
channel.

Setting Manual Mode

If your administrator has given you permission to use manual mode, you can set your
agent state and channel loads manually. This means that you can reduce your channel
loads if you want. In manual mode, you can also change each of the Voice, Email, and
Web Chat channels individually from Available to Busy, and from Busy to Available. In
other words, you can be Busy in one channel while Available in other channels.

When you are in manual mode, the Status Control bar contains channel buttons that you
can click. The following illustration shows the Status Control bar in manual mode:

S[te|58 @)

[iermy] bMax 1 Yoice 1 Email 1 Chat

In manual mode, you can do the following things:
e Set your agent state across all media channels
e Set your agent state for only one media channel

e Set your channel load

To enter manual mode:
1. Right-click in the Avaya Agent Status Control bar.
2. Click Options in the menu to open the Channel load dialog box.
3. In the Channel load dialog box, select the Manual Mode check box.
4. Click Apply.

Note:

If you cannot access the Manual Mode check box, your administrator has
set your channel loads. Contact your administrator for further assistance.

Automatic Mode

In automatic mode, when you click the Agent button, you can only change your agent state
across all media channels at the same time. You cannot change your agent state for a
single channel. Therefore, you are always in the same agent state in all media channels.
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When you are in automatic mode, the Status Control bar on the Media tab has only
button—the Agent button. You cannot select the Voice, Email, and Web channels icons.

jerny] bax 1 Woice 1 Email 1 Chat

Setting Your Channel Loads

For each type of contact that you handle, you have a channel load, which is the number of
contacts in that media channel that you are enabled to handle at one time. You may be
able to adjust your channel loads, but they can never be higher than channel ceilings that
your administrator set for you. (The channel ceiling is the absolute maximum number that
you can ever handle at one time.)

For example, if your administrator has set up your account so that the channel ceiling for
chat contacts is three, you can set your chat channel load to three, two, one, or even zero.
But with a ceiling of three, you can never change your channel load to four chat contacts.

To be able to adjust your channel loads, your user account must be set up for permission
to work in manual mode. If you can select the Manual Mode check box in the Channel
load dialog box, that means that you have permission to adjust your channel load.

To set your channel loads:
1. Right-click a media channel button in the Avaya Agent Status Control bar.
2. Click Options from the pop-up menu.
The Channel load dialog box is displayed.

Channel load

Contacts for a specified channel

For example, if you enter B for
weh chatz, this means you will
receive no more than B web chats
at atime.

Enter the amount of contacts you  ‘web chat |3
want to receive per channel.

Setting: changed. E-mail: |3

Click Apply ta cantinue with .
theze new settings. Woice:

Spply I Cancel |

JJ.

1

3. Select the Manual Mode check box if it is not already selected.

Note:

If you cannot select the Manual Mode check box, you cannot adjust your
channel load. Contact your administrator for further assistance.
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4. Enter the maximum number of contacts you want to be able to handle in the text box
next to the appropriate channels. Click the up arrow to increase the number or the
down arrow to decrease the number.

If the number stops changing when you click the arrow, you have reached the ceiling
that your administrator set for you. For example, you may not be able to set more than
1 or 2 chats.

If any field is disabled, you are not set up to handle sessions in that channel.
5. Click Apply.

The Avaya Agent Status Control bar shows the channel loads that you entered, which
is the maximum number of contacts that you can handle for each channel. The
following illustration of the Avaya Agent Status Control bar shows that the agent can
handle a maximum of 1 voice contact, 1 email contact, and 1 chat contact.

L\tel8|®

lierm] ka= 1 %oice 1 Email 1 Chat

Note:

The Web Agent Status Control bar shows your current loads for chat and
email, as set by the program rules. These are called contact loads. The
routing servers can reduce this number at any time according to program
rules that consider the number and type of contacts you are handling, the
number of contacts currently in the system, and so on. Therefore, the
numbers can change while you are in your current login session. Your
current contact loads as shown in the Web Agent may be less than the
channel loads shown in the Avaya Agent.

The following illustration of Web Agent Status Bar icons indicate a current contact load
of 0 emails and 1 chat session. At the current time, this agent cannot receive any email
contacts, but later the agent may be able to receive one again.

BEoE

Entering Reason You Are Unavailable

Your contact center may use a feature that lets you enter a reason that you are unavailable
(in Aux-work). If your contact center uses this feature, you can enter a reason or change
the reason that you are unavailable. You will remain in Aux-work state even if you change
the reason.

For example, you may be unavailable because you are in a training session. You select
InTraining as the reason that you are unavailable. When you return from your training
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session, you may go on your break. You change the reason that you are unavailable to
OnBreak.

To enter or change the reason you are unavailable:
1. While you are in Aux-work, right-click in the Status Control bar.
2. Select Change Aux Reason from the pop-up menu.

3. In the Select reason code dialog box, select the reason that you are not available.

x

Huddle

Supsrizon

B sthioom Bresk

| SmokeBieak |

Ok I Cancel

4. Click OK.

Viewing Customer and Contact Information

When a contact arrives in the Avaya™ Interaction Center (Avaya IC) contact center, an
electronic data unit (EDU) is created for that contact. The application then forwards the
contact to an available agent, using the rules that have been set up by your system
administrator.

The Avaya Agent on your desktop displays information about the currently active contacts
that have been assigned to you. The task lists in the Media pane display the basic
information about each contact. The Contact pane that is displayed near the bottom of the
Avaya Agent contains two areas where you can immediately access more detailed
information about a contact:

e The EDU Viewer displays detailed information about any active contacts, including the
creation date and time.

e The Contact History Browser provides information about previous contacts with the
same customer.

The Contact pane also contains two buttons:

e The Contact History Filter button
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e The Active Contact Viewer button becomes available only when another agent is
currently handling an email contact with the same customer. The Active History Browser
provides information about the other active email contact or contacts.

To view the information in the Contact pane, click a contact in the task list to bring it into
focus.

For information about the Contact History Filter, see Filtering Contact History

Information on page 60. For information about the Active Contact Viewer, see Using the
Active Contact Viewer on page 58.

The following illustration shows the media task list;

1 2 3 4
| Y/ | |
A
§ o | o g R ’%’9 |Q‘ D
E Subject [Time [ Tupe B ﬁ [created 2000-07-19 120213 -
meg 4 18Jul 2000 16:16:25 Email
msg 2 180l 2000 16:16:22 Emai HasAttachments |faise
mzg B 18Jul 2000 16:16:19 Email To support2@
msg 7 18Jul 2000 16:16:16 Email F
meg B 18.Jul 2000 16:16:08 Emai rom CA—
mzg 9 18.ul 2000 16:16:04 Email Qurhiset Test Email EDU created by A
message 1 18 Jul 2000 16:16:00 Ermail hd 4 | v

Contact History Browser
Contact History Filter button
Active Contact Viewer button
EDU Viewer

Pobd=

Viewing Active Contact Information

You can use the EDU Viewer for most information about your active contacts. You may
need to check the Active Email Viewer to see all active email contacts.

Using the EDU Viewer Information

When you select a contact in a task list, the EDU Viewer brings the tab containing
information about the active contact to the front.

Using the Active Contact Viewer

Another agent may have deferred an email contact from a customer that you are handling
by voice, email, or chat. The agent who has deferred the email plans to reply to the
customer at a later time. The deferred email remains in the other agent’s Email task list.

Deferred emails are not displayed in the Contact History Browser because they have not
been completed.
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You can see information about the deferred email contacts in the Active Contact Viewer.
For each active email contact from that customer in another agent’s Email task list, the

Active Contact Viewer displays:

e The date and time when the email contact was created
e Whether there are any attachments

e The contents of the To field

e How many times the email contact has been forwarded

e The sender’s email address

e The subject line

If the customer has several active email contacts in the system, information about each
contact is displayed in a separate tab.

To view information about a deferred email contact:
1. Double-click the new email contact to open it in your desktop and view information
about that contact in the EDU Viewer.

2. Click the Active Contact Viewer button, which is located between the two boxes in the
Contact pane.

Note:
If the button is disabled, there is no other active email contact from the
customer in the contact center.

If any deferred email contacts from this customer exist, the Active Contact Viewer
dialog box opens and displays information about them.

Viewing Contact History Information

The Contact History Browser contains information about completed contacts that your
current customer has had with the contact center. Contacts that have not yet been

wrapped up are not listed.
The Contact History Browser contains a tab for each of your current contacts. Each tab
contains the history of that contact, that is, the previous contacts the customer has had

with the contact center. Avaya Agent automatically brings the tab for the active contact to
the front of the Contact History Browser. To view information about another contact, click

the appropriate tab.

Note:
Current information about an active customer contact does not appear in the
Contact History Browser until you have wrapped up that contact.
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In addition to the information that is visible in the Contact History Browser, you can double-
click to see more details about previous email and chat contacts. The additional
information available in the Contact History Browser is as follows:

e Voice contact — No additional information.

e Email contact — When you double-click, displays the Email History dialog box, which
contains two tabs:

- Tracking History tab, which provides a more detailed description of each contact

- Customer History tab, which provides a detailed customer history and copies of
emails this customer sent to the company in the recent past

e Chat contact — When you double-click, displays your Internet browser and displays a
transcript of the previous chat session.

Clearing Current Contacts

You can clear the Contact History Browser of all the information that is currently displayed.

To clear contacts from the Contact History Browser:
1. Right-click in an empty part of the Avaya Agent.
2. Click Contact History Browser - Reset from the pop-up menu.
3. Click OK.

Filtering Contact History Information

If the current customer has a large number of contacts in the Contact History Browser, you
can use the Contact History Filter to filter records before they are displayed. For example,
if you click Email in the Media Type filter and enter May 1, 2003 and May 31, 2003 in the
Time filter, the Contact History Browser displays only email contacts received from a
customer in the month of May.

You can filter and display records by:

e Media type

e Date and time the contacts were received

e Last x contacts made by a customer (for example, the last five contacts)
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To filter contacts in the Contact History Browser:

1. Click the Contact History Filter button. This is the top button between the two boxes
of the Contact pane.

The Contact History Filter dialog box is displayed.

Contact History Filter

— Media Type Filter
¥ Enable Filter Media Mame: IF'hone 'I

i~ Time Filter

¥ Enatle Filter Start Date: I 5 AE/00 vl End Date: I 5 ME/00 vl

r— Last M Contacts Filker

Last IU Contacts
Reset | Set I Cancel |

2. Select the Enable Filter check box for the desired filter or filters.
3. Complete the required fields for the selected filter or filters, as follows:
e Media Type Filter — Select email, chat, or voice from the Media Name list.
If you want to view contacts of all media types, do not click this filter.
e Time Filter — Click a start date and an end date.

e Last N Contacts Filter — Enter a numerical value for the last number of contacts
you want to view (for example, enter 10 to view the customer’s last ten contacts).

4. Click Set.
Clearing Contact History Filters

To clear all contact history filters:
1. Click the Contact History Filter button.
2. In the Contact History Filter dialog box, click Reset.
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Reloading Layouts in the EDU Viewer

The EDU Viewer displays details of the current contacts in your task lists.

If your administrator instructs you to clear all current contacts from the EDU Viewer or to
reload updated layouts, you use options in a pop-up menu to do these tasks, as described
in the following subsections

e Clearing Current Contacts in the EDU Viewer

e Reloading EDU Viewer Layouts

Clearing Current Contacts in the EDU Viewer

You use the EDUViewer - Reset command to clear all tabs of the EDU Viewer.

Note:
Only use the EDUViewer - Reset command if your administrator instructs
you to do so.

To clear your current contacts:
1. Right-click in an empty part of the Avaya Agent.
2. Click EDUViewer - Reset from the menu.
3. Click OK.

Reloading EDU Viewer Layouts

You use the EDUViewer - Reload Layouts command to reload the EDU Viewer formats
onto your desktop after your administrator has changed them.

Note:
Only use this command if your administrator instructs you to do so.

To reload the EDU Viewer formats:
1. Right-click an empty part of the Avaya Agent.
2. Click EDU Viewer - Reload Layouts from the menu.
The revised templates are loaded onto your system.
3. Click OK.
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Using the Unified Agent Directory

The Unified Agent Directory (UAD) is a directory full of information about resources in your
contact center. Depending on the set-up at your company, the UAD may have the following
tabs:

e Queues tab — The UAD always has a Queues tab. When this tab is selected, the UAD
displays queues, which are groups of agents with certain similar skills or knowledge who
handle a particular media type. The queues are used to route contacts to agents. For
example, there may be email queues for Hardware Sales, Software Sales, Hardware
Support, and Software Support, each containing agents who handle emails about a
particular type of customer. Similarly, there may be voice queues or chat queues who
handle particular types of customer.

e Agents tab — The UAD on your desktop may or may not have an Agents tab. If the tab
is present, it contains lists with many items of information about the Avaya IC users in
your contact center. This may include information about the following types of agents:

- Administrators
- Supervisors

- External agents, who are people, usually outside of your company, who possess
special knowledge or skills

- Agents with particular skills, such as speaking other languages or knowing a
particular operating system

e Tabs for individual workgroups — Your contact center may have set up workgroup tabs in
the UAD. Each workgroup tab contains information only about agents in that workgroup.
For each agent listed in the workgroup tab, only the agent’s login name, display name,
and primary email address are displayed.

You can use the UAD for the following purposes:

e Looking Up Queue and Agent Information on page 65

e Involving Other Agents in a Voice Contact on page 90

e Initiating a Voice Contact on page 94

e Sending an Email to an External Agent on page 110

e Transferring an Email Contact on page 112

e Originating an Outbound Email on page 124

e Involving Other Agents in a Chat Contact on page 152
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An agent is using the UAD in the following illustration to transfer a chat contact to another

agent:
Select Destination for Conference.... X|
1 —Ppiiicw L~ 9
2 —p Site:IDefauItSite j Tazk: SOFLA WATSOM [Sofia 'wats -€— 10
3 _> E uueueg E .":".QEFItS |
| Fe-Lygh Administrator
4 : DefaultT enant
5 ——»El @Default
g agent] [Joe Agentl]
6 g agent? [lane Agent?]
i zUper [Super Yizor]
El @ E astCoastGroup
agent3 [lim Agent3)
agentd [Suzie agentd)
ezLper [Supervizor Eastcoast)
7 — T IagentE 34-— 11
8 ————pp Comment: I.Jane, please help Sofia find the perfect running shoes.
O LCancel
1. View menu
2. Site drop-down menu
3. Tabs. Agents tab is selected in this illustration.
4. IC Default tenant
5. IC Default workgroup
6. Agents in the Default workgroup. Agent states are indicated by the icon.
7. To field for destination of contact. With a voice contact, you can enter a phone

number or queue manually.
8. Comment field where you can type a comment about this contact.
9. Active contact description
10. Active contact media type icon
11. Icon, which changes according to your previous action. A pencil indicates that you
typed in the To field. A greyed out pencil indicates that there is no text in the To
field. An Agent icon indicates that you selected an agent. An arrow indicates that
you selected a queue.
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Looking Up Queue and Agent Information

Whether or not you are currently handling contacts, you can use the UAD to look up
information about resources at your company. You may be able to find contact information,
such as email addresses and phone numbers, of other agents, supervisors, external
agents, or agents with particular skills.

This section explains how to look up information in the UAD, under the following topics:

e Looking Up Queues with the Queues Tab on page 65

e Looking Up Agents with the Agents Tab on page 66

e Looking Up Agents with the Find Option on page 70

e Filtering Data Displayed in UAD on page 68

e Updating UAD Information on page 74

Looking Up Queues with the Queues Tab

The Avaya IC software routes incoming customer contacts to various queues. A queue is a
group of agents with similar skills and knowledge assigned to handle specific types of
customer contacts.For example, there may be a Hardware Sales queue, a Hardware
Support queue, a Software Sales queue, and a Software Support queue, each containing
agents who handle a particular type of customer.

The Queues tab of the UAD lists the queues that administrators at your contact center
have set up in the database and marked for inclusion in the UAD (marked as
"addressable"). Queues include agents enabled to handle a single media type (Voice,
Email, or Chat) or the combination of Voice and Chat.

You use the Queues tab when you want to transfer a voice contact or email contact to a
queue. The transfer will be assigned to the first available agent in that queue. (Chat is the
exception. You cannot transfer a chat contact to a queue.) For information, see Involving
Other Agents in a Voice Contact on page 90 or Transferring an Email Contact on page 112.
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The following illustration shows the UAD open to the Queues tab when no contact has
been selected.

x|
Site: I DefaultSite hd l Task:
E Queues | 3 Agents |
D efaultChatlueue@0 efault Tenant
[ efaultE maillueusED efaultT enant
Eazt Coast Email Guele
To I ‘?
Comment: I
Ok | Cancel |

By default, the Queues tab displays only the queues that handle the same media channels

that you are currently handling.
To be sure that you have the latest information on queues, you should refresh the UAD
before using the Queues tab. See Refreshing the Entire UAD on page 75.

Looking Up Agents with the Agents Tab
If your UAD has an Agents tab, you can use it to look up information about people who
work for the contact center. You may find the following types of information about each
person who is listed in the Agents tab:
e General agent information, such as last name, first name, login ID
e Telephone numbers, such as primary, secondary, mobile, pager, and fax

e Email addresses, such as internal and personal

If your UAD does not have an Agents tab or if you are looking for agents with particular
skills, use the instructions in Looking Up Agents with the Find Option on page 70.

To look up agent information:
1. Right-click anywhere in the Avaya Agent Media pane.

2. Select Show Directory from the pop-up menu.
The Directory dialog box (the UAD) is displayed.
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3. Click the Agents tab (or any workgroup tab that you have containing agent
information).

The tenant and workgroups that you belong to, and the agents within these groups, are

displayed in a tree structure, as shown in the following illustration. A house icon
represents tenants and a folder icon represents a workgroup.

Note:
A tenant may be a company, such as XYZ Corp; a location, such as New
York or Boston; or a workgroup, such as Sales or Support.

Site: | DefaviSite | Task

E Hueuss |£ f-\gentsl

-1 Administrator
-t DefaultT enant
E--@Default
S agent! [Joe Agent]]
g agent? [lane Agent?)
e O super [Super Yisar)
EI@ EastCoastGroup
i 0 agentd [Jim Agent3)
agentd [Susie agentd]
esuper [Supervizor Eastcoast]

To I {:?

Comment;: |

[k | Cancel |

A red icon of a person’s head represents an agent. The appearance of the icon
indicates information about an agent, as shown in the following illustration:

- Agent LoggedOut
D - Agent Loggedin
B - Agent Aux\Work
EE - Agent Available
&8 - Agent Outbound

4. If the person you are looking for does not belong to this tenant or these workgroups,
make an appropriate selection from the Site drop-down menu. If you are not certain
which of these tenants and workgroups the person belongs to, select All Sites.

5. Navigate through the tree structure. Click the plus button (+) beside any tenant or
workgroup to display its contents. Use the scroll bars as necessary to see more

information.
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6. When you find the name of a person you want information about, right-click the name
and click Properties.

The Properties dialog box is displayed for this person.

=
Wigi
Siter [Refaibsite -1 Task:
agent11's Propetties |

& O
By Mame | Phonel E-mail I —

" Title First Mame iddle Mame Last Mame
E I Iagent‘l 1 I avapa

E Dizplay Mame

Iagent‘l 1 avapa

Manager's Mame

I™ Manager
| -

—T
Comment: I

o

Ok I Cancel |

7. Click the appropriate tab in the Properties dialog box to find the desired information
about this person.

Tip:
If you leave the UAD open for a while, the information may not be current.
You can right-click a workgroup and select Update State to update the
information in that workgroup. For more information, see Updating UAD
Information on page 74.

Filtering Data Displayed in UAD

You can use the Filter dialog box to limit the information you see in the UAD. You can filter
agents by the type of media agents handle, their agent type, and their current agent state.

To filter queue or agent information:
1. Right-click anywhere in the Avaya Agent Media pane.
2. Select Show Directory from the pop-up menu.
The Directory dialog box (the UAD) is displayed.
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3. Select View > Filter.

The Filter dialog box is displayed.

FMedia Tepo Agont Typo———— —&gent States
[+ “Yoice [ Software i+ Available
[~ Email [T Eutamnal ™~ Logged-n
[~ Chat [~ Supervizor T Any
| Apply I Cancel
Note:

If you do not see a Filter option in the UAD’s View menu, or if the Filter
option is disabled, your contact center does not use this feature.

4. In the Media Type section of the Filter dialog box, select or de-select the types of
media handled by agents that you will search for. You can select one, two, or all three
types. If you do not select a media type, all media channels are included.

5. In the Agent Type section, select one or two of the following:
a. Software if you want to search only for non-human resources like IVR queues.

b. External if you want to search only for people who have been designated as
external agents.

c. Supervisor if you want to search only for supervisors.

Note:

External agents are people, usually outside of your company, who have
been designated as external agents because of special knowledge or skills
they possess.

6. In the Agent States section, select only one of the following agent states:
a. Available includes only agents who are currently logged-in and available.

b. Logged-In includes only agents who are logged-in (whether they are available or in
Aux-work).

c. Any includes all agents regardless of agent state (whether they are logged in and
available, logged in and in Aux-work, or not logged in).

7. Click Apply.

The tab is updated to display only the information you included in your selections.
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Looking Up Agents with the Find Option
The Find option offers another method of looking up information about agents at your
contact center. With this dialog box, you can search for agents in the following ways:
e Media type (Voice, Email, or Chat)
e Agent type (External, Supervisor, or Software)
e Current agent state (Available, Logged-In, or Any)
e Skills (such as knowledge of a language or an operating system, and skill proficiencies)
e Personal information (First Name, Last Name, and so on)

The Find option returns three pieces of information about each agent: login ID, display
name, and media types that are enabled for the agent.

You can save the results of each search as a tab to be added to the UAD. The tab displays
the results list of the Find dialog box, including agents’ media types, login ID, display
name, and email address. This can help you find an agent with a specific skill when you
need one, such as an agent who is proficient in a specific language. For example, if you
occasionally receive voice contacts from people who speak German, you could search for
agents who speak German proficiently and who handle Voice. You would then save the
results of your search as a tab which you can name "German."

Note that you can search for agents by agent state, but agent state changes regularly. If
you want to be sure agent state is accurate, you may want to perform a new search.
To look up agent information with the Find option:

1. Right-click anywhere in the Avaya Agent Media pane.

2. Select Show Directory from the pop-up menu.

The Directory dialog box (the UAD) is displayed.
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3. Select View > Find.
The Specify Search Criteria dialog box is displayed.

Specify Search Criteria ﬂ
Search Status: Mot Started.
Agents | skils | ByMame |
Media Type Agent Type Agent States Find Mow |
[~ “Yoice I~ Software * Available
Stop Search |
™ Email [ Estemal " Loggedin
[~ Chat [~ Supervisor  Any MI
Save Results |
Note:

If the Find option is disabled, your contact center does not use this feature.

4. From the Site drop-down menu, select the location that you want to include in the
search.

5. Go to the appropriate step below for each tab you want to use for the search. Skip the
steps about tabs you do not want to use.

Tip:
You can use any of the three tabs (Agents, Skills, or By Name) in the
dialog box to select the criteria that will be used for the search. The tabs are
cumulative. This means that when you click the Find Now button, the
search will find only the agents that meet all the criteria you select in all the
tabs.

6. Agents tab — Select all the criteria that you want to include in the search, as follows:

a. In the Media Type section, if you want to look for agents who are enabled to handle
a single media channel, select that media type. You can select one, two, or all three
types. If you do not select any media type, the search will include all media
channels.

b. In the Agent Type section, select one or two of the following:
i. Software if you want to search only for non-human resources like IVR queues.

ii. External if you want to search only for people who have been designated as
external agents.

iii. Supervisor if you want to search only for supervisors.
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c. In the Agent States section, select only one of the following:
i. Available if you want to search only for agents who are currently available.

ii. Logged-In if you want to search only for agents who are currently logged in
(including those who are Available and those in Aux-work).

ii. Any if you want to include all agents.

7. Skills tab — If you want to search for agents with certain skills, such as agents who
speak certain languages or agents who support a certain operating system, click the
Skills tab and do the following:

a. If necessary, navigate through the folders.
b. When you find the skill you want, double-click to select it.
The selected skill moves to the bottom of the dialog box.

c. You can select a range (> for greater than; = for equal to, or < for less than) and a
Proficiency rating (Expert, High, Low, or Medium) to indicate the level of
proficiency by clicking in the appropriate columns.

For example, if you wanted to find an agent who speaks French well (greater than a
Medium level of proficiency), you might select a Range of > and a Proficiency of
Medium. You would first click the Range column to open the following menu:

Fange |
> <

KT E

Atfter selecting the range, you would click the Proficiency column and select the
range.

8. By name tab — If you want to find a specific person, click the By name tab and enter
any information that you know about the person in the appropriate text box.

Note:

The information is case-sensitive. If a person’s name is Bob, your search will
not find him if you type bob instead of Bob.
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9. Click Find Now whenever you have entered all the desired search criteria.

When the search is complete, the dialog box expands to display your search results.
The following illustration shows results of a search for chat agents who speak
French.

specify Search Criteria

Site: IM_I,I Site j Search Status: Complete -

igents Skills IB_I,INameI

@ Presview ;l

=5 Language

Fird Mo

Stop Search

J Mew Search
hd Save Fesults

ISearch # - 2

LR |

Skill Hame | Range | Proficiency
Skillz/Language/French = tedium - 3
< |

tedia | Login Mame | Dizplay Mame | E -mail Addresz

Chat JP Jean Pierre JP@xyzZoorp.com i_—— 4

1

-

Search Status.

Search Results text box giving the number of this search.

Skill that was searched for.

Information about the agent or agents that were found with this search.

Pobd=

10. Look at the results of the search at the bottom of the dialog box. If you think that the
results will be useful another time, create a tab with this data, as follows:

a. In the text box at the right side of the dialog box, where Search #X is displayed,
select the text and type over it to create a name for the new tab.
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b. Click Save Results.

A tab is added to the main screen of the UAD displaying the information found in the
previous search.

11. If you did not get exactly the results you wanted, change any of your selections in the
Specify Search Criteria dialog box as desired. Then click the Find Now button again.

A\ cauTion:
Use the New Search button only if you want to clear the previous search
criteria and begin again.

12. If you want to save the results in a tab added to the main UAD dialog box, you should
first rename the results in the Search Results text box so you will know what is
displayed in the tab. Then click the Save Results button.

Deleting Search Results Tabs

If you saved information you found in the Find option, new tabs were created in the UAD
with the results. You can delete any tabs that were created this way.

To remove search results tabs from the UAD:
1. Click the tab that you want to delete.

2. Select View > Delete Search Results.
The tab is deleted.

Updating UAD Information

Information about queues and agents changes over time. For example, new queues or
agents may be added or existing ones may be removed.

To be sure that the information you see in the UAD is current, you can refresh the UAD
before using it.

You can either refresh the entire UAD or you can update agent states only. To be sure you
get the latest information about queues, you must refresh the entire UAD.

If you want to be certain that the agent state information is current and your contact center
does not update this information automatically, or if your UAD has been open for a while,
you can update agent states only. If your contact center is large, it is faster to update agent
states than to update the entire UAD.
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Refreshing the Entire UAD

The information about queues and agents may have changed since you logged in. To be
sure that you have the latest information on both queues and agents, you can update all
UAD data. It may take a while to refresh the entire UAD.

To update all data displayed in the UAD:
e Select View > Refresh.

The UAD brings in all the latest information.

Updating Agent State Only
The information in the UAD about agents may not be current if your UAD has been open
for a while or if your administrators have turned off automatic updates of agent state data.

You can update the agent state of agents in a single workgroup. It is faster to update the
agent state in one workgroup than to update the entire UAD.

To update agent state data in members of a group:
1. Right-click the name of a workgroup.
2. Select Update State from the pop-up menu.
The latest agent state information for members of this workgroup is displayed.

3. Repeat with other workgroups, as desired.

Using Screen Pops

If your contact center has set them up, you may see screen pops, like the one in the
following illustration, when new incoming contacts arrive in your task lists. If you click Yes
in a screen pop, the new contact becomes active. If your contact center includes an agent
desktop application that is integrated with Avaya Agent, information about that contact is
automatically imported into that application.

If you are already responding to a contact when the new contact arrives, and you click No
in the screen pop, Avaya Agent does not display a second screen pop because the new
screen pop may interrupt your current contact. You can manually display a screen pop for
the second contact through the pop-up menu in the Avaya Agent Media pane.

Note:

Depending on how your administrator configured your system, you may not
see screen pops.
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To perform a manual screen pop for an incoming contact:
1. Click the new contact to make it active.
2. Right-click in any open area of the Avaya Agent.
3. Click Screen Pop in the pop-up menu.

Avaya Agent opens the integrated agent desktop application with customer information
about the incoming contact.

Wrapping Up Contacts

After you complete an incoming voice, email, or chat contact or an Outbound Contact call,
your contact center may require you to wrap up the contact or call by entering information
in a Wrap-up dialog box or a Prompter script. The information you enter is added to the
contact information in the database to assist the next agent who handles a contact from
that customer. Because each contact center handles wrap-up information differently, your
system administrator determines the following:

e Whether you are automatically placed in the WrapUp state after completing a contact

e Whether you enter information in a dialog box or click buttons in a script to enter
customer and contact information

e Whether you must record wrap-up information for every contact
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Using the Wrap-up Dialog Box

Most contact centers document the reason and outcome of customer contacts through the
Wrap-up dialog box, like the one shown in the following illustration.

Pl
Categories:
1 —>|L|:|an application |
Feazons: Outcomes:
R eazon | Dustcome |
— — -g— 3
2 — General inguiry Customer helped, satizfied
Wieh zite navigation help Customer not satizfied
Loan application help Customer wants callback
Wrap-up Selection|z):
Categan | Reazon | [utzome |
- 4
| Canicel I Histary = | -— 5

Categories drop-down menu
Reasons

Outcomes

Wrap-up Selection(s)
History button

abhobh=

When you wrap up a voice, email, or chat contact, you may need to select information from
one or more of the following areas of the Wrap-up dialog box:

e Categories — You may see a category for each of the media channels in this drop-down
menu. Of you may see another type of grouping of a set of reasons for the contact (for
example, Balance Inquiry or Cancellation Request).

e Reasons — Items that specify the purpose of a customer’s contact or the intent of the
work you performed.

e Outcomes — This information specifies the action you took or the result of your activity.

The Wrap-up Selection(s) area is for the items that you select from the Reasons and
Outcomes areas, or whatever areas you have in your Wrap-up dialog box.
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The Wrap-up dialog box may also have a History button that displays the following
information about previous contacts with this customer:

e The login ID of the agent who entered the wrap-up information
e The name of the agent who entered the wrap-up information

e A description of the category, reason, or outcome selected by the agent who
wrapped up the contact

To wrap up a contact using the Wrap-up dialog box:

1. Complete your voice conversation, chat session, or email with the customer, using the
Hangup button for a voice contact, or the Wrap button for an email or a chat session.
With an email, you may not need to use the Wrap button.

The Wrap-up dialog box opens automatically.
2. Select the appropriate item from the Categories drop-down list.

3. Select the appropriate items in the Reasons list and the Outcomes list, or whatever
lists you see.

Note:

If your Avaya Agent contains two or more lists, you may need to choose
from all available lists before you can add the entries to the Wrap-up
Selection(s) list.

4. Click the down arrow button to add the items you selected to the Wrap-up
Selection(s) list.

Note:

If you need to de-select an item that you added to the Wrap-up Selection(s)
list, select the item, click the up arrow button, and click OK.

5. Click OK.

6. If a dialog box asks you to confirm that you want to wrap the contact, click Yes.

Using a WrapUp Prompter Script

If your system is configured for a WrapUp Prompter script, the script is displayed in the
Prompter pane when you wrap up a contact.

The WrapUp Prompter script contains a series of questions about contacts specifically
designed by your company. You proceed through the script by clicking radio buttons,
selecting check boxes, or typing text in fields to provide information about the contact.
Generally, the answers to the script questions require you to select reason, category, and
outcome information, similar to the information fields in the Wrap-up dialog box (see Using
the Wrap-up Dialog Box on page 77).
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To wrap up a contact using the WrapUp Prompter script:
1. Click the Hangup button to complete the voice contact.

You automatically enter the WrapUp state, and the WrapUp Prompter script opens in
the Prompter tab of the Contact pane.

2. If necessary, click the Prompter tab to bring it to the foreground of the Contact pane.

Follow the script, selecting or entering the appropriate information. The following
illustration shows a Prompter script. Your script may not resemble this example.

name
Sessions Prew | MNext |

“Mirap-up =515=
History Please select the Category:
[ 001 - Auto Insurance
[T 002 - Home Insurance
[T 010 - New Mortgage
[T 011 - Refinance

| QPrompter  Cortact
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Chapter 3: Managing Inbound Voice Contacts

This chapter provides step-by-step instructions on using Avaya™ Computer Telephony for
IC to manage your inbound voice contacts.

When customers make telephone calls that come in to the contact center, their calls are
routed by the Avaya™ Interaction Center (Avaya IC) software to agents who are available
to handle voice contacts. Voice contacts that are routed to you are displayed in your Phone
task list.

This chapter includes the following topics:

e Using the Phone Task List and Softphone on page 82

e Handling a Basic Voice Contact on page 88

e Involving Other Agents in a Voice Contact on page 90

Initiating a Voice Contact on page 94

Example: Handling Two Voice Contacts on page 96
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Using the Phone Task List and Softphone

When your contact center application forwards a voice contact to your desktop, the contact
is displayed in the Phone task list, which is located in the Softphone interface, as shown in
the following illustration:

éhﬂnra nﬂmj

Media l Outbound Contact

Lt

|icurly] b ax 1 Woice 0 Email O Chat

765 OnHaold 0:46 - 4—— 3
» curly [nCall 0038 _I < 4

Hangup Haold
2 — | ritiate Tranzfer
Conzult Conference

Phone task list
Softphone buttons
On Hold voice contact
Active voice contact

Pobd=

The Phone task list displays information about all voice contacts you are currently
handling. Each entry in your Phone task list corresponds to a different voice contact.

The information about each contact that is displayed in your Phone task list depends on
the telephone switch used by your contact center. The Phone task list can display the
following information about each contact:

e Customer Number — The number displayed depends on whether the call is an inbound
or outbound call, and what information exists in the call record. If the call is:

- inbound, the display will show the primary ANI (Automatic Number Identification)
associated with the call. If that information is not available, it will show the ANI
associated with the call.

- outbound, the display will show the number that was dialed. If that information is not
available, the display will show the primary DNIS (Dialed Number Identification
Service). If that information is not available, the display will show the DNIS.

e Call ID — Number that identifies the contact to the software.

82 Avaya Agent User Guide



Using the Phone Task List and Softphone

e Call State — State of the contact (such as Ringing, Ready, Busy, OnHold, InCall,
WrapUp)

Note:

Your contact center may use different terms to describe call states. For
example, Ready may be known as Available. Busy may be known as
Auxiliary Work or Idle. The WrapUp state may be known as After Call Work.

e Time-in-call — The period of time that you have been on the call with the customer in
minutes and seconds.

Tip:
If you select a contact and hold your mouse over it for a moment, you will
see a "tooltip" with some of the same information about the contact. This
tooltip may be easier to read than the information within the task list and it
may contain additional information.

The status of a new contact in the task list before you answer the call is Ringing. You
double-click the contact to answer the call (unless you are using Auto Answer, which
answers the call for you). Then you begin talking.

An open angle bracket (>) indicates the active voice contact. This is the customer you are
currently handling. All buttons that you click apply to the active contact.

Blue highlighting indicates the selected contact. The selected contact may or may not be
the active contact.

Using the Softphone Buttons

You use the Softphone buttons to control the active voice contact. All Softphone buttons
affect the active contact. For example, if you click the Hangup button, the system hangs up
the active voice contact, but any other contacts in your Phone task list remain.

If you receive a second voice contact while you are still handling your first voice contact,
you can select the second voice contact by clicking it one time. This selects the contact
without answering the telephone call. It allows you to see information about the second
contact in the EDU Viewer or Contact History Browser while you are still engaged with your
first contact. A selected contact is highlighted in blue in the task list.

If you double-click the second voice contact, it becomes the active contact, while the first
contact is put on hold. You should tell your first customer that you will put them on hold
before you double-click a second voice contact.

If you have any problems with your Phone task list or with Softphone, see Inbound Voice
Problems on page 223.
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The out-of-the-box Softphone interface in the Media pane is shown in the following
illustration. Your Softphone may resemble the following illustration, or it may have a
different set of buttons.

éhﬂnra nﬂmj

Media l Outbound Contact

Lt

|lzurly] b ax 1 Yoice 0 Emal 0 Chat

765 OnHold 01:45 -

1 |
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2 —pr Hangup Hald -— S
3 —p Iniitiate Transfer < 6
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Active voice contact

Hangup button (Changes to Answer)
Initiate button

Consult button

Hold button (Changes to Reconnect)
Transfer button

Conference button
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With the telephony buttons, you can perform various Softphone functions. These buttons
can include:

e Answer or Hangup
e Hold or Reconnect
e Initiate

e Transfer

e Consult

e Conference

e Ready

e Busy

Telephony buttons are either available or unavailable to you, depending on the current
state of the active voice contact and on your agent state. For example, the Hold and
Hangup buttons are available only if the active voice contact is in an InCall state. If it is not
in an InCall state, the Hangup button is disabled (greyed out), and the Hold button is
either disabled or replaced by the Reconnect button.
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Using the Softphone Menu

With the Softphone component of Avaya Agent, you can perform standard telephone
functions without a physical telephone. The Softphone menu is part of the Avaya Agent
pop-up menu. You see this menu if you right-click (use the right mouse button to click) any
blank section of Avaya Agent. The pop-up menu contains the following menu options:

e Softphone - Login/Logout
e Softphone - Reset

For information on logging in and out of Softphone, see Logging In and Out of Media
Channels on page 45.

Using Softphone to Set a Reason for Being Unavailable

Depending on how your site is configured, you may see a dialog box whenever you log out
or click the Busy button on the Softphone.

In this dialog box, you must select a reason before you can log out or set your telephone to
the Busy state.

Select reazon code |

After Call 'wark,
Going for Smoke
Restroom Break,
b1

b2

Lunch

Cancel |

To select a reason:
1. Click the desired reason to select it.

2. If you want to clear the dialog box and select a different reason, click the Cancel
button.

3. Click OK.
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Using Softphone with DEFINITY Switches
If your Softphone system uses an Avaya™ DEFINITY telephone switch, you may need to

do the following tasks:
e Sending Numerical Information with DTMF

e Using the Auto-In Work Mode

Sending Numerical Information with DTMF

If your Softphone uses a DEFINITY telephone switch, your administrator may have
implemented DTMF. You use DTMF to enter numerical information, such as a customer’s
account or identification number, on the numeric keypad of the Dial Pad dialog box. DTMF
sends this numerical information to a selected device, such as an Interactive Voice

Response (IVR) unit, as if you had dialed the tones on your telephone.

Dial Pad E

123456733

|| 2] 3

BT | UEF

ol ra

A1 951 5
el JiL il

- 3 e
pops | Ty | wide
) [ ;
3 U "

Clear |

Send | [T

To send numerical information with DTMF:

1. In Avaya Agent, click the DTMF button.
2. In the Dial Pad dialog box, enter the numbers in either of the following ways:

e Click in the entry field. Then type the digits on your keyboard.
OR

e Click the numeric buttons in the keypad window.

If you type an incorrect number, click the CE (Clear Entry) button to clear one number
at a time or click the Clear button to completely clear everything that is displayed.

3. Click the Send button to transmit the number across the telephone line.
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Using the Auto-In Work Mode

This section applies to you only if you are using a DEFINITY telephone switch and you can
set the Auto-In and Manual-In work modes. You can set these work modes by pressing
buttons on your telephone, by entering codes on your telephone, or by using Softphone.
The work modes have been set up at your contact center to correspond to agent states in
specified ways.

The Auto-In work mode automatically assigns you to specific Automatic Call Distributor
(ACD) queues. It makes you available immediately after the end of a call. Therefore, with
Auto-In, you may get another call as soon as you hang up.

If you plan to take a break after your current call while in Auto-In mode, you can change
your work mode or agent state while on the call. The operation does not take effect,
however, until you complete the call. For example, while on a call, you can click the Agent
button in the Avaya Agent to change your agent state to Aux-work. The button will turn
grey and remain grey as long as you remain in the call. As soon as you complete the call,
your state will change to Aux-work and the Agent button will turn red.

In Auto-In mode, you cannot preset the Softphone while in a call to change from a Busy
telephone state to an Available telephone state. You must reset the Softphone to change to
and from the Aux-work state. See Softphone Stops Responding on page 226.

Be aware of the following issues when using Auto-In mode:
e You should not use this mode when you are handling outbound calls.

e If you are logged in to email or chat, you should log out of those media before using
Auto-In.

e Presets from your physical telephone while your voice contact is in the InCall state do
not work.

e If your Avaya Agent is not configured for wrap-up, you cannot set a WrapUp preset on
your physical telephone while in automatic mode. (For an explanation of automatic and
manual modes, see Changing State Across All Media Channels on page 53.)

e Other buttons you push on your physical telephone while wrapping up in automatic
mode may not work.

e If your system uses the Wrap-up dialog box and you press the Autoln and Manualln
buttons, a voice contact may be assigned to you while you are handling another call.
You will see a Wrap-up dialog box for the first call after it ends, but a second call may
arrive before wrap-up is complete. This will not happen on subsequent calls.
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The following table shows how your agent state changes when you press a telephone
button in either manual or automatic mode.

Initial Agent State Phone Button Pushed Changed Agent State
Available Autoln No change
Manualln No change
AfterCall Voice channel changes to
busy
AuxWork Aux-work
Aux-work Autoln Available
Manualln Available
AfterCall No change
AuxWork No change
Init aux-work Autoln For all buttons:
Manualln No Change / Aux-work at
AfterCall the end of the call
AuxWork
Outbound Autoln Available
Manualln Available
AfterCall No change
AuxWork Aux-work

Handling a Basic Voice Contact

This section explains how to handle a basic incoming voice contact, under the following

topics:

e Handling Contacts With Auto Answer

e Handling Contacts Without Auto Answer

e Placing a Voice Contact on Hold

e Involving Other Agents in a Voice Contact
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Handling Contacts With Auto Answer

If you have Auto Answer turned on, Softphone automatically answers an incoming voice
contact and makes that your active contact. Softphone does the following:

e Answers the voice contact.
e Makes it the active contact.

e Highlights the contact in the list and adds an open angle bracket (>) to help you identify
this as the active contact.

e Changes the contact’s status in the Phone task list to InCall.
To answer a new voice contact with Auto Answer turned on:
1. Begin speaking with the customer.

2. When you have finished the call, click the Hangup button in Softphone.

Handling Contacts Without Auto Answer

If you do not have Auto Answer turned on, follow this procedure.
To answer a new Softphone contact:
1. Double-click the new voice contact in the Phone task list.
2. Begin speaking with the customer.
3. When you have finished the call, click the Hangup button in Softphone.

Note:

If you see CTI - Server Failure in the Phone task list, contact your
administrator.

Placing a Voice Contact on Hold

You can place a voice contact on hold while you look up information, answer another
contact, or transfer the voice contact to another agent. The contact’s status in the Phone
task list changes to On Hold.

A button in Softphone changes its label between Hold and Reconnect. When you click the
Hold button, the label changes to Reconnect. When you click the Reconnect button, the
label changes to Hold.
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Note:

If you are using an Aspect switch, you cannot use the Hold and Reconnect
buttons. Instead, to put a current voice contact on hold and connect to a new
voice contact, double-click the new contact. To reconnect to the first voice
contact and put the second contact on hold, double-click the first contact.

To place a customer on hold while you speak to another customer:

1. Ask the customer with whom you are speaking if you may put them on hold for a
moment.

. Click the Hold button.
. Double-click the new voice contact in the Phone task list.

. Begin speaking with the second customer.

a A WO N

. Return to the first customer as soon as possible, as follows:

a. Either finish the call with the second customer or tell that customer you will put them
on hold.

b. Click Hold if you did not finish the call with the second customer.
c. Select the first voice contact in the Phone task list.
d. Click Reconnect.
e. Continue your conversation with the first customer.
6. If the second customer is on hold, return to that customer as soon as possible.

For more complete information on handling two simultaneous telephone calls, see
Example: Handling Two Voice Contacts on page 96.

Involving Other Agents in a Voice Contact

At certain times, you might want to have other agents help you with a customer to whom
you are speaking. You can do so using the following Softphone buttons:

e Transfer — Transfers the call and removes the voice contact from your Phone task list
immediately. You will not be able to speak to the customer after you complete the
transfer. The call waits in a queue until it is connected to an agent.

e Conference — Transfers the call to another agent while you remain on the call, and lets
you, or the other agent, add more agents to the call as well.

e Consult — Places the customer on hold and connects you to the other agent so that the
two of you can talk privately before the call is actually transferred. Once you are done
consulting with the agent, the call is transferred and the contact is removed from your
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Phone task list. You will not be able to speak to the customer after you complete the
consult.

You can also transfer the voice contact to a queue if you prefer. The system routes the
transfer to anyone currently available in that queue. You may also be able to transfer a
voice contact to an individual agent.

Tip:
If you want to transfer a contact to someone with a particular skill, first use
the Find option to get the skilled person’s contact information, as described
in Looking Up Agents with the Find Option on page 70. Then return to this
section to transfer the contact to that agent.

Note:

For information on transferring an Outbound Contact call, see Transferring,
Conferencing, and Consulting an Outbound Contact Call on page 207.

To transfer a voice contact to a queue or an agent:
1. Tell the customer that you are going to transfer them to someone who will help them.

2. Click the Transfer, Conference, or Consult button on the Softphone, according to the
type of transfer you want to do, as described above.

The Select Destination for <Transfer, Conference, or Consult> dialog box is
displayed, depending on which button you clicked. The following illustration shows the
Select Destination for Transfer dialog box.

Select Destination for Transfer....

Migw
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Ok | Caricel |

3. If you want to transfer the contact to the first available agent in a queue, leave the
Queues tab selected. If you want to transfer the call to an agent, select the Agents tab
or other appropriate tab.
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4. If the queue or agent to whom you want to transfer the contact is located at a different
site, select that site from the Site drop-down menu. Select All Sites if you do not know
where the queue or agent is located.

Tip:
If you are certain you know the telephone number of an agent to whom you
want to transfer the contact, you can enter the number in the To field, and
then skip to Step 6 in this procedure.

5. Find and select the queue or agent who will receive this transfer. If you need help
finding an agent, see Looking Up Agents with the Agents Tab on page 66.

The queue name or agent name is placed in the To field when you select it. In the
following illustration, a queue has been selected.

Select Destination for Transfer....

Wi

Site:[&l Sites v Taskidz2 €
& cueues |2 Agentel
G0 716

byt ualtlueue

To:  |MyVirtualOueue [«

Conmneril. ||

Ok I Carizel I

6. If you want to send a message to the agent who will receive the contact, put your
cursor in the Comment field and type the message.

The agent will see your message in the EDU Viewer.
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7.

10.
11.

Involving Other Agents in a Voice Contact

Click Ok, or press Enter when your cursor is in either the Comment or To field.

If you selected another agent, the <Transferring, Conferencing, or Consulting> Call
with < telephone number> dialog box is displayed.

ranferencing Call with F1h..

Ringing...

switch 1o Caller | Lamplete | Lancel |

Watch the status of the transfer that is displayed in the dialog box. In the illustration
above, the status is Ringing. This indicates that the other agent’s telephone is ringing.

If you are doing a Transfer, that is, you clicked the Transfer button in Step 2, the dialog
box disappears when the agent answers the telephone. A Wrap-up dialog box may
then appear for you to wrap up the contact.

If you are doing a Consult or a Conference, the dialog box status changes from
Ringing to In Call when the agent answers the telephone. The dialog box contains
buttons that let you switch between talking to the other agent and talking to the caller
(the customer). The dialog box will remain on your screen until you click the Complete
button.

. If you are doing a Consult or a Conference, begin speaking to the other agent when

the status in the dialog box changes to Connected to Destination and the button
changes to Switch to Caller. Tell the agent about the customer’s question or problem.

. Click Switch to Caller when you are ready to speak to the customer.

When you are connected to the customer, the status changes to Connected to Caller
and the button changes to Switch to Destination. You can click that button to speak
to the agent again.

If you are doing a Conference, add other agents to the call.

Whenever you want, you can complete your part of the Consult or Conference. Say
good-bye to the customer and agents, and click the Complete button in the dialog box.

Note:

If you see the Wrap-up dialog box or a Prompter script, wrap up the voice
contact as usual.
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Initiating a Voice Contact

If you are enabled for voice contacts, you can use your contact center telephones to make
a voice contact. You can use the UAD’s Select Destination dialog box to find the
telephone number of another agent, supervisor, or external agent who works for your

company.

Note:
If you are looking for information about making outbound calls as part of
your job duties, see Handling Outbound Contact Calls on page 193 or
Managing Outbound Lists on page 215.

To initiate a call:

1. Click the Initiate button on the Avaya Agent Softphone to open the Select Destination
for New Call dialog box.

Select Destination for New Call....
Wiew

Site: I DefaultSite TI T ask: <New Callz t
= ueues | L .&gsntsl

GH0_F1E
Mytfirtuallueue

To I ﬂ:‘?

Carmment: I

Ok Cancel

Tip:
If you know the telephone number of the person you want to call, you can
enter that number in the To field at the bottom of the UAD. Then skip to Step

9 of this procedure.

2. If you want to call the first available agent in a queue, click the queue in the Queues
tab.

The name of the queue moves to the To field.

a. If you want, write a comment in the Comment field for the agent who will receive
your call. The agent will see your comment in the EDU Viewer.
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10.
11.

Initiating a Voice Contact

b. Click Ok.
A dialog box informs you that you are being connected.
c. When you hear the other agent, begin speaking.

d. When you are finished speaking, click the Softphone Hangup button.

. If you want to call a specific agent, and there is an Agents tab on the UAD, click on

that. If you do not see an Agents tab, search for the person as described in Looking
Up Agents with the Find Option on page 70 or Filtering Data Displayed in UAD on
page 68.

. If the person is not located in your site, select the name of the site from the Site drop-

down menu. If you do not know where the person is located, select All Sites.

. Navigate through the tree structure in the scroll box on the left. Click any tenant or

workgroup to display the agents in that tenant or workgroup. Use the scroll bar as
necessary.

. When you see the name of the person you want to call, you may want to check that

this is the correct person. To do so:
a. Right-click the name and click Properties in the pop-up menu.

b. Click the Phone and Email tabs of the dialog box as necessary so you can check
that this is the person you want to call.

c. Click OK to return to the previous dialog box.

. When you find the correct name, click the name once to move it to the scroll box at the

bottom.

Tip:
You can double-click the name instead, if you want to connect the call
immediately.

. If you want, write a note to the agent in the Comment field. Comments are displayed in

the agent’s EDU Viewer.

. Click OK.

A dialog box informs you that you are being connected.
When you hear the other agent, begin speaking.

When you are finished speaking, click the Softphone Hangup button.
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Example: Handling Two Voice Contacts

With Softphone, you can handle more than one incoming voice contact at the same time,
using either the telephony buttons or keyboard shortcuts. By following this example, you
can take two incoming voice contacts using the Softphone telephony buttons.

In the following example, a voice contact comes into the contact center. Your Softphone is
in the Ready state. Avaya IC routes the voice contact to you. Your Phone task list displays
the caller’s telephone number and the contact’s status as Ringing.

To answer two simultaneous voice contacts:
1. If Auto Answer is not turned on, double-click the contact to answer it manually.

2. Ask for information from the customer, who is following up on a previous contact. Use
the Contact History Browser to look up the record on the previous contact.

While you are looking up the customer’s history, another voice contact is assigned to
you.

3. Click the Hold button to place the first voice contact on hold so that you can answer
the second voice contact.

4. Double-click the new incoming voice contact to answer it.

5. Click the Hold button to place the second voice contact on hold while you complete the
first voice contact.

6. To return to the first voice contact, select it in the Phone task list. Then click the
Reconnect button.

7. When you have completed the first voice contact, click the Hangup button.

8. If your company requires you to enter wrap-up information for each contact, you enter
the WrapUp state, and the Wrap-up dialog box is displayed. Select the reason and
click OK.

When you complete WrapUp, this information is entered into the customer’s record.
(For more information about wrapping up contacts, see Wrapping Up Contacts on
page 76.)

9. Click the second voice contact in the Phone task list to make it the active contact. Click
the Reconnect button to speak to the customer.

10. If you do not have the information the customer needs, click the Transfer or Consult
button to transfer the second voice contact to another agent (see Involving Other
Agents in a Voice Contact on page 90).
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If your account is enabled for Email Management, you use the Web Agent to interact with
customers by email.

Some customers send email from the company’s Web site while others send it from a
corporate or personal mail account. The email is routed by the Avaya™ Interaction Center
(Avaya IC) software to agents who are available to handle email. Email contacts that are
routed to you are displayed in your Email task list.

This section contains the following topics:

e Being Alerted to a New Email Contact

e Using the Email Task List

e Viewing Email History

e Composing a Normal Email Reply
e Addressing Emails with the UAD

e Using Resources in Email

e Using Suggested Responses

e Sending an Email to an External Agent

e Transferring an Email Contact

e Deferring an Email

e Saving a Draft
e Forwarding an Email

e Spell Checking Your Emails

e Requesting More Information from Customer

e Responding to an Email Alert

e Resolving an Email

e Originating an Outbound Email

e Approving or Rejecting an Email

e Handling a Rejected Email
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e Using Multiple Languages with Email

e Wrapping Up an Email Contact

Being Alerted to a New Email Contact

Email that customers send from the company Web site may be routed to you whenever
you are available for email.

Depending on how the Avaya IC software has been set up at your contact center, you may
be alerted to an incoming email in two ways:

e By a sound. For information on changing the way that you are alerted, see Setting
Preferences on page 180.

e By a screen pop. This is a dialog box that asks if you want to suspend your other
contacts to begin handling the new email contact. You may be able to control whether
you receive this dialog box, with the Wait for agent confirmation before accepting a
contact preference. For information, see Setting Preferences on page 180.

Note:
If you are alerted to an email contact but do not acknowledge it within a
preset amount of time, the contact is assigned to another agent and
removed from your Email task list. The amount of time is set by the
administrator of the WebACD Server configuration.
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Using the Email Task List

The Email task list displays the email contacts currently assigned to you. A typical Email
task list is shown in the following illustration:

||| ovigin | A

B [ jbb@rw.com 1| — 1
Ep B lesiew@myhome.., 0 <—— 2

1| | [» 1. Oldest contact

— 2. Active contact

How do | retumn a pair of shoes | | <@—— 3 3. Subject line of selected email
ordered? contact

If you click a contact in the Email task list, it becomes selected. The subject line of the
selected contact is displayed when you click the contact. All tasks that you perform to the
email in the Web Agent apply to the selected email contact. (When you double-click a
contact, the Web Agent window opens and displays this contact in Compose mode or
Reply mode.)

A good deal of information about your email contacts is displayed in the small space of the
Email task list by visual cues, including icons and text.

Icons in the Email Task List

If you pay attention to the icons in the task list, you can see at a glance a lot of useful
information. There are three columns of icons in the Email task list.

The icons in the first column indicate whether the email is active or has been transferred,
as shown in the following table

Icon Description

B The email contact is active.

E You have transferred this email to your supervisor or to another agent. The
contact remains in your task list until you wrap it up.
Note: If you receive an error when you transfer an email to another agent,
contact your administrator.
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The icons in the second column give you information on the source of each email contact.
You may see icons representing the following sources:

Icon Description

A reply to a normal email sent to the customer by the agent

o

A reply from an external agent

e

A reply from a customer to a request for additional information

ol

A reply to an email you forwarded.

;]

An email composed by another agent and forwarded to you for approval
(Quality Assurance)

An email rejected during Quality Assurance and sent to you for correction

A reply to an email that you originated.

¢ BB

An email alert, notifying you that an email requested from a customer or an
external agent is overdue.

1
F

A reply from an automatic response email that was sent to the customer from
ﬂ;' the Avaya IC system.

Icons in the third column the current status of each email contact, as shown in the following

table.
Icon Description
% New, unopened email contact.
b Open, active email contact. This is the contact you are currently handling in
the Web Agent.
. Deferred email contact. Click this contact when you are ready to complete
your email reply.
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Icon Description
E-F Email contact in WrapUp state. You are wrapping up this email in the Web
d Agent while you select information in the Wrap-up dialog box or you use a

Prompter script.

T Email contact is in Inactive state. That is, a set amount of time has passed
since you selected it. When you click it, this contact will become active.

Text in the Email Task List

The following areas give you text information about a selected email contact:
e Origin — The email address from which the email was sent.

e Age — The length of time the contact has been assigned to you. The time runs
continuously until you complete the contact.

e Question box — The text the selected customer typed in as the subject of their email.

Tip:
You may not be able to see all of the information in the Origin and Age
columns. To see all of the information, hold your cursor between two
columns until the cursor changes its shape. Then click and drag the column
to the left or right until you can see the information you want to see. Repeat
in the other direction as desired.

Viewing Email History
You can search for copies of previous emails sent by your customers in the History dialog

box. This dialog box has the following tabs:

e Tracking History — Detailed tracking information about the current email and past
emails sent from a customer’s email address

e Customer History — A list of previous emails the customer has sent to your company
and copies of the emails themselves
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Note:

Another agent may have deferred an email contact from this customer. You
cannot see deferred email contacts in the History dialog box but you can
see them in the Active Contact Viewer. It is a good idea to check the Active
Contact Viewer when you are looking for information about a customer’s
recent contacts. See Viewing Active Contact Information on page 58.

To see the tracking history or previous emails of an email contact:
1. Display the email you want information about in the Email Preview mode.
2. Click the Email History button in the email toolbar to display the History dialog box.
The History dialog box opens with the Tracking History tab displayed.

3. To see the maximum amount of information in the Tracking History tab, do any of the
following:

e To see all available information in a table column, hold your cursor at the right edge
of any column title. When you see a double-headed arrow, click and drag to the
right.

e To see tracking information about past emails sent by this customer, select the View
Full Email History check box.

4. To see complete technical information about the routing of any email selected in the
table, select the Header check box. When there is a problem, this information may be
helpful for supervisors or administrators.

5. To see copies of emails this customer sent to your company in the recent past, click the
Customer History tab.

6. Check your dialog box to see the time range of the emails displayed. For example, the
dialog box may display emails that were received in the past three months. If you want
to see emails that arrived before this time range, you may be able to clear the check
box to specify a longer time range.

7. Select any email in the box at the top to see a copy of the email itself in the scroll box
at the bottom.

Note:

If you see an Attachment button (paper clip) to the right of a selected email,
click the button to see a list of all attachments. Click the button to open the
attachments or save them to your computer.
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Composing a Normal Email Reply

The following procedure explains how to compose a normal reply to a customer email
using features available in the Email reply screen.

To compose a basic email reply to a customer:

1. Ensure that you are available to handle email by looking at the Email Channel button in
Avaya Agent. If the button shows a yellow X, click the button to make yourself available
for email.

You are now available to receive the number of email contacts that is set for you in
your channel load. See Setting Your Channel Loads on page 55 for information about
channel loads. After you become available, any email contacts that are routed to you
show up in the Email task list.

2. In Avaya Agent, select a contact in the Email task list. If there is more than one contact,
select the oldest one. The contacts are usually listed in reverse chronological order,
that is, with the oldest contact at the top.

For information about the meaning of the icons, and the text displayed in the Origin
and Time columns, see Being Alerted to a New Email Contact on page 98.

The Web Agent window opens in the Email Preview mode to show you this email and
information about it. The Information Bar displays "New inbound message from
customer.”

3. Read the message using the scroll bar, if necessary, to see the entire message.

4. If you see the Attachment button (paper clip) in the Email Preview toolbar, this email
has one or more attachments. Click the button to open the attachments or save them
to your computer.

5. Before you begin your reply, you can use any of the following buttons in the email
toolbar, as needed. You can also return to this Preview tab later to use these buttons.

e Print — Prints the currently displayed email to the default printer.

e Resolve — Lets you apply a status to the email. See Resolving an Email on
page 122 for information.

e Email History — Displays a dialog box with tracking information about this email or
copies of previous emails sent from the current customer’s email address, including
email attachments, if any. See Viewing Email History on page 101 for more
information.

e Transfer — Displays the Unified Agent Directory so you can transfer this email
contact to a particular agent, or transfer it to a queue and let Avaya IC route the
email to the first available agent in that queue. For information, see Transferring an
Email Contact on page 112.
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e Defer — Defers your reply to this email contact until a later time. The contact remains
in your Email task list but you are available for another email to replace this one. For
more information, see Deferring an Email on page 113.

e Wrap — Wraps up this email contact. See Wrapping Up an Email Contact on
page 129 for information.

6. To begin your reply, click one of the two reply buttons in the email toolbar:
e Reply — Addresses your reply to the sender of the email and no one else.

e Reply to all — Addresses your reply to the sender of the email and to all the people
listed in the Cc (Copy) field of the message you are replying to.

The window changes to Compose mode where you will write your email reply. Note
that the drop-down menu indicates that this is a Normal Reply.

7. If you want to add the email address of anyone in your company, so that they will
receive a copy of this email, add their email address easily to any of the address fields
by using the UAD. See Addressing Emails with the UAD on page 105 for information.

8. Look in the Resource area of the window to determine if there are any Suggested
Responses. If you see Suggested Responses, refer to Using Suggested
Responses on page 109 for instructions about choosing a response or responses.

9. If you do not see Suggested Responses, look for any resources that are relevant to the
customer’s question in the Email Templates folder, Global Resources folder, or Agent
Resources folder. For information on viewing resources, see Viewing Your
Resources on page 177.

10. If you found a resource that you want to use, add it to your message. For information
on adding resources to an email, see Using Resources in Email on page 107.

11. If you added a resource, read the message in the Message Composition area and
modify it appropriately, if necessary.

12. Type your message to the customer in the Message Composition area. Be sure that
you address the customer’s question or problem.
Tip:
If you added a resource or an attachment, you may want to begin with a
short introduction to explain the resource or the attachment.

13. Look over the buttons in the email toolbar to decide whether you want to execute any
of the commands before you send your message. The buttons are as follows:

e Print — Prints the currently displayed email to the default printer.

e Save — Saves a draft of your message. The contact remains in your Email task list.
The next time you double-click this contact and begin to reply to this customer’s
email, the Compose window opens with the message you saved.

e Cancel — Displays a dialog box that asks if you want to save a draft of the reply you
are composing. If you say No, your reply is deleted, and you must compose a new
reply for this email contact.
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e Add Attachments — Attaches a file from your computer’s hard drive or from the
hard drive of any computer that you can access on the network. When you press the
Add Attachments button, a window is displayed where you can browse to the file
and select it.

e Spell Check — Helps you check and correct the spelling of your message. For
information, see Spell Checking Your Emails on page 117.

Tip:
You can select an option in the Preferences dialog box to bring up the Spell
Checker automatically before your messages are sent. If you select this
option, you will not forget to spell check your messages. See Setting
Preferences on page 180.

14. When the message is complete, click the Send button.

If the Spell check before sending an email option is selected in your Preferences,
the Spell Checker is displayed so you can check the spelling in your message. Check
the spelling, referring to Spell Checking Your Emails on page 117 if necessary.

If the Confirm before sending an email option is selected, a dialog box asks if you
are sure you want to send the message. Click Yes.

To change the preferences that determine whether the Spell Checker or the
confirmation dialog box are displayed whenever you start to send an email, see Setting
Preferences on page 180.

Your response is sent to the customer.

15. Click the Wrap button to wrap up the email contact. If you need more information, see
Wrapping Up an Email Contact on page 129.

Addressing Emails with the UAD

When you address emails to people at your contact center, the Unified Agent Directory
(UAD) can help you find and add the addresses quickly and easily, and without errors. The
UAD opens in a special Email Addressing mode for this purpose. This is useful for the
following tasks:

e Composing a Normal Email Reply

e Sending an Email to an External Agent

e Transferring an Email Contact

e Forwarding an Email

Originating an Outbound Email

Issue 2 February 2005 105



Managing Email Contacts

Note:

The following procedure explains how to add email addresses, not how to
do other tasks such as transfer emails or send them to external agents. See
the appropriate sections, as listed above, for those procedures.

To address an email using the UAD:
1. Display the email you are responding to in the Compose window.
2. Click the button beside the Cc or Bec fields to display the UAD.
The meaning of these fields is as follows:

e Cc (Copy)— This field is for the address of any person or any queue that you want to
receive a copy of this email.

e Bcc (Blind Copy) — This field is for the address of any person or any queue that you
want to receive a copy of this email, without anyone else seeing their address.
Note:

The To field is disabled for a Normal Reply and for a Request Additional
Information email because the email is automatically addressed to the
customer to whom you are replying.

3. If the queue or person you are looking for is not located in your site, select the name of
the site from the Site drop-down menu. If you do not know where the queue or person
is located, select All Sites.

4. Navigate through the Queues tab, Agents tab, or any other tab available to you,
opening groups as necessary, until you find the queue or person to whom you want to
address this email.

5. Select the desired name and then click the To, Cc, and Becc button to add that person’s
email address.

6. Repeat the preceding steps as desired to add the addresses of all the intended
recipients to your email.

7. Click Ok.
The email addresses are added to the email you are composing.

8. If you are doing any of the following tasks, return to the appropriate section to finish
your email and send it:

e Composing a Normal Email Reply on page 103

e Sending an Email to an External Agent on page 110

e Transferring an Email Contact on page 112

Forwarding an Email on page 115

Originating an Outbound Email on page 124
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Using Resources in Email

Resources are previously prepared text, emails, and URLs (Internet addresses) that you
can send repeatedly to different customers by chat or email. Resources save you the time
and tedium of typing the same things again and again. Text and email resources may
contain such things as greetings, closings, and answers to frequently asked questions.
Email resources may have information already entered in the To, Cc, and Bcc fields, and
they may contain attachments. URL resources may be links to company Web pages. For
example, a URL may link to a page about exchange policies.

When you are composing an email, you may see any or all of the following types of
resource folders:

e Global Resources — This folder is for email, text, and URL resources created for you and
other agents by supervisors. If you are an agent, you cannot create or modify these
resources.

e Agent Resources — This folder is for email, text, and URL resources that you create for
yourself. These resources are saved with your login ID. You are the only person who
can see or use the resources you create.

e Email Templates — This folder is for a type of email resources called email templates.
These are created for you and other agents by administrators. An email template is a
prewritten email response that becomes customized when you use it. For example, your
current customer’s name and the current date may be automatically entered into the
email resource whenever you use it. Your company may also send a copy of an email
template when you apply a status to a customer’s email. For information, see Resolving
an Email on page 122.

e Suggested Responses — (If your company is not using the Content Analyzer, you never
see this folder.) This folder is for email resources that are created by an Avaya software
product, called the Content Analyzer, in response to a particular email. When these
resources exist, you must consider using them before you consider using resources in
any of the other folders. For more information, see Using Suggested Responses on
page 109.

e Migrated Resources — You see this folder after you import migrated resources. Your
administrator will inform you if you need to do this. See Importing Migrated
Resources on page 179.

The resources in the Global Resources folder and the Agent Resources folder can be any
of three types—email, text, or URL. The Email Templates and Suggested Responses
folders, when these exist, are always email resources. Email, text, and URL resources are
described in detail in Resource Types and Examples on page 172.
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Using Global, Agent, or Email Template Resources in an Email

To use a global, agent, or email template resource in an email:

1. While composing an original email or an email reply, look through the resources
available to you. See Viewing Your Resources on page 177 for information.

2. To use a resource, right-click it and select the appropriate option, depending on the
resource type. The options are as follows:

o Email, Email Templates, and Suggested Responses — Use is the only option.
When you select this option, the entire email resource is used, including all header
information and text in the resource. You can edit this information as needed.

e Text — Insert and Insert Quoted are the options. Insert places the text of the
resource into the email you are composing. Insert Quoted does the same as Insert
but adds a special character at the start of every line to indicate that the text was
pasted into the email. If you want to choose a different character to be inserted, see
Email Preferences on page 183.

e URL - Insert and Insert Quoted are the options. Insert pastes a copy of the URL
from the resource into the email you are composing. Insert Quoted does the same
as Insert but adds a special character to indicate that the URL was pasted into the
email.

A\ cauTiON:

You may be able to send a resource directly to the customer by double-
clicking it, depending on the way Avaya IC has been configured at your
contact center. If double-clicking sends a resource to the customer, be
careful not to double-click before you are ready.

3. If this is an email resource, email addresses in the To, Cc, and Bcc fields of the
resource are added to your email, along with any addresses already in your email
reply, such as the customer’s reply address. Modify or delete these addresses, and
add new ones if you want.

Note:

In a Normal Reply or a Request Additional Information email, you cannot
edit the To field because the email is automatically addressed to the
customer.

4. If there is no information in the Subject field, enter an appropriate subject.

5. Modify any text that was inserted from the resource into the body of your email, as
necessary.

6. Finish composing the email.
7. Click Send when you are ready to send the message.

8. Click Wrap to wrap up the email contact.
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Using Suggested Responses

Suggested Responses are generated automatically, either by Avaya IC or by software
called the Avaya™ Content Analyzer. The software is guessing that these responses may
appropriately answer the current customer’s question.

When an incoming email in your Email task list has been analyzed, you see a Suggested
Responses folder in the Web Agent. The resources are “dynamic,” that is, the resources
and the folder that contains them are only available when the email contact they were
created for is active. When you complete that email contact, the resources that apply to it
are removed.

You must read the email from the customer and decide which of the Suggested Responses
best answers the customer’s question or problem. If you see a score for the responses,
this may help you decide. The higher the number, the more likely it is that this is a proper
response to the customer’s question.

To select and send Suggested Responses:
1. Double-click an email contact in the Email task list.
The Web Agent window displays the customer’s message in the Email Preview mode.

2. Read the customer’s message, using the scroll bar if necessary to see the entire
message. Be sure you understand what the customer is asking.

3. Click the Reply button or select Contact > Reply to begin your reply to the customer.

4. If you see a Suggested Responses folder, look at the responses with the highest
scores first. The responses with the highest scores are displayed at the top of the list.

Note:

If you do not see a Suggested Responses folder, no Suggested Responses
have been created for this message.

The scores give an indication of the likelihood that each response is a good one. In
other words, the higher the score, the more likely it is that this is a proper response to
the customer’s question. However, only you can decide what is actually the best
response.

Tip:
You can hold your cursor over any Suggested Response to see information
about it, without opening it.

5. If the responses have attachments, verify that the attachments are appropriate for the
customer’s question.

6. Right-click each response and select View Resource. Read the responses one by
one, until you see one or more that you think answers the customer’s question. You
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may need to read all the Suggested Responses to find the response or responses that
you think answer the customer’s question best.

7. When you have found a response that you want to send to the customer, right-click it
and select Use.

The contents of the Suggested Response are inserted into your email reply.

8. If you want, add some additional text to address your customer directly, or make any
small changes that you think are necessary to better answer your customer’s question.

9. If you found other Suggested Responses that you think are appropriate, repeat Steps 7
and 8. Each time you select Use for a Suggested Response, that response is added to
the message. You can add or delete text to help your customer understand the multiple
responses.

10. When the message is ready, click Send.

11. Click Wrap to wrap up the email contact.

Sending an Email to an External Agent

If you do not know how to answer a customer’s question or solve a customer’s problem,
you should ask for information from a person, usually outside of your company, who has
been designated as an external agent because of special knowledge or skills.

You use a special type of email when you send an email to an external agent. This type of
email sends you or another agent an alert message if you do not get a response from the
external agent within a certain period of time.

You should defer the customer’s email to put it on hold while you write to the external agent
and wait for a reply. If you receive a reply from the external agent that will help your
customer, you can find the deferred email and send the customer the information.

To send an email to an external agent about a customer’s question:
1. Read the customer’s email in the Email Preview mode.

2. If you need information from an external agent to answer the customer’s question or
problem, click the Defer button in the email toolbar to put the customer’s email on hold.

The email contact remains in your Email task list, marked with a red icon to indicate
that it is deferred.

3. Click the Reply button or select Contact > Reply.

The drop-down menu displays the Normal Reply selection.
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4. Select Send to External Agent from the drop-down menu.

The letters RE: are added to the beginning of the Subject field of the email to indicate
to the external agent that this message is about an email you received.

5. Click the button beside the To field.
The UAD is displayed in External Agent mode. Only external agents are visible.

6. If the external agent is not located in your site, select the name of the site from the Site
drop-down menu. If you do not know where the external agent is located, select All
Sites.

7. Navigate through the tenants and workgroups in the UAD for the name of the external
agent.

8. Select the name of the external agent to move it to the To field.

You can only include one email address in the To field. If you need to write to additional
external agents, send a separate email, or add their email addresses to the Cc field.

9. Click Ok to add the external agent’s email address to your email.
10. Compose your email to the external agent.
11. Click Send when you are ready to send this email to the external agent.

12. Click Wrap to wrap up this email contact.

Handling a Reply from an External Agent

If you or another agent previously sent an email to an external agent, you may receive a
reply from the external agent as a contact in your Email task list.

To handle a reply from an external agent:
1. In Avaya Agent, select the reply from an external agent in the Email task list.
A special icon in the task list identifies this as a reply from an external agent.

The Web Agent window opens in the Email Preview mode to show you this email and
information about it. The Information Bar informs you that this is a reply from an
external agent.

2. Use the scroll bar, if necessary, to see first the message requesting information from
the external agent. Then read the reply from the external agent.

3. Take whatever action is needed. For example:

a. If you deferred the original email from the customer while waiting for the external
agent to respond, double-click the Defer icon in the Email task list. This makes the
email reply to the customer active again.

b. Copy the information in the reply from the external agent by clicking Ctrl-C.
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c. Paste the information into the reply to the customer.
d. Write any other text to the customer as appropriate.
e. Click Send.
f. Click Wrap.

Transferring an Email Contact

In most cases, you try to reply to your customers by yourself. But in some cases, you may
not be able to handle a customer’s problem. In those cases, you may want to transfer the
email contact to another agent or supervisor. When you transfer a contact, it is removed
from your task list, and it is no longer your responsibility.

Tip:
If you want to transfer this email to a person with a particular skill, for
example to someone who speaks a particular language or supports a
particular product, first use the Find option to find the email address of a
person with that skill. See Looking Up Agents with the Find Option on
page 70.

To transfer an email contact:

1. If you are not viewing the email you want to transfer in Email Preview mode, click the
Preview tab.

2. Click the Transfer button in the email toolbar.
The Select Destination for Transfer dialog box is displayed.

Select Destination for Transfer.... |

View

Site: I DefaultSite - l Tazk: rkalavan@ichat. com =1

E Queuss | 2 Agentsl

DrefaultE maill ueue@D efaultT enant
East Coast Email Queus
‘whest Coast Email Queue

Ta: IDe[aullEmaillJ ueuel@DefaultTenant E

Comment; IF'Iease zend Harriet information about home refinancing.

Ok LCancel
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3. If you want to transfer the email to anyone in a particular queue, do the following:
a. Select the queue from the Queues tab.
The name of the queue is displayed in the To field.

b. If you want to include a message to the agent who will receive the email, put your
cursor in the Comment field and type the message.

c. Click Ok.

The Email is transferred to the queue that you specified. The contact is removed from
your Email task list.

4. If you want to transfer this email to a particular person, click the Agents tab or the
appropriate workgroup tab. Then do the following:

a. If the person you are looking for does not belong to the tenant or workgroups that
are displayed, make an appropriate selection from the Site drop-down menu. If you
are not certain which site the person belongs to, select All Sites.

b. Navigate through the tree structure. Click the plus button (+) beside the name of any
tenant or workgroup to display its contents. Use the scroll bars as necessary to see
more information.

c. When you find the name of a person you want to transfer this email to, click the
name select it.

The name of the agent is displayed in the To field.

d. If you want to include a message to the agent who will receive the email, put your
cursor in the Comment field and type the message.

e. Click Ok.

The Email is transferred to the agent that you specified. The contact is removed from
your Email task list.

Deferring an Email

When you need considerable time to find an answer to a customer’s question or a solution
to the customer’s problem, you can defer the email contact so you can work on it at a later
time.

When an email contact is deferred, another email contact can be routed to you in the place
of the deferred contact. For example, if your channel load allows you to handle only one
email, when you defer an email, another email can be routed to you.
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To defer an email:

1. Click the Preview tab for this email if you are not already viewing the email in the
Preview mode.

2. Click the Defer button in the email toolbar.

The email is saved as a draft, including the customer’s address and any text that you
began writing. The email contact remains in your Email task list, marked with a red icon
to indicate that it is deferred.

3. Take any action necessary to find an answer the customer’s question. For example,
you may want to send an email to an external agent asking for information, or you may
want to transfer the email contact to another agent. See Sending an Email to an
External Agent on page 110 or Transferring an Email Contact on page 112.

Note:
After you defer the email, you are available for another email to replace it.
The wait time for the contact continues to count while the email contact is
deferred. When you are ready to work on this email, see Finishing a
Deferred Email on page 114.

Finishing a Deferred Email
If you deferred an email, you must return to it and complete it as soon as you can.

To finish a deferred email:

1. When you are ready to return to an email that you previously deferred, double-click it in
your Email task list.

The Compose window displays the message that you deferred. This is now an active
email contact.

Tip:
While you are replying to an email that you previously deferred, you are still
available for another email. If you do not want to receive another email
contact while you are replying to this email, click the Agent button or the
Email Channel button in the Avaya Agent to put yourself in Aux-work (Busy)
state. After you finish replying to the email, click the button again to make
yourself Available.

2. Finish writing your email reply. If you received information to help your customer, select
and copy the information by clicking Ctrl-C. Then paste the information into the email
reply by clicking Ctrl-V.

3. When the email is ready, click Send to send the email.

4. Click Wrap to wrap up the email.
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Saving a Draft

When you begin to reply to an email but cannot finish your reply at the moment, you can
click the Save button to save it as a draft. This saves the contents of your reply in the
Compose window and the email contact remains in your Email task list. When you are
ready to return to your reply, click its Compose tab. No new email contact can replace this
one until you finish your reply and send it.

Tip:
If you need to leave an email for a period of time because you are waiting for
information, you can defer the email and return to complete it later. This lets
you receive another email in its place. Deferring an Email on page 113 for
information.

Forwarding an Email

You may occasionally want to use Avaya Agent to forward a copy of an email that you
received to another email address. For example, you may want to forward an email
expressing a customer’s interest in a product that another agent supports. This lets the
agent contact the customer.

Do not use Forward:

e To transfer ownership of an email to another agent. If you need to transfer ownership of
an email to another agent, see Transferring an Email Contact on page 112.

e To write to an external agent for help with the email. If you need to obtain information
from an external agent, see Sending an Email to an External Agent on page 110.

If the Unified Agent Directory (UAD) at your contact center uses workgroup tabs or an
Agents tab, you can use the UAD to forward the email to a particular person, or to anyone
in a particular workgroup or anyone with a particular skill.

To forward an email:
1. With the email displayed in the Email Preview window, click Forward.

The Information Bar tells you that the email will be forwarded to the specified recipient.
The Subject field uses the subject of the email you are forwarding, preceded by FW: to
indicate that this is a forwarded message.

2. Write a message to the recipient or recipients of this forwarded email at the top of the
message itself. You may want to explain why you are forwarding the email and give
any other relevant information.
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Tip:
If you want to forward this email to a person with a particular skill, for
example to someone who speaks a particular language or supports a
particular product, use the Find option instead of the Agents tab described
in the following steps. See Looking Up Agents with the Find Option on
page 70. Then return to finish the remaining steps of this procedure.

3. Click the button beside the To, Cc, or Bec fields, according to which of the following
address fields you want to use:

e To — The main person to whom you want to forward this message. You can only
include one email address in this field.

e Cc (Copy) — Anyone else that you want to receive a copy of this email.

e Bcc (Blind Copy) — Anyone that you want to receive a copy of this email without
anyone else seeing their address.

The UAD opens in Email Addressing mode. This mode makes it easier for you to add
email addresses. In this mode, the UAD displays only the agents that are enabled for
email and it contains only their email addresses.

4. If you want to forward this email to a person, click the Agents tab or the appropriate
workgroup tab. If you want to forward this email to a queue, click the Queues tab. Then
do the following:

a. If the person or queue you are looking for does not belong to the tenants or
workgroups that are displayed in the box, make an appropriate selection from the
Site drop-down menu. If you are not certain which site the person belongs to, select
All Sites.

b. Navigate through the tree structure on the left. Click the plus icon (+) beside the
name of any tenant or workgroup to display its contents. Use the scroll bars as
necessary to see more information.

c. When you find the name of a person or queue you want to forward this email to,
select it from the list.

d. Click the To, Cc, or Bcc button to move the name of the person or queue to the
appropriate box.

e. Click OK.

The email address of the person or queue you selected is added to the appropriate
field of the email you are composing.

5. Repeat as desired if you want others to receive this forwarded email.

6. If you want to forward this email to anyone who is not in the UAD, type their address in
the appropriate field.

7. Click Send when you are ready to forward this email to all the included addresses.
8. Do any other required action to resolve the customer’s problem, such as the following:

a. Reply to the customer’s email (see Composing a Normal Email Reply on page 103)
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b. Request additional information from the customer (see Requesting More
Information from Customer on page 119)

c. Request information in an email to an external agent (see Sending an Email to an
External Agent on page 110)

9. Click Wrap to wrap up this email contact.

Spell Checking Your Emails

The Spell Checker can help you find and correct spelling errors in your email.
You can set two email preferences related to the Spell Checker.

e A preference lets you display the Spell Checker automatically whenever you press the
Send button. If you do not set this preference, you must select the Spell Check option
each time you want to check the spelling of an email message.

e A preference lets you determine whether the Spell Checker will always check the
customer’s original message as well as your reply or check only your reply.

Note:

If you set the preference to check only your reply, not the original message,
you should be careful when you use the Change All feature. The Change
All feature may not change all occurrences of the word, possibly leaving
misspelled words, if you do either of the following things:

e If you clicked the Ignore button when the Spell Checker found this misspelled
word in previous text of this email, then it will continue to ignore the misspelled
words.

e If you cancel the spell check before it has finished checking the entire
message, the misspelled word might occur in text that was not checked.

For information on how to set preferences, see Setting Preferences on page 180.

To check the spelling of an email:
1. Select Contact > Spell Check.
The Spell Checker is displayed.
Tip:
The Spell Checker has many features, all of which are labeled. You can see

what happens when you click any of the buttons on the right side of the
dialog box by holding your cursor over the button until a tooltip appears.
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2. If you composed the message in any language other than your primary language,
select that language from the Available languages drop-down menu.

This action changes to the dictionary of that language. Any words that are not in the
currently selected dictionary are displayed in the Not in dictionary text box.

3. If you see a word in the Not in dictionary box, look at the word to determine if you
think it is spelled correctly. Look at the list of words in the Suggestions box to
determine if any of those words is the correct spelling for the word. If so, select the
word and click the Change button.

Tip:
If a word is displayed in this box, it is not included in the currently selected
dictionary. However, it may be spelled correctly. For example, names of
people and products are not in the dictionary. If you think that you may use a
name again, click the Add button to add it to your dictionary.

4. If a misspelled word appears several times in your message, you can use the Change
All button to correct every occurrence of the word.

A\ cauTiON:

Be careful using the Change All button. Some occurrences of the word you
are searching for may be incorrect in one place but correct in another. Or the
word you are searching for may be part of another word. When you use the
Change All button, you must also be certain that the correct spelling is in
the Change box.

5. You may decide that you do not want the Spell Checker to check certain types of
words. Click the Options button to bring up a dialog box like that shown in the
following illustration in which you can select items for the Spell Checker to ignore.

Spelling preferences E3 |

[ ! lgnaore all-caps words (e.g., ASAF)

[ | lgnore capitalized wards (e.q., Canada)

[ | lgnore words with numbers (e.g., ¥2K)

v lgnore words with mixed case (e.q., SuperBase)
[+ lgnaore domain names (e.o., wintetreesofware corm)

[+ Repor doubled waords (2.0, the the)

v Suggest split words

e Cancel

6. When you are finished checking this message, click Cancel.
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Requesting More Information from Customer

Occasionally a customer may send you an email with incomplete information. For
example, the customer wanted to place an order but forgot to include a ZIP code in the
shipping address. In this case, you send a special type of email asking for the missing
information.

To request additional information:
1. Display the email from the customer in Email Preview mode.
2. Click the Reply button or select Contact > Reply.

The window changes to Compose mode. The drop-down menu under the toolbar
indicates that this is a Normal Reply. You must change this, as indicated in the next
step, if you decide that more information is needed from the customer.

3. Select Request Additional Info from the drop-down menu.

The Information Bar states, "This email will be sent to customer to request more
information."

4. Put your cursor at the top left of the Email Composition Area and compose an email to
the customer. Explain that you need more information to help them or fulfill their
request. Tell them exactly what information is missing.

5. When your email reply is finished, read it to verify that everything is correct.
6. Click Send.
The email request is sent to the customer.

Note:

If the customer does not reply within the time limit set by administrators, you
or another agent will receive an email alert, an automatically generated
email notifying you that the customer has not replied. If you receive an alert,
see Responding to an Email Alert on page 120.

7. Click the Wrap button to wrap up the email contact.
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Handling a Customer Reply to a Request for Information

If you or another agent sent a Request Additional Info email to a customer, you may
receive the customer’s reply.

To handle a reply to a Request Additional Information email:
1. In Avaya Agent, select the reply in the Email task list.

A special icon in the Email task list identifies this as a reply to a request for additional
information.

The Web Agent window opens in the Email Preview mode to show you this email and
information about it. The Information Bar informs you that this is a customer reply to a
request for information.

2. Use the scroll bar, if necessary, to see the original message requesting information.
Then read the reply from the customer.

3. If the information is still not complete, reply to this message as another request for
information, as indicated in Requesting More Information from Customer on page 119.

4. If the information is complete, click Reply to compose a reply to the customer. Thank
the customer for the information. Include any other message to the customer as
appropriate.

5. Click Send to send your request or your reply.

6. Click the Wrap button to wrap up the email contact.

Responding to an Email Alert

Occasionally you may receive an email alert. The purpose of this type of email is to notify
you that a response from a customer or external agent to a previous email is overdue.
Email alerts are generated automatically by the Avaya IC software.

A special icon in the Email task list indicates that this is an email alert. The Information Bar
in the Web Agent also informs you that this is an email alert.

The original email related to an email alert may be either of these:

e Request Additional Info - An email was sent to the customer requesting more
information, and the customer did not respond within the time limit for this type of email.

e Send to External Agent - An email was sent to an external agent requesting
information, and the external agent did not respond within the time limit for this type of
email.
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In some cases, you are the agent who sent the original email that requested a response. In
other cases, another agent sent the email.

When you receive an email alert, you must take action to try to get a response.

To respond to an email alert:
1. Double-click the email alert contact in your Email task list.

The Web Agent is displayed in the Email Preview mode. The Information Bar states,
"This is an email alert. The recipient of a request for information has not responded to
a request."

2. Read the email to see what additional information was needed from the customer or
the external agent.

Tip:
If you did not send the email requesting information from the customer or
external agent, you may want to click the Email History button to learn
more about this email or previous emails from this customer.

3. If the original email related to this alert was a Request Additional Info email, you
should try again to get a response from the customer. You have three choices:

e Call the customer on the telephone and ask the customer for the information. See
Initiating a Voice Contact on page 94.

OR

e Send the customer another request for information. If the customer fails to reply
within the set amount of time, another email alert will be generated. While viewing
the email alert in Email Preview mode, click the Reply button or select Contact >
Reply. Select Request Additional Info from the drop-down menu. Write a
message to remind the customer about the required information. Send the email
and wrap the contact.

OR

e Send the customer a normal reply. This will not generate another alert. While
viewing the email alert in Email Preview mode, click the Reply button or select
Contact > Reply. Leave Normal Reply selected in the drop-down menu. Write a
message to remind the customer about the required information. Send the email
and wrap the contact.

4. If the original email related to the email alert was sent using the Send to External
Agent selection, you should try again to get a response from an external agent. You
have two choices:

e Call the external agent on the telephone and ask for the requested information. See
Initiating a Voice Contact on page 94.

OR

e Send the email to another external agent or the same external agent.
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a. While viewing the email alert in Email Preview mode, find the text of the original
email that was sent to an external agent, scrolling down as necessary. Select that
text. Then click Ctrl-C to copy the text.

b. Begin a new email by selecting Tools > Compose Email.

c. Click on the button in the To field and select an external agent. If you need
information about finding an external agent, see Sending an Email to an External
Agent on page 110.

Tip:
Itis usually a good idea to select a different external agent than the one the
original email was sent to.

d. Click Ctrl-V to paste the text that you copied from the email alert into the new email.

e. Write an additional message if necessary to explain further what information is
needed.

f. Click the Send button.
Your reply is sent to the selected external agent.

g. Click the Wrap button to wrap up the email alert contact.

Resolving an Email

You can resolve a message without writing an email response. When you resolve an email,
you apply a status to it. The status tells the Email Management software how to handle this
type of email. For example, the software may reply to the customer’s message
automatically, using an email template. An email template is a complete email response
that can be used to reply automatically to customer emails that are alike in some way.

For example, your company may set up a Dismiss status. You are to apply this status when
all of a customer’s problems have been resolved and the customer writes an email to thank
you for your help. When you apply the Dismiss status, a copy of an email template is sent
to the customer. The text of the email thanks the customer for contacting your company
and invites them to contact the company again.

Your company has defined the list of statuses and the responses that are carried out for
each status. The statuses and responses may include the following:

e A customer sends an email praising the service or product they received. You apply an
Acknowledge status. A copy of an email template is sent to the customer to thank them
for their email.

e A person sends an email to your company’s email Support address, but the person is
not listed as a customer. You apply a Rejection status. A copy of an email template is
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sent to tell the customer that they cannot receive support to help them solve their
problem until they purchase a product.

e A customer sends a frequently asked question (FAQ) about cameras, for example. You
apply a Camera status. A copy of an email template is sent to describe the cameras that
they may buy.

You may need to ask your administrator or supervisor what types of messages you should
resolve and what statuses you should apply to them.

To resolve an email:

1.

Become familiar with the email statuses that are available to you before you need to
use them. Ask your administrator for information, or click the Resolve button in the
Email Preview mode and read the description of each status.

. When you receive an email contact that you need to resolve because it fits one of the

statuses, display the email in the Email Preview mode.

. Click Resolve.

A dialog box is displayed asking you to select a status to apply to this message.

. If the email is in a language that is not the primary language used at your company,

select the language from the Filter by language drop-down menu.

5. Read the description of each status.

6. If an email template is displayed in the scroll box at the bottom of the dialog box, read

the message for each status to determine if it is an appropriate response to this email.

Tip:
You may see strings of characters within the messages that you do not
understand. These character strings may be variables, that is, character
strings that stand for information that changes automatically when the
template is used. For example, the %date% character string may be a date
variable that will change to the current date and %customername% may
change to the current customer’s name whenever you use this resource.

. Select the status that is appropriate for this email, and click Resolve.

The Email Management software carries out the action that is associated with this
status. The dialog box closes and the email contact is removed from your Email task
list.
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Originating an Outbound Email

You may occasionally want to originate an email, that is, to send an email that is not a reply
to an incoming customer email. Usually, you originate an outbound email when you want to
send an email to an external agent to ask for information. The UAD helps you address an
original outbound email to an external agent.

To originate an outbound email:
1. If the Web Agent is not currently displayed, click the Web Agent button in the task bar.
2. In the Web Agent, select Tools > Compose Email.
The window is displayed in the Compose mode.
The Information Bar informs you that this is a new outbound email.

3. If you want to address this email to an external agent, click the button beside the field
you want to use, as follows:

e To — The main person or persons to whom you want to address this message
directly.

e Cc (Copy) — Anyone that you want to receive a copy of this email.

e Bcc (Blind Copy) — Anyone that you want to receive a copy of this email, without
anyone else seeing their address.

The UAD opens in Email Addressing mode. In this mode, the UAD displays only
external agents.

4. If you are looking for an external agent who does not belong to the tenant or
workgroups that are displayed, make an appropriate selection from the Site drop-down
menu. If you are not certain which tenant or workgroup the person belongs to, select
All Sites.

5. Navigate through the tree structure. Click the plus icon (+) beside the name of any
tenant or workgroup to display its contents. Use the scroll bars as necessary to see
more information.

6. When you find the name of the external agent that you want to address this email to,
select it from the list.

a. Click the To, Cc, or Bec button to move the name to the appropriate box.

Tip:
If you know an email address of someone else to whom you want to address
this email, type the address in the appropriate address field.
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b. Click Ok.

The email address of the external agent is added to the appropriate field of the
email you are composing.

If you need to delete the name of a person that you selected, click the name and
press the Delete key on your keyboard.

7. Repeat as desired to add other email addresses.
8. Put your cursor in the Email Composition area and type your message.
9. Use the Add Attachment or Spell Check buttons as desired.

10. When you are ready to send your message, click Send.

11. If a dialog box asks you for the information, specify the language to be used and the
queue to be used. The queue you select will be used in the From address of the email.
Therefore, replies to this email will be routed to the same queue.

Tip:
You can set preferences for the system to select the default queue or default
language automatically. Then the dialog box will not be displayed whenever
you send an original outbound email.

12. If a dialog box asks for confirmation, click OK.

Your email is sent to the recipients.

Approving or Rejecting an Email

The email replies that you and other agents send, or a certain percentage of them, may be
sent to an Approver for Quality Assurance before the emails are sent to customers. You
may be a designated Approver, even if you are not a supervisor. This section assumes that
you are a designated Approver.

When you receive an email that needs Quality Assurance, the Email task list displays a
Quality Assurance icon. You should give high priority to an email needing Quality
Assurance because the customer is waiting for a reply and the approval process may take
time.

When you click an email contact that has been sent to you for Quality Assurance, the
Information Bar also alerts you to the fact that the email was sent to you for your approval
or rejection.
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To handle an email sent to you for Quality Assurance:
1. Double-click the email contact in your Email task list.

Notice that the Information Bar informs you that this message needs Quality
Assurance.

2. Look at the customer’s message at the bottom of the email.
3. Click the Quality Assurance button.

The email is displayed as a reply to the customer in Quality Assurance mode.
Depending on the way the Quality Assurance feature was set up by your administrator,
the reply you compose to the customer here may be sent for approval again or it may
be sent directly to the customer.

4. Carefully read the agent’s reply to the customer’s email. Read any attachments as
well. Look for the following things:

e Did the agent respond appropriately to all of the customer’s questions and
problems?

e Did the agent use polite language?

e Did the agent use reasonably correct grammar and spelling?

e Did the agent include company promotional information, if applicable?
e If the email used any resources, are they entirely appropriate?

e If the email has attachments, are they appropriate?

5. If your answer to all of the previous questions is yes and you do not see any other
problems with the email, do the following:

a. Click Approve from the drop-down menu.

Iﬂapprwe 'I [E?Send

arked as ‘Approved’

b. Click Send.
The email is sent directly to the customer.

6. If you see problems with the email, do the following:

126 Avaya Agent User Guide



Handling a Rejected Email

a. Click Reject from the drop-down menu.

LREJECT "I [E?Send

——

Approve f -
Warked as 'Hejected'

The Information Bar changes to indicate that you rejected the agent’'s message.

b. Write a message explaining to the agent exactly what they need to do to make the
email reply acceptable.

Note:

You may want to ask your administrator whether the agent who receives this
rejected email is always the agent who wrote the reply. In some cases, the
administrator has set up the software so that an Approver’s comments and a
copy of the original email reply are sent to any available agent.

c. Click Send.
A confirmation dialog box is displayed.
d. Click Yes.

This message is sent to the agent for correction. When the agent corrects the message
and sends it again, the reply may be sent directly to the customer or it may be routed to
you or another Approver, depending on the setup at your contact center.

Handling a Rejected Email

Some or all of the emails you and other agents write to customers may be sent for approval
(also known as Quality Assurance) to another agent or a supervisor who is designated as
an email Approver. This person reads each email that is sent for approval and takes one of
the following actions:

e Approves the email and sends it to the customer.

e Makes corrections to the email, marks it as Approved, and sends the corrected email to
the customer.

e Marks the email as Rejected, along with a message explaining what needs to be done
to make the message acceptable and sends the email for correction. It may be routed
back to the original agent who wrote the rejected email or to any agent, depending on
the setup at your contact center.
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If you receive a rejected email in your Email task list, the email icon contains an X to
indicate that it is a rejected email. You should usually select this contact before other email
contacts in the list because the customer is still waiting for a reply.

To edit a rejected email:

1.

Double-click the rejected email contact in the Email task list.

The Web Agent window displays the rejected email in Email Preview mode. The
Information Bar identifies this as a rejected message.

. Read the message carefully, noting the comments that the Approver put in the email.

Note what changes are required to make the email to the customer acceptable.

. Click the Reply button or select Contact > Reply.

At this time, this email becomes a normal reply.

. Edit the email according to the changes recommended by the Approver.

5. When you are finished, reread the message from the Approver and check that you

made all the desired changes.

. Remove the message from the Approver and the original reply that was rejected.

A\ cauTiON:

The previous step is crucial. You must remove everything from this reply
except the new message to the customer.

7. Read the entire message to check it again. Make any necessary changes.

8. When you are ready to send the message, click Send.

Depending on the setup at your contact center, the message is either sent back to an
Approver or sent to the customer.

Using Multiple Languages with Email

You may receive emails in a language that is not your primary language. If you know the
language well, you may reply in that language. Check with your administrator if the
language is not displayed properly.

You can also spell check your reply in that language. When you open the Spell Checker
(select Contact > Spell Check), select the appropriate language from the Language drop-
down menu.
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In the following illustration, an agent is replying to an email in Chinese:

B[] S

Contact Resources Tools Help

SRy |

& B Agent resources
Returns & Exchanges| || [ This email will be sent to the customer

@ Global resources
€ (& Email templates Header [ Attachments |
To: |Elruse Lee <bruselee@yahoo. com=>
Ce: |
Bee: |

Subject:| @E: AvayatF 5B HEE(CRM)E B

IS

Avaya PR R - ESBNF FERERCRMBES LR, MBS, BHEEE
He PSR PR RBEE ¥ 0ERE P BEETEEEHERE Interaction
Management), T%% ZBusiness Intelligence ¥ ETE B (Commitment Management)Z
¥ Preview content i, BE - R EHEERS, EAFFAMEN R EIET,

EEERIMAIE SHE, SRFER SR ENTEINERT, B PR
FEENENEE R BHEEAEN S EERRES TEE-EN BN ESEEE. 86
ERENSSEEE Bt R EREEEE MRMEMEEF T,

TE B D B0 A8 B B R B EERE B AN ER R R AR AR E SRR 1 b B as B

Shopping Mecca wants you to [
returns policy.
ithin 30 days of your purcha

[4]

o [ D
[@ webaACD|@ Email €, super|a® Default[& jerry[S 1 Ayaya Web Agent (£)1999-2002 Avaya, Inc.

If you use another language, you may want to create some Agent Resources in that
language. See Managing Resources on page 171.

Wrapping Up an Email Contact

When you have sent a normal email reply to a customer, you may need to wrap it up. In
some contact centers, email is wrapped up automatically whenever an agent sends a reply
to the customer. Ask your administrator if your emails are wrapped up automatically. If the
answer is yes, you do not need to read this section.

You can select Email Preferences to wrap up email responses automatically after you send
them. see Setting Preferences on page 180.

When you click the Wrap button, you are in WrapUp state. While in this state, you cannot
receive another email contact to replace this one. You may need to perform the following
tasks:

e Enter information about the session in a Wrap-up dialog box.

e Follow a WrapUp script in Prompter.
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Note:

In certain cases, you may not see a Wrap-up dialog box for any of the
following reasons:

e The email contact was removed because you did not respond in the allotted
amount of time.

e Your supervisor removed the email contact to put it back in a queue.
e The email contact was cancelled in the server.

e The email contact was wrapped automatically because a preference to wrap
up this type of email automatically is selected in Email Preferences. For
information about the wrap-up preferences, see Setting Preferences on
page 180.

To wrap up an email contact:
1. After you send an email, click the Wrap button in the email toolbar.
2. If a dialog box asks if you want to confirm, click Yes.
Tip:
You can set a preference to control whether this dialog box is displayed

whenever you wrap up an email contact. See Setting Preferences on
page 180.

3. If you see a Wrap-up dialog box or a Prompter script, fill in the questions about this
email contact. For information about the dialog box or script, see Wrapping Up
Contacts on page 76.

The email contact is completed. It is removed from your Email task list.
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If your account is enabled for Web Management, you use the Web Agent to “chat” with

customers (that is, to exchange typed messages with customers in real-time).

Customers visiting your company’s Web site who have a question or want help can click a
button to request a chat session (or a chat session with a phone call or VoIP call). A
request for a chat session becomes a chat contact. Avaya™ Interaction Center (Avaya IC)

routes chat contacts to agents who are available to handle chat. Chat contacts that are
routed to you are displayed in your Chat task list.

This chapter explains how to receive and manage your chat contacts and the related
collaboration features. Collectively, these chat and collaboration features are referred to as
Web Management.

The chapter contains the following topics:

Being Alerted to a New Chat Contact

Using the Chat Task List

Identifying the customer chat client

Handling a Basic Chat Session

Sharing Browsers with a Customer

Using Resources in a Chat Session

Spell Checking Your Messages

Using the Phone in a Chat Session

Involving Other Agents in a Chat Contact

Involving Other Agents in a Voice Chat

Handling a JoinUs Conference

Handling Simultaneous Chat Sessions

Monitoring a Chat Session (Supervisors Only)

Starting a Lotus Sametime Session

Viewing Customer DataWake Records

Using Multiple Languages in Chat Sessions

Wrapping Up a Chat Contact
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Being Alerted to a New Chat Contact

Chat requests sent by customers who click the Chat button on the company Web site, a
chat contact is created. Chat contacts may be routed to you whenever you are available for
chat.

With chat, it is particularly important to respond quickly. Depending on how the Avaya IC
software has been set up at your contact center, you may be alerted to a new chat contact
in two ways:

e By a sound. A Contact preference lets you determine whether you are alerted with a
sound. For information, see Setting Preferences on page 180.

e By a screen pop. This is a dialog box that asks if you want to suspend your other
contacts to begin handling the new chat contact. The "Wait for confirmation before
accepting a contact" preference lets you determine whether screen pops are displayed
when new contacts arrive. For information, see Setting Preferences on page 180.

Note:

When a screen pop informs you that a new chat contact has arrived, clicking
OK or pressing the Enter key begins the chat session with the customer. Be
careful not to click OK or Enter accidentally when a screen pop appears. To
be sure that you do not do this, you can turn off the Wait for agent
confirmation before accepting a contact preference.

If you are alerted to a chat contact but do not acknowledge it within a preset amount of
time, the contact is assigned to another agent and removed from your Chat task list. The
amount of time is set by the administrator of the WebACD Server configuration.

Using the Chat Task List

The Chat task list displays all the chats that are currently assigned to you. Your Chat task
list is probably located near the bottom of your Media pane. Your Chat task list may look
something like this:

M ame ] Duratiu:un] Waiting |4

& elizabeth  001:05  0001:05 4 1 1. Oldest contact

& iohnd 000919 00:0016 2 2. Chat contacts currently assigned to you
3. Customer’s question (empty when your

'Q guest_Sa.. 00:12:44 00:00:00

i

cursor is not over a contact or when no
chat contact is selected)
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Each entry in your Chat task list relates to a different chat contact. If you have more than
one chat contact in the Chat task list, you can click each contact in turn to display its
customer’s question. For each chat contact, the Chat task list displays the following

information:

e Customer’s question — The text the customer typed when requesting a chat. The
question is displayed only when you select the chat contact. The question is also
displayed in the Web Agent when you double-click to make this the active contact.

e Name — The name that the user chose to log in to the Web site. Users can also log in as
“‘guest.”

e Duration — How long ago the customer was assigned to you. This time runs
continuously until you complete the contact.

e Waiting — How long ago the customer responded to you or requested a chat.

Each chat contact has a customer icon. The color on the customer icon changes as the

status of the chat contact changes. Shirt colors and other symbols indicate status as

follows:

e Red — It is your turn to respond. The customer has waited longer than the maximum
desirable time set up by your administrator.

e Yellow — It is your turn to respond. The customer responded recently. The customer has

not yet waited longer than the maximum desirable time.

e Green — It is the customer’s turn to respond. You sent the most recent chat message.

e Blue with an arrow symbol — This contact was transferred to you.

e Exclamation mark or something else if the icon was customized — It is the customer’s
turn to respond. The customer has not responded for awhile.

Icons are also used for chat contacts in which a customer requested a phone call (Chat &

Phone) or a VoIP call (Chat & VolP). These icons are the same as the icons for those

features in the Web Agent.

Identifying the customer chat client

Avaya IC includes two chat clients that a Website customer can use when they chat with
an agent. Depending on your setup, all chat customers might use the same chat client. Or,
you might have some customers who use one chat client and other customers who use the

second chat client.

In addition to the language selected by the customer, you see a message in the transcript
at the beginning of a chat session. The message identifies if the chat client used by the

customer does not support all features.
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Note:

The Welcome messages in the following table are the default messages.

These messages may be different in your system.

The following table describes the chat clients available with Avaya IC.

Chat client

Customer Chat
Applet

Description Welcome Supported features
message

Opens in a separate window - e Text chat

next to the internet browser e Page push

used by the customer. e Join Us

The set of features provided by
this chat client depends upon

e Shared browsing or
Collaborative form filling

which Java plugin the customer e Voice chat
has on their machine.
Warning: Java e Text chat
Pluginis enabled | e Page push
on Customer's e Join Us
machine. e Voice chat
Customer HTML | Can open in a separate window | Welcome to e Text chat
Chat Client next to the internet browser orin | Avaya Chat. You | e Page push
a frame of the website. can chat and e Join Us

This chat client provides a
reduced set of features.

send pages.

Handling a Basic Chat Session

This section presents the basic procedures to use with a customer in a chat session.
Before you go through the procedure, it is important for you to understand a chat session
from the customer’s point of view.

When customers visit the Avaya™ Interaction Center (Avaya IC) Web site that you are
supporting, they can click buttons to ask for different types of help. If they click a Chat
button, they are prompted to log in either with their user name and password or as a guest.
The customer will type chat messages to you in the chat client.

As the request is routed, a message displayed in the chat client informs them that an agent
will be with them shortly. If the request is routed to you, you see the chat contact in your
Chat task list. As soon as you double-click the contact, the customer sees a message in
the chat client that you have arrived to help them.

You should begin the chat session as instructed by your contact center administrators. For
example, you may type "Hello" and introduce yourself.
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Note:

Before you begin chatting with your first customer, ask your administrator
how you send chat messages to customers. Do you click the Enter key on
your keyboard or do you click the Say button in the Web Agent?

To interact with a customer using chat:

1. Look at the Chat button in the Avaya Agent status control. If the button has a yellow X,
click the button to make yourself available for chat.

When the Agent button does not have a yellow X, you are available to receive the
number of chat contacts that is set for you in your channel load. See Setting Your
Channel Loads on page 55 for information. Your channel load for chat is also displayed
in the Chat icon in the Status Bar at the bottom of the Web Agent.

2. In the Chat task list, double-click the contact you want to accept for a chat session.
Usually this is the customer who has waited in queue the longest, whose name is at
the top of the list.

If this is your first chat contact since you logged in or if this is the first chat session you
are monitoring, the File Download dialog box is displayed. The dialog box asks you to
choose what to do with the aimagentcl.hta file. This dialog box will not appear again
until your next login session.

A\ cauTiON:

As indicated in Step 3, you must open the aimagentcl.hta file. Do not save
this file. If you save this file, Web Agent cannot access the file and Shared
Browsing will not function.

3. If the File Download dialog box is displayed, click Open this file from its current
locationThen click OK.

An Internet browser icon is added to your Windows Task Bar. This is the browser you
will use for Shared Browsing with your first chat customer. For each chat contact that
you handle or monitor, another browser will open and another icon will appear in the
task bar. If you are a supervisor and do not plan to use Shared Browsing in your
monitoring sessions, you can select the “Start collaboration automatically when
monitoring a chat session” preference. When this preference is selected, a browser
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and an icon do not appear for each session. See Setting Preferences on page 180 for
more information.

The Web Agent opens in Chat mode, as shown in the following illustration.

ﬁ Avaya Web Agent + ;Iglll

Contact Resources Tools Help

|
BT E |

S Filter by | i |._°‘ Mew chat task from customer Sandy |
Resources  Question:
© B Agent resources Do you sell custom-made shoes? =] smw
B Global resources =
©- (& Email templates -
Call Connected. —
1

Yes, we do. 'l lead you to our Just-My-Size site and show you how to order shoes made just
for you.

2 o
| B Push URL | o Say

[@ webaCD|@ Email|@ Chat|®, super[ef Default[£ jerry [T 1 Ayaya Web Agent (£)1999-2002 Avaya, Inc.

[T [T

1. Customer’s question
2. Type your messages here.

4. Read the customer’s question in the scroll box above the Transcript area. If you cannot
see the customer’s entire question, use the scroll bar.

5. Consider whether any of the Global Resources or Agent Resources are appropriate to
send to the customer.

For information on viewing resources, see Organizing Your Resources on page 178.
For information on adding resources to a chat, see Using Resources in a Chat
Session on page 143.

6. Put your cursor in the Text Entry area and type a message in response to your
customer’s question.

7. When your message is ready, click the Say button or the Enter key, depending on the
configuration of Avaya IC.
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If the Spell check text before a "Say" preference is selected, your
message is spell-checked after you click the Say button. If this option is not
selected, you can click the Spell Check button or select Contact > Spell
Check at any time to check a message. For information on this preference,
see Setting Preferences on page 180. For more information on the Spell
Checker, see Spell Checking Your Messages on page 145.

Your customer sees the message you just sent in their chat client. In the Web Agent,
your message moves to the Transcript area. The message begins with your preferred
name followed by a colon. For example, if your preferred name is jerry, your Web

Agent may look like the following illustration:

ﬁ Avaya Web Agent

Contact Resources Tools Help

=10l x|

EEkE ez

b i by |_ M |._°‘ Mew chat task from customer Sandy |
Resources ) Question:
B8 Agent resources Do you sell custorn-made shoes? ‘: W
B Global resources - SM‘
© (& Email templates -
Call Connected. —
Caller missing phrase
1 —P ||| jerry: Yes, we do. Il lead you to our Just-My-Size site and show you how to order shoes
made just for you.
Sandy: Great!
AutoSync turned on.
jerry:
hittp: Mtest2 quintus comicmbvelcome html?nonescallid=3cfd3eal 0000000057 7h1 aBd232b0002 Sagentld=jerry
2 Your browser should have opened to the site now. =
—>
| B Push URL | o Say I

[@ webaCD|@ Email|@ Chat|®, super[ef Default[£ jerry [T 1 Ayaya Web Agent (£)1999-2002 Avaya, Inc.

1. Message agent jerry sent
2. Message agent jerry is about to send

When your customer replies, you see their message under yours in the Transcript

area, preceded by the customer’s user name.

8. Continue your conversation with the customer. Read the customer’s messages. Then

type and send your responses.
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9. Use any of the following buttons to access other features while you are in the chat
session:

e Print — Prints the currently displayed chat messages to the default printer.

e Auto Sync — Starts an Auto Sync session so your customer’s browser displays the
same Web pages as your browser while you navigate through Web pages. See
Using Auto Sync on page 139 for more information.

e JoinUs — Starts a JoinUs session in which friends of your customer can join the chat
session. See Handling a JoinUs Conference on page 161 for more information.

e Sametime — Starts a Lotus Sametime™ session with your chat customers. You can
only use Sametime if it is installed and configured for both you and your chat
customers. See Starting a Lotus Sametime Session on page 167 for more
information.

e Transfer — Displays the Unified Agent Directory (UAD) so you can transfer this chat
contact to another agent or supervisor. For information, see Involving Other Agents

in a Chat Contact on page 152.

e Chat & Phone — Lets you talk to the customer on a regular telephone connection
while still in the chat session. See Handling a Chat & Phone Session on page 147.

e Chat & VoIP — Lets you talk to the customer on a telephone-Internet connection
while still in the chat session. See Handling a Chat & VolP Session on page 151.

10. When your customer is satisfied, wrap up the chat contact. Use the instructions in
Wrapping Up a Chat Contact on page 170.

Sharing Browsers with a Customer

The term "Shared Browsing" refers to three features that make it possible for you and your
chat customer to see the same Web pages at the same time:

e Auto Sync — When you click Auto Sync and then navigate through a Web site, your
customer’s browser follows your lead to display the same pages simultaneously.

e Page Push — You "push" a URL to your customer. Your customer sees the page
displayed within their browser. The customer can push a URL to you as well.

e Collaborative Form Filling — When you share a Web page with a customer through Page
Push or Auto Sync, you can help your customer fill out forms, such as registration forms,
shopping cart pages, and checkout pages.

Note:

You can use the three Shared Browsing features when multiple agents are
in the session. The first agent in the chat session is in charge of the Auto
Sync session. All agents can push pages and collaborate on form filling.
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Technical Issues with Shared Browsing

You need to be aware of the technical issues in this section so that you can explain them to
your customers when necessary.

Customers Using Netscape 6.0 and Netscape 6.2.1

Chat customers who are using Netscape 6.0 through Netscape 6.2.1 cannot share
browsers with you. When you try to use Auto Sync or Page Push with a customer who is
using those particular versions of Netscape, the customer receives a message prompting
them to install a later version.

Privacy Protection for the Customer

A customer can follow your browser when you Auto Sync but the customer cannot lead.
Therefore, the customer can visit any other page or Web site, knowing that you are not
watching them as they navigate.

Shared Browsing on External Web Sites

Usually when you share browsers with a customer, you and your customer are browsing
your company’s Web site or a Web site that your company supports. But your customer
may want to show you a product on an external Web site (also called an off-domain Web
site). Or you may want to show your customer a product on an external Web site to
indicate that your company’s similar product is better or less expensive.

However, using Shared Browsing with an external Web site can sometimes cause
problems. A page may not be displayed properly on your browser or your customer’s
browser. Or the page you see may not exactly match the page that your customer sees.
You may want to ask your supervisor or administrator if there is anything you should know
about using Shared Browsing on external Web sites.

Using Auto Sync

With Auto Sync, you and your chat customer can navigate the Web together, that is, you
can see the same Web pages at the same time. You are always in the lead.

When you click Auto Sync, any action that you perform in your browser is reflected in the
customer’s browser. For example, if you enter information in a form, your customer sees
that information. If you follow a link, the customer’s browser follows the same link.

If a customer wants to send you a page, such as information they entered on a form, they
must click a Send Page button.
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You can click a button to stop or start the Auto Sync feature at any time.

To use Auto Sync to share browsers with your customer:

1.

While in a chat session, tell your customer that you are going to lead them as you
navigate through some Web pages. Explain that they will see the same pages in their
browser that you see in yours.

. Click the Internet Explorer button in the Windows Task Bar to open the Shared

Browsing browser for this customer.

Tip:
If you are handling two or more chat contacts simultaneously, there is an
Internet Explorer icon for each customer.

3. Go to a Web page that you want your customer to see.
4. Click the Auto Sync button.

The Web page in your browser is pushed to the customer. The Auto Sync button
changes to show arrows indicating that Auto Sync is turned on. The Transcript area
also states that Auto Sync was turned on.

. Ask your customer if they can see the Web page that you just sent. Chat with your

customer about the page, as appropriate.

. If your customer wants to lead you to a different page, tell them to go to that page and

click the Send Page button in their chat client. They can also paste the URL into the
chat client and click Send Page.

You see the page your customer sends you on your browser. You can also see the
URL the customer typed in the Transcript area of the Web Agent.

. Continue to share Web pages with your customer, until you satisfy their request and

answer all their questions.

Tip:
In the Transcript area, you can see the URLs of all the pages you and your
customer shared.

. Click the Auto Sync button again when you want to end the Auto Sync session.

The button changes to indicate that it is turned off. The Transcript states that Auto
Sync was turned off. You can easily start another session with this customer whenever
you want by clicking the Auto Sync button again.

Tip:
If you begin a chat session with another customer before you complete the
chat session you are currently handling, another browser will open for the
second customer.
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Pushing a Web Page

At any time during a chat session, you can "push" a Web page to your customer. Your
customer’s browser opens to that page almost immediately.

Use this feature when you want to show your customer some information or to help your
customer find a page they are looking for.
Tip:
Use Page Push when you want to show your customer a single page. If you
want to lead your customer to a series of pages, use Auto Sync instead.

Tip:
If you send the same URL repeatedly, it is easier to create a URL resource

and then send the resource any time you want. See Managing
Resources on page 171 for more information.

To push a Web page to your customer:
1. Type a complete URL in the Text Entry area. It must begin with http://, https://, or ftp://.
Example of an incomplete URL: www.avaya.com
Example of a complete URL: http://www.avaya.com
2. Click the Push URL button.

The Transcript area shows that you have pushed a URL to your customer. Your
customer sees a message in their chat client that a URL was sent to their browser. If
you entered the URL correctly and the URL is currently working, the customer’s
browser opens to the page you pushed.

3. Verify with your customer that the page is displayed in their browser.

Using Collaborative Form Filling

Any time you are sharing browsers with your customer, you can help the customer fill in
information on a Web page. This feature is called Collaborative Form Filling. A form can be
a Web page or any part of a Web page where customers enter information. For example,
your customer may need help entering information on the following types of forms:

e Registration form
e Shopping cart or order page
e Checkout page
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When you or your customer enter information in a form that you are sharing, you both see
that information immediately. Thus, you can take turns entering information. The customer
must submit the information when the form is complete.

To help your customer fill in a form:
1. Verify that your chat customer wants you to help fill out a form.
2. Ask if the customer is currently viewing the form.
3. If the customer is viewing the form, ask them to click the Send Page button.

The page is displayed on your browser. If the customer has entered any information,
you see that information.

4. If the customer is not viewing the form and you know where the form is located, take
the following steps:

a. Go to the URL with your browser. Click Auto Sync.
OR

b. Type the URL in the Text Entry area. Click Push URL.
The customer sees the page on their browser.

5. If the customer is not viewing the form and you do not know the URL, ask the customer
to go to the page that contains the form. Then tell them to click the Send Page button.

6. Take turns with your customer, as needed, to fill out the form.

Everything you type in the form is displayed immediately on the customer’s browser.
Everything your customer types is displayed on your browser as soon as the customer
clicks the Send Page button.

Tip:
Take turns with your customer. If you and your customer type
simultaneously, the information you enter is garbled. If this happens, ask
your customer to click the Send Page button again.

7. Ensure that your customer clicks the appropriate button to submit the form when the
form is finished.

Tip:
When your customer clicks the button, the page you are viewing may be

different from your customer’s page. In this case, ask your customer to click
the Send Page button again.
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Using Resources in a Chat Session

Resources are previously prepared text, emails, or URLs that you can send repeatedly to
different customers by chat or email. Resources save you the time and tedium of typing the
same things again and again. Text and email resources may contain such things as
greetings, closings, and answers to frequently asked questions. Email resources may have
information already entered in the To, Cc, Bec, and Subject fields, and they may contain
attachments. URL resources may be links to company Web sites, such as a page about
exchange policies.

When you are in a chat session with a customer, you can send text and URL resources.
Although you cannot send an entire email resource from a chat session, you can send the
text of the email resource.

When a chat session is active, you see the following folders in the Resource Area of the
Web Agent:

e Global Resources — Resources that your administrator or supervisor has prepared for
you and other agents. All agents in the group the resources were prepared for see these
resources when they log in.

e Agent Resources — Resources you create yourself for your own use. These resources
are saved with your account. Other agents cannot see the resources that you create.

e Migrated Resources — You see this folder after you import migrated resources. Your
administrator will inform you if you need to do this. If you do, see Importing Migrated
Resources on page 179.

For information and examples of the resource types (text, email, and URL), and
instructions on creating resources, see Creating New Agent Resources on page 173.

To send a text resource while in a chat session:

1. If you want to see all the resources within all folders, click the Expand all folders
button above the Resource Area. If you want to see only the main folders, click
Collapse all folders.

Tip:
To expand or collapse the contents of an individual folder, right-click the
folder and select Expand folder or Collapse folder.

2. If you want to limit the resources that you see, select the type of resource you want to
see from the Filter by drop-down menu.and select one of the following menu options:

e [Blank — Displays all types of resources for all tenants and all languages.]

e Tenant — Displays only the resources for a specified tenant, which may be any
group in an organization, such as a company, location, or workgroup.

e Language — Displays only the resources for a specified language.
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e Text resources — Displays only text resources.
e URL resources — Displays only URL resources.
e Email resources — Displays only Email resources.
3. If you only want to view the contents of a resource, do one of the following things:

e Select the resource and select the Preview content check box. A scroll box opens,
displaying the resource contents.

e Right-click the resource and select View resource from the pop-up menu.

4. If you want to send a text resource or the text of an email resource immediately, right-
click the resource and select Say.

Tip:
You can also double-click to send a resource immediately, if Avaya IC is
configured this way at your contact center. If double-clicking sends a
resource to the customer, be careful not to double-click before you are
ready.

The text is sent to the customer and is also displayed in the Transcript area, preceded
by your preferred name within brackets and a colon. For example, if your preferred
name is JackS and you send the message "Hello" to your customer, the Transcript
area displays this:

<JackS>: Hello.

5. If you want a URL resource to open in the customer’s browser, right-click on the
resource and select Push.

The Web page at that URL automatically opens in the customer’s browser. The URL is
displayed in the Transcript area of the Web Agent, preceded by your name.

Tip:
You can also type a URL directly in the Text Entry area and click Push URL
to have the customer’s browser open to a Web page.

6. If you want to modify a resource in the Text Entry area or add a message before
sending the resource to the customer, do the following things:

a. Right-click the resource and select Insert or Insert quoted.

Tip:
By default, Insert Quoted adds an angle bracket (>). This indicates to your
customer that this text is different from your messages. If you want, you can
change the character that is used. See Setting Preferences on page 180.

b. Modify the text and add any new text you want to send your customer in the Text
Entry area.

c. When the text in the Text Entry area is as you want it, click Say to send it to your
customer.
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Spell Checking Your Messages

Spelling errors can make your messages difficult to read and can sometimes lead
customers to misunderstand what you type. Because you want to type fast, it is difficult not
to make many spelling errors in a chat session. Therefore, it is a good idea to use the Spell
Checker.

A preference displays the Spell Checker whenever you click the Say button. This allows
you to check each message before it is sent to the customer. Although it takes time to
check every message, it is recommended that you turn on this chat preference and see
how it works for you. See Setting Preferences on page 180.

If you prefer, you can check only those messages that you want to check, as described
here.

To check the spelling of a chat message before you send it:
1. Put your cursor in the Text Entry area where you typed a message you want to check.
2. Select Contact > Spell Check.
The Spell Checker is displayed.

Tip:
The Spell Checker has many features, which are all labeled. To see what
happens when you click a button on the right side of the dialog box, hold
your cursor over the button. A tooltip describes what the button does.

3. If you wrote the message in any language other than your primary language, select
that language from the Available languages drop-down menu.

This action changes to the dictionary of that language.

4. If a word is displayed in the Not in dictionary box, look at the word to determine if you
think it is spelled correctly. Look at the list of words in the Suggestions box to
determine if any of those words is the correct spelling of the word. If so, select the word
and click the Change button.

Tip:
If a word is displayed in this box, it is not included in the currently selected
dictionary. However, it may be spelled correctly. For example, names of
people and products are not in the dictionary. If you think that you may use a
name again, click Add to add the name to your user dictionary.
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5. You can decide at any time that you do not want the Spell Checker to check certain
types of words. Click the Options button to bring up a dialog box like that shown in the
following illustration where you can select items for the Spell Checker to ignore.

Spelling preferences E3 |

[ | lgnaore all-caps wards (e.g., ASAF)

[ | lgnare capitalized words (e.g., Canada)

[ | lgnare wards with numbers (e.g., ¥2K)

v |gnare wards with mixed case (e.g., SuperBase)
[+ lgnore domain names (e.d., wintertreesofteare corm)

[+ Report doubled words (e.g., the the)

W Suggest split words

e Cancel

6. When you are finished checking this message, click Cancel.

Using the Phone in a Chat Session

While connected to a customer in a chat session, you can also speak to the customer,
using what is called Voice Chat. You can use two types of Voice Chat:

e Chat & Phone (also known as Callback) — You and your chat customer speak to each
other over your telephones or headsets. The customer can request this type of call from
the Web site or you can initiate it from the Web Agent.

e Chat & VoIP — You speak to your chat customer over your telephone or headset. Your
customer speaks to you over the Internet, using their computer’s microphone and
speakers. If customer requests a Chat & VolP from the Web site, you must initiate your
own VolIP session using the Chat & VolIP button in Web Agent.

The two types of Voice Chat may appear almost the same to you. In both types, you speak
to your chat customer over your telephone. However, the VoIP call is different for
customers because they speak to you over their computer’s microphone and speakers,
rather than a telephone. Customers using a dial-up connection to the Internet may prefer
this type of call because it makes it possible for them to continue browsing the Web site as
they speak to you.
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In both types of Voice Chat, you speak to your chat customer in real-time, just as with an
ordinary telephone call. Voice Chat can make your interaction with the chat customer
faster and more satisfying for both of you than chat alone, in the following ways:

e Voice Chat is easier for customers who do not type well.

e Voice Chat is usually faster for both you and your customer because people can speak
faster than they can type.

e Voice Chat makes it possible for you and your customer to hear each other’s tone of
voice.

e Voice Chat can combine other chat features with voice. For example, you can speak
about the Web pages as you browse them together with Auto Sync.

See the following sections for information:

e Handling a Chat & Phone Session on page 147

e Handling a Chat & VoIP Session on page 151

e Involving Other Agents in a Voice Chat on page 157

Handling a Chat & Phone Session

You and your chat customer can speak to each other over the telephone while you remain
in the chat session together. You can receive a chat contact with a request for this type of
session or you can suggest it to a chat customer. Read the appropriate procedure,
depending on whether your customer requested a Chat & Phone session or you want to
suggest one to your customer.

e Responding to a Chat & Phone Request on page 147

e Initiating a Chat & Phone Request on page 149

You use the Softphone interface in the Avaya Agent to control the telephone call portion of
a Chat & Phone session. For information on handling a call with Softphone, see Handling a
Basic Voice Contact on page 88.

Responding to a Chat & Phone Request

When a customer requests a Chat & Phone call from the Web site, the request becomes a
chat contact. If the contact is assigned to you, it is displayed in your Chat task list with a
special icon to indicate that it is a Chat & Phone request. After you begin the chat session,
you must connect the telephone call, as described in the following procedure.
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To respond to a Chat & Phone request:
1. Double-click the Chat & Phone contact in the Chat task list.

The Web Agent opens with this contact currently active. The Chat & Phone toolbar is
displayed, as described in Voice Chat Toolbars on page 38.

If the customer is registered or if the customer entered their telephone number from
the Web site, you see their telephone number in the Customer phone number field.

Tip:
You may want to verify with your customer that this is the correct telephone
number, and then make any necessary changes in the text box.

2. Type a message to the customer in the Text Entry area and click Say to send the
message.

For example, you may say, "Hello, Maria. | see that you want me to call you on the
phone. I will call you now at the number you entered."

3. If you do not see a telephone number in the Customer phone number field:

e For a customer with the Customer Chat Applet, click the Request Phone
Information button.

This action causes a dialog box to be displayed in your customer’s chat client
asking them to enter their telephone number. After the customer enters the number
and clicks the Enter button, you see the number in the Customer phone number
field.

e For a customer with the Customer HTML Chat Client, ask the customer to send the
phone number in a text message, and then type or copy the phone number into the
Customer phone number field.

4. If necessary, put on your headphones.
5. Click the Add phone request to chat button beside the customer’s telephone number.

You hear noises as the system dials the telephone number. Then you hear the
customer’s telephone ring. If you need to cancel the call before it is completed, click
the Hangup button in the Softphone.

6. When your customer answers the telephone, say "Hello" and introduce yourself as the
agent who is in a chat session with them. Begin helping your customer.

Tip:
Because you are still in a chat session with the customer, you may also be
able to do the following things while you are on this telephone call:

e Use Auto Sync, Page Push, or Collaborative Form Filling. However, you
cannot use these Shared Browsing features if your customer is using this
telephone line to connect to the Internet. See Sharing Browsers with a
Customer on page 138.
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e Send text and URL resources to your customer. See Using Resources in a
Chat Session on page 143.

7. When you are certain that the customer is satisfied, say good-bye and hang up the
telephone.

8. Click the Wrap button in the Web Agent to wrap up the chat contact.

The chat contact enters WrapUp state. For information on wrapping up contacts, see
Wrapping Up Contacts on page 76.

The voice contact continues until you click the Hangup button in the Softphone.
9. Finish speaking to the customer on the telephone. Then click the Hangup button.

10. Click Wrap to wrap up the voice contact.

Initiating a Chat & Phone Request

Any time you are chatting with a customer, you can suggest that you call them. You will
remain connected with the customer in the chat session while you speak on the telephone.

Note:
Chat & Phone is sometimes called "callback."

To add Chat & Phone to a chat session:

1. Ask your current chat customer if they would like you to call them. Explain why you
think that this is a good idea.

For example, you may type, "l think it will be easier for you to explain how | can help
you over the telephone. Would you like me to call you?"

2. If necessary, put on your headphones.
Tip:
You may want to make yourself unavailable for voice contacts in the Avaya

Agent. Then you will not receive another call while you set up this Chat &
Phone session.

3. Click the Chat & Phone button in the Web Agent.

The Chat & Phone toolbar is displayed, as described in Voice Chat Toolbars on
page 38.

4. If you do not see a telephone number in the Customer phone number field:

e For a customer with the Customer Chat Applet, click the Request Phone
Information button.

This action causes a dialog box to be displayed in your customer’s chat client
asking them to enter their telephone number. After the customer enters the number
and clicks the Enter button, you see the number in the Customer phone number
field.
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5.

e For a customer with the Customer HTML Chat Client, ask the customer to send the
phone number in a text message, and then type or copy the phone number into the
Customer phone number field.

Tip:
If the customer is registered or the customer entered their telephone number
from the Web site, their telephone number is pre-entered. You may want to
verify with your customer that this is the correct telephone number. If
necessary, you can change the number in the text box or enter a new one.

When you know the telephone number in the Customer phone number field is
correct, click the Add phone request to chat button.

You hear noises as the system dials the telephone number. Then you hear the
customer’s telephone ring. If you need to cancel the call before it is completed, click
the Softphone Hangup button.

. When you hear the customer answer the telephone, say "Hello" and introduce yourself

as the agent helping them in the chat session.

. Help your customer with their question or problem.

Tip:
Because you are still in a chat session with the customer, you can also do
the following things while you are on this telephone call:

e Use Auto Sync, Page Push, or Collaborative Form Filling. However, you can
only use these Shared Browsing features if your customer does not use this
telephone line to connect to the Internet. See Sharing Browsers with a
Customer on page 138.

e Send text and URL resources to your customer. See Using Resources in a
Chat Session on page 143.

8. Ensure that the customer is satisfied.

9. Click the Wrap button in the Web Agent to wrap up the chat contact.

10.

11.

For information, see Wrapping Up a Chat Contact on page 170.

The voice contact continues until you click the Hangup button in the Softphone.

Finish speaking to the customer on the telephone. Say good-bye when you are ready
to hang up. Then click the Hangup button.

If you see the Wrap-up dialog box or a Prompter script, wrap up the voice contact.

For information, see Wrapping Up Contacts on page 76.
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Handling a Chat & VoIP Session

Many customers who are browsing your company’s Web site cannot use their telephone
while they are connected to the Internet. If they have a question, they can click a Chat &
VolIP button so they can continue browsing the Web site as they speak to an agent. If you
are enabled to receive this type of contact, this request may be routed to you and appear in
your Chat task list. You must initiate the Chat & VolIP feature from the Web Agent.

Note:

Customers must meet certain requirements to be able to engage in a voice
chat session with you. When a customer requests a VolIP call, the Avaya IC
software sends a dialog box to the customer. The customer can click the
Run Test button to determine if their computer meets all the requirements. If
the customer’s computer is unable use VolP, the customer receives an error
message that explains the problem, and Avaya IC offers to submit a regular
text chat request for that customer.

After you connect to your chat customer through VolP, you will speak to the customer over
your telephone.

To respond to a VoIP request:
1. Click the Chat & VolIP contact in your Chat task list.
The Web Agent opens in the VolP mode. You will see the Chat & VolIP toolbar.

2. Type a message to the customer in the Text Entry area and click Say to send the
message.

For example, you may say, "Hello, Maria. This is John at XYZ Tech Support. | see that
you want me to call you with VoIP. Are you familiar with VolP calls?"

3. If the customer is not familiar with this type of call, ask them to ensure that the following
statements are true:

e They are using the Windows operating system.

e They are using one of the following Internet browsers:
- Internet Explorer 5.x or 6.x
- Netscape 7

e Speakers, microphone, and sound card on their computer exist. The speakers are
turned on and the microphone is plugged in to the computer.

e Their audio device is not already in use, such as playing music.
4. If necessary, put on your headphones.

5. Look at the Voice channel button in the Avaya Agent. If the button has a yellow X, click
the button to make yourself available.
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6. Click the Initiate VolP request button. The customer’s chat client and your Web Agent
show the status as the connection is made.

7. When the status message informs you that the connection was made, say "Hello" and
ask if your customer can hear you.

Tip:
If the connection breaks during the session, you receive a message to help
the customer troubleshoot the problem.

8. Help your customer with their original question or problem.

Tip:
Because you are still in a chat session with the customer, you can use the
following features in this VolP call:

e Share browsers with the customer, using Auto Sync, Page Push, or
Collaborative Form Filling. See Sharing Browsers with a Customer on
page 138.

e Send text and URL resources to your customer. See Using Resources in a
Chat Session on page 143.

9. When the customer is satisfied, say good-bye and then click the Hangup button in
Softphone.

10. Click the Wrap button in the Web Agent to wrap up the Chat & VoIP contact.

The chat contact and the VolP contact are both wrapped up as a single contact. Your
customer’s chat client informs them that the session is finished.

Involving Other Agents in a Chat Contact

At certain times during a chat session, you may need help answering your customer’s
questions or you may need to transfer the chat contact to an agent in a different
workgroup. At these times, you can either consult with another agent while the customer is
on hold, or you can conference another agent into the chat so that both of you can talk to
the customer. If you conference in a second agent, you can also leave the chat contact and
let the second agent finish working with the customer while you go on to other tasks. (In
effect, this transfers the chat contact to the other agent.)

Note:

For information about adding agents to a Chat & Phone or Chat & VolP
session, see Involving Other Agents in a Voice Chat on page 157.

You can also add multiple agents to the chat by conferencing in each agent individually.
Each agent can stay in the chat session or leave it whenever they want by completing the
contact. The chat session remains active until the last agent completes the contact.
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Just as you can request that another agent become involved in your chat contact, so can
another agent or supervisor request that you become involved in their chat contact. When
this happens, you must wrap up the joint contact just as you would a contact that you
handled by yourself.

If you want to involve another agent with a particular skill, you can do one of the following:

e Use the Find option in the UAD to find a specific skilled agent. then conference that
agent into the chat contact, as described in Conferencing Another Agent into a Chat
Contact on page 153.

e Transfer the chat contact to another agent, as described in Transferring a Chat Contact
to Another Agent on page 154.

e Transfer the chat contact to a queue that includes all agents with the needed skill, as
described in Transferring a Chat Contact to a Queue on page 155.

e Conference the chat contact to a queue that includes all agents with the needed skill, as
described in Conferencing a Chat Contact to a Queue on page 156.

e Cancel the transfer or conference of a chat contact before it connects to another agent,
as described in Cancelling the Transfer or Conference of a Chat Contact on page 157.

Unlike a blind transfer, when you transfer or conference a chat contact to a queue, you are
not dropped from the chat contact immediately when you initiate the conference. You can
stay in the chat conference room until a second agent receives the contact from the queue.

Conferencing Another Agent into a Chat Contact

To conference another agent into a chat contact:
1. Tell your chat customer that you are going to find another agent who can help them.
2. Click the Conference current contact button in the Web Agent.
The UAD’s Select Destination for Conference/Transfer dialog box is displayed.

If the dialog box has an Agents tab, that tab is selected. If it has a workgroup tab, you
can use that tab for your search.

3. If the agent you are looking for may be in a different location or workgroup, click the
Site drop-down menu to make another selection. Or select All Sites to include all
locations and workgroups.

Tip:
If you are not certain about the login ID of the agent to whom you want to
transfer the chat session, right-click the agent’s name. Then click the
Properties pop-up menu. A dialog box with information about this agent is
displayed.
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4. Navigate through the folders as necessary until you find the agent you want for the
transfer. Click the name of the agent.

The name you selected is displayed in the To field.

5. If you want to send a comment to the agent, put your cursor in the Comment field and
type your message.

6. Click OK.
A dialog box will inform you if the agent is unavailable.

If available, the agent is connected to the session. The Transcript area announces that
this agent has arrived.

7. Chat with the customer and with the agent, reading their messages in the Transcript
area and replying in the usual way.

All messages you, the other agent, and the customer send are displayed in your
Transcript area. The customer and the other agent see all messages as well.

8. If you want to add another agent to the conference, repeat the above steps. You can
stay in the Conference session with both agents and the customer as long as you
want.

9. Whenever you decide to leave the session, inform the others that you will leave and
say good-bye. Then you can drop out of the session by wrapping up the contact as
usual. If you need instructions, see Wrapping Up a Chat Contact on page 170.

You are dropped from the chat session. The agent to whom the contact was
transferred continues to chat with the customer.

Note:

Each agent can drop out of the chat session whenever they want. The chat
session continues until the last agent in the session wraps it up.

Transferring a Chat Contact to Another Agent

When you transfer a chat contact to another agent:
1. The receiving agent joins the chat conference room.

2. You are automatically dropped from the chat conference room.

To transfer a chat contact to another agent:
1. Tell your chat customer that you are going to find another agent who can help them.
2. Click the Transfer current contact button in the Web Agent.

The Select Destination for Conference/Transfer dialog box of the Unified Agent
Directory is displayed.
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3. In the Select Destination for Conference/Transfer dialog box, select the Agent tab.
4. If the agent you need is in a different location:

e Select the desired site from the Site drop-down menu.

e Select All Sites from the Site drop-down menu to view agents in all locations.

5. Navigate through the list of queues until you find the agent you want for the transfer,
then select the name of the agent.

Avaya Agent displays the agent you selected in the To field.

Tip:
If you are not certain about the login ID of the agent to whom you want to
transfer the chat session, right-click the agent’s name. Then click the
Properties pop-up menu. A dialog box with information about this agent is
displayed.

6. To send a comment to the agent who receives the chat contact, type your message in
the Comment field.

7. Select OK.

8. Continue to chat with the customer until the agent is available and the chat is
transferred to that agent.

9. As soon as the second agent joins the chat conference room, Avaya IC drops you from
the conference room.

10. When you leave the chat conference room, you enter the WrapUp state. Wrap up the
chat session as described in Wrapping Up a Chat Contact on page 170.

Transferring a Chat Contact to a Queue

When you transfer a chat contact to a queue:
1. The receiving agent joins the chat conference room.

2. You are automatically dropped from the chat conference room.

To transfer a chat contact to a queue:
1. Tell your chat customer that you are going to find another agent who can help them.
2. Click the Transfer current contact button in the Web Agent.

The Select Destination for Conference/Transfer dialog box of the Unified Agent
Directory is displayed.

3. In the Select Destination for Conference/Transfer dialog box, select the Queues
tab.
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4. If the queue you need is in a different location:
e Select the desired site from the Site drop-down menu.
e Select All Sites from the Site drop-down menu to view queues in all locations.

5. Navigate through the list of queues until you find the queue that includes agents with
the needed skills, then select the name of the queue.

Avaya Agent displays the queue you selected in the To field.

6. To send a comment to the agent who receives the chat contact from the queue, type
your message in the Comment field.

7. Select OK.

8. Continue to chat with the customer until an agent is available and the chat is
transferred from the queue to that agent.

9. As soon as the second agent joins the chat conference room, Avaya IC drops you from
the conference room.

10. When you leave the chat conference room, you enter the WrapUp state. Wrap up the
chat session as described in Wrapping Up a Chat Contact on page 170.

Conferencing a Chat Contact to a Queue

When you conference a chat contact to a queue:
1. The receiving agent joins the chat conference room.

2. You can talk to the receiving agent before you leave the chat conference room.

To conference a chat contact to a queue:
1. Tell your chat customer that you are going to find another agent who can help them.
2. Click the Conference current contact button in the Web Agent.

The Select Destination for Conference/Transfer dialog box of the Unified Agent
Directory is displayed.

3. In the Select Destination for Conference/Transfer dialog box, select the Queues
tab.

4. If the queue you need is in a different location:
e Select the desired site from the Site drop-down menu.
e Select All Sites from the Site drop-down menu to view queues in all locations.

5. Navigate through the list of queues until you find the queue that includes agents with
the needed skills, then select the name of the queue.

Avaya Agent displays the queue you selected in the To field.
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6. To send a comment to the agent who receives the chat contact from the queue, type
your message in the Comment field.

7. Select OK.

8. Continue to chat with the customer until an agent is available and the chat is moved
from the queue to that agent.

9. When the second agent joins the chat conference room, you can either:
e Stay in the chat conference room and continue to participate in the chat session
e Leave the conference room

Note:

You cannot send private messages to the second agent in the conference
room.

10. When you leave the chat conference room, or when the customer leaves the chat
conference room, you enter the WrapUp state. Wrap up the chat session as described
in Wrapping Up a Chat Contact on page 170.

Cancelling the Transfer or Conference of a Chat Contact

You can cancel a transfer or a conference of a chat contact at any point until the other
agent accepts the chat contact.

To cancel the transfer or conference of a chat contact:
1. Click the Cancel Transfer/Conference request button in the Web Agent.

2. Click OK in the message box.

3. Advise customer that you have cancelled the transfer or conference request.

Involving Other Agents in a Voice Chat

When you are in a Voice Chat session with a customer (either Chat & Phone or Chat &
VolIP), you may want to add one or more agents into the Voice Chat, or you might want to
transfer the Voice Chat to another agent.

Note:

A Voice Chat has two media channels, Chat and Voice. If you want to
involve another agent in the contact, that agent must be available to take
both the chat session and the voice call.
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When you involve other agents in a Voice Chat, there are some differences from working
with a text chat session. For example, the dialog box that is displayed when you click the
Conference button is called In the Select Destination for Conference dialog box, be
sure to enter the agent’s name in the To field before you click the OK button. Otherwise, a
message says Destination Busy and you cannot transfer the contact.

You can use the Softphone buttons to:
e Conference — Includes another agent in the contact with yourself and the customer.

e Consult — Lets you talk to the other agent while the customer is on hold before you
transfer the contact to that agent.

Note:

You cannot use the Transfer Softphone button for a Voice Chat. If you want
to send a Voice Chat to another agent, you must use the Consult feature so
that you can be sure the other agent is available for both the chat and voice
portions of the contact.

For more information about the Softphone buttons, see Using the Phone Task List and
Softphone on page 82.

To add another agent to a Voice Chat:

1. While in a Chat & Phone or Chat & VoIP session with a customer, click the Softphone
Conference button.

The UAD’s Select Destination for Conference dialog box is displayed.

2. Select the agent that you want to conference in to the voice chat. (For details, see
Involving Other Agents in a Chat Contact on page 152.)

Once you have selected an agent, the system tries to connect the voice portion of the
voice chat with the agent you selected, and displays the status of the connection in the
Conferencing Call/Chat dialog box, as shown below.

Conferencing Call/Chat with icagentZ...
Ringing...

Switch To Caller | Send Chat | Cancel |

When the other agent has been contacted and the voice call has been connected, the
Conferencing Call/Chat dialog box shows the status In Call and enables the Send
Chat button. At this point, you and the agent you just added can talk with each other
over the phone, but the other agent has not yet been added to the chat and cannot
speak to the customer over the phone.

158 Avaya Agent User Guide



Involving Other Agents in a Voice Chat

Tip:
If you want to tell the customer that the conference is almost complete, you
can click the Switch to Caller button. The status changes to Connected
with Caller, and you can now speak to the customer over the phone. If you
want to go back to the other agent, click the Switch to Destination button.

3. Click the Send Chat button to send the chat to the other agent. When the other agent
has been conferenced into the chat, the status changes to Chat Conferenced, as
shown below.

Conferencing Call/Chat with icagentZ...
Chat Conferenced.

Switch To Caller | Complete | [Cancel |

At this point, you, the customer, and the agent you just added can all view and
participate in the chat, and you can speak to the other agent, or the customer, over the
phone. The other agent, however, cannot yet speak to the customer over the phone.

4. To conference everyone in to the voice call as well as the chat, click the Complete
button. At this point, anything you say on the phone will be heard by both the other
agent and the customer.

To consult with another agent before transferring the Voice Chat:

1. While in a Chat & Phone or Chat & VoIP session with a customer, click the Softphone
Consult button.

The UAD’s Select Destination for Consult dialog box is displayed.
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2. Select the agent to whom you want to transfer the voice chat. (For details, see
Involving Other Agents in a Chat Contact on page 152.)

Once you have selected an agent, the system tries to connect the voice portion of the
voice chat with the agent you selected, and displays the status of the connection in the
Consulting Call dialog box.

When the other agent has been contacted and the voice call has been connected, the
Consulting Call dialog box shows the status In Call and enables the Send Chat button,
as shown below.

Consulting Call/Chat with icagent?Z...
In Call.

Switch To Caller | Send Chat | Cancel |

At this point, you and the agent you just added can talk with each other over the phone,
but the other agent cannot enter the chat with the customer or speak to them over the
phone.

Tip:
If you want to tell the customer that the consultation is almost complete, you
can click the Switch to Caller button. The status changes to Connected
with Caller, and you can now speak to the customer over the phone. If you
want to go back to the other agent, click the Switch to Destination button.

3. Click the Send Chat button to send the chat to the other agent. When the other agent
can see the chat log, the status changes to Chat Conferenced, as shown below.

Consulting Call/Chat with icagent?Z...
Chat Conferenced.

Switch To Caller | Complete | [Cancel |

At this point, you, the customer, and the agent you just added can all view and
participate in the chat, and you can talk to either the agent or the customer on the
phone.

4. To transfer the contact to the other agent, click the Complete button. Avaya Agent
takes you out of the chat and transfers the customer’s voice call to the other agent’s
phone line. At this point, you can wrap up the contact as you normally would while the
new agent handles the customer’s issues.
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Handling a JoinUs Conference

You may occasionally have a customer who would like to invite one or more others to join
the chat session. This type of session is called a JoinUs Conference.

To create the JoinUs Conference, you first create a JoinUs handle (user name). You send
this handle with a special URL, given in step 6 of the following procedure, to anyone who is
going to enter the JoinUs session. These people go to the URL and enter the handle. You
can then all share browsers and type messages to each other about what you see.

For example, say that you have a customer who is thinking about buying an item on the
company Web site but wants the advice of his wife before making a decision. You suggest
that his wife join the session and he agrees. You follow the instructions below to create the
handle and to convey the URL and instructions to your customer’s wife. She then goes to
that location and enters her handle. The chat client opens on her desktop. Now the three of
you can exchange chat messages in a three-way session.

The following instructions explain how to have a person of your customer’s choice join a
conference. In the instructions, the person is called a "friend," but of course it may be a
spouse or an acquaintance. If your customer wants more than one person to join, repeat
the instructions as needed.

Before you begin, ask your administrator for the URL of JoinUs conferences.

To handle a JoinUs conference:

1. Chat with your customer about having someone they know join the chat session. Note
that these instructions refer to this person as your customer’s "friend."

2. Explain to your customer that their friend must go to a specific Web address (URL) and
enter a specific user name, which is called a "handle". Explain that you must give their
friend the URL and handle they need to join the chat. Ask which of the following
methods the customer prefers:

e You send the information to your customer and the customer passes it on to their
friend.

e You send the information to your customer’s friend through the friend’s email
account.

e You call your customer’s friend on the telephone and give them the information.

3. Ask your customer to send the friend’s email address or telephone number, as
appropriate.

4. Click the JoinUs button in the Web Agent window.
The JoinUs dialog box is displayed.

5. Enter a handle for the customer’s friend.
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Tip:
Write down the handle and the friend’s name in case you forget them later.

6. Whether by email or telephone, tell the friend the URL and the handle for the JoinUs
Conference, as follows:

a. Unless your administrator has changed it, the URL is website\public\joinus.jsp.

b. Tell the friend to enter the handle in the appropriate field when their browser has
finished loading the JoinUs Web site.

Note:
If the JoinUs Web site asks for a password, the friend should leave that field
blank.
c. After they enter their handle, they should click the Submit button.

When the friend does this, the JoinUs program is downloaded to their browser. You,
your primary customer, and your customer’s friend are in the same chat room. You
can each see what the other two people type.

7. Manage the JoinUs conference as appropriate. Use Auto Sync or push URLs to your
customer and their friend. Watch your browser as they send pages to you and each
other.

Tip:
You may want to tell your customer and friend how to lead the others to a

Web page. They can go to the page or paste the URL in the URL box of their
chat client, and then click the Send Page button.

Note:

If your customer or their friend closes their browser or clicks the End Chat
button, the session continues between you and the other person.

8. When your customer and their friend indicate that they are finished, tell them that you
will close the session. Say good-bye.

9. Wrap up the JoinUs session.
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Handling Simultaneous Chat Sessions

You can handle more than one chat session at the same time. For example, you may chat
with a new chat customer while your other chat customers are reading material you sent
them or trying your suggestions.

Tip:
If you plan to handle multiple sessions, it is a good idea to set the "Away
from Desk" message. The "Away from Desk" message is sent to the
customer whenever you do not respond within a period of time you specify.
This is a preference and is described in Setting Preferences on page 180.

To handle simultaneous sessions with multiple customers:

1.

Ensure that you are available for the number of simultaneous sessions you want to
handle. For information, see Changing Your Agent State on page 51 and Setting Your
Channel Loads on page 55.

. While handling a chat session, double-click the name of another customer from the

Chat task list. Usually you should select the next contact from the top.

The Web Agent changes to display your chat session with the new customer. An icon
for a new Internet Explorer browser is added to the Windows Task Bar, beside the icon
for your previous chat customer.

3. Type and send a message to the new customer.

. Whenever you have a chance to return to the original customer, click that customer’s

contact in the Chat task list.

The Web Agent changes to display information about this contact, including the
transcript of your previous conversation.

. If your current chat contact load allows you to handle more chat customers and you

want to add another, repeat Steps 2-4. Your contact load for chat is the maximum
number of chat contacts you can handle simultaneously. This number, which can
change during your login session, is displayed in the chat icon at the bottom right of the
Web Agent.

Tip:
If one of your chat customers needs more attention, you can click the
Transfer button and transfer that contact to another agent.

6. Return to interact with your other customer by clicking the name in the Chat task list.
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Tip:
You can double-click any currently active contact in the Chat task list to have
the Web Agent window display that chat session.If you are handling multiple
contacts simultaneously, the logo in the Web Agent window may change
when you select a different contact from the Chat task list. This can help you
distinguish between different customers quickly.

Tip:
You can use the Shared Browsing features with each chat contact. Use the

Internet Explorer icons in the Windows Task Bar to switch between the
browsers.

7. When you are finished with any of the chat customers, select the name from the Chat
task list. Wrap up and close this session as usual. See Sharing Browsers with a
Customer on page 138.

The other chat sessions remain active until you wrap up and close them.

Monitoring a Chat Session (Supervisors Only)

If you are a supervisor, one of the most important ways that you can ensure quality is to
monitor your agents’ chat sessions. You can enter a chat session and "view" the interaction
between the agent and the customer in real time. You can also have other supervisors join
you in observing an agent.

Note:

Before you can monitor an agent, you must be designated as the supervisor
of at least one of the agent’s workgroups. For details about setting up
workgroups, see IC Administration Volume 2: Agents, Customers, &
Queues.

When you first enter the chat session, neither the agent nor the customer can see you. You
can become visible by selecting the Make Visible option and "speaking." When you are
visible, both the agent and the customer can also see you if you leave.

If you want to monitor a session without anyone knowing you are there, you can leave
yourself Invisible. This makes it possible for you to observe natural interactions for training
purposes. It also helps ensure that your agents perform well because they know that you
may monitor them at any time.
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To monitor a chat session:

1. To give your full attention to monitoring a chat session, you can set your availability for
voice, chat, and email to 0 in Avaya Agent.

Tip:

If you prefer to monitor while you handle a chat session of your own or reply
to an email, you can do this. Use the Chat Management and Email
Management buttons in the main toolbar to switch between contacts, as
desired.

2. Click the Supervisor Mode button in the main toolbar of the Web Agent.

If you have not participated in or monitored a chat session since you last logged in, the
File Download dialog box is displayed. It asks you to choose what to do with the
aimagentcl.hta file. This dialog box appears the first time you begin to handle a chat
contact or monitor a chat session during your login session. It does not appear again
until the next time you log in and begin to interact with a chat customer or monitor an
interaction.

A\ cauTiON:

The aimagentcl.hta file is necessary for Shared Browsing. The file causes a
separate Internet browser to open for each session that you participate in or
monitor. If you do not plan to use Shared Browsing in sessions that you
monitor, you may want to select the "Start collaboration automatically when
monitoring a chat session" preference. When this preference is selected, a
browser and an icon do not appear for each session. See Setting

Preferences on page 180 for more information.
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3. If the File Download dialog box is displayed, click Open this file from its current
location. Then click Open.

An Internet Explorer icon is added to your Windows Task Bar. This is the browser you
will use if you monitor a chat session in which the agent and customer share browsers.

A Monitoring panel is added to the Web Agent above the Resource area. It displays a
tree showing your workgroup, the agents who are in chat sessions currently, and the
customers with whom they are chatting, as shown in the following illustration.
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1. Workgroup
2. Agent
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* 5 4. Current chat sessions
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S Filter by . Monitoring panel.

Tip:
To expand the window and see more of this tree, hold your cursor over the
bottom edge of the Monitoring panel. When you see a small, double-headed
arrow, drag the edge of the panel down, as far as you want. You can drag
the edge back in similar manner.

4. Click the magnifying glass icon next to the agent whose chats you want to monitor to
see what chats that agent is currently engaged in. Click on any customer name under
that agent to monitor that chat.

A transcript of the current session is displayed in the Transcript area of the chat
window.

Note:

By default, when you begin monitoring, you are invisible to the agent and to
the customer you are monitoring. You cannot type in the Text Area unless
you make yourself visible.
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5. If you want to become visible, right-click the name of the customer. Then select Make
Visible.

In the Transcript area, the system announces your presence. A line says Supervisor
is available on the call.

Tip:
If you make yourself visible, remember to make yourself invisible again
before monitoring another session.

6. If you want to become invisible again, right-click the name of the customer. Then select
Make Invisible.

The system announces that you are not available. However, you can continue
monitoring the session without typing messages.

Note:
If you click another chat session, the system announces that you left the first
session. You can only monitor one session at a time.

7. To end your monitoring session without switching to another session, click the
Supervisor Mode button or click an icon at the root level in the Monitoring panel.

Starting a Lotus Sametime Session

Lotus Sametime™ is a real-time collaboration program that is integrated into Avaya IC. If
your administrator indicates that you are to use Sametime, you can start a Sametime
session with your current chat customers. With Sametime, you can share applications, use
a white board, and share audio and video with the customer.

If you want to use Sametime with multiple customers, start a JoinUs session as explained
in Handling a JoinUs Conference on page 161. Then begin the Sametime session.
Sametime may not work if a JoinUs customer enters a Sametime session that has already
begun.

Note the following points:
e Sametime must be installed and configured on your desktop.
e You need a login ID and password, assigned to you by your administrator.

e You must be in a chat session with the customer or customers that will join you in a a
Sametime session.

e You must log in to Sametime to begin the session. After you log in, your customers can
join you in the session.

e Other agents may not be able to join the Sametime session.

For more information about Sametime, see the Sametime user guide.
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To begin a Lotus Sametime session:

1. Ensure that the person you are chatting with has Lotus Sametime installed and wants
to join you in a Sametime session.

2. Click the Sametime button.
A browser opens with a drop-down menu of services.
3. Select the type of service you want.
4. Enter your Sametime login ID and password.
Your customer’s browser and your browser connect in a Sametime session.
5. See the Sametime help system for information on handling the session.

6. You can end the Sametime session at any time. Simply close the browser that you
were using for the Sametime session.

Viewing Customer DataWake Records

A DataWake™ record is a list of URLs (Web pages) that customers have recently
navigated. Your administrators set up the Web pages that can be listed in DataWake
records.

Some URLs that the customer has visited may not appear in the customer’s DataWake.
Your administrators determine which URLs can be included in DataWake records.

To view a customer’s DataWake record:
1. Display a contact in the Web Agent.
Note:
When you are not handling a chat contact, the DataWake option is disabled.
2. Select Tools > DataWake.

Your Internet browser opens to the customer’s DataWake Summary page. The
DataWake record may the following columns:

e Time — The time of day when the customer accessed the page.

e Priority — The significance of a particular URL accessed by the customer, as
defined by your administrator in IC Manager.
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e Type — Pages are classified as either escalation pages or browse pages. Escalation
pages are pages from which a customer can send an email or request a chat
session. Browse pages are all other pages in the DataWake database.

e Description — The URL of the page. You may be able to click the URL to access the
page in your browser.

Using Multiple Languages in Chat Sessions

Your customer may want to chat with you in a language that is not your primary language.
If you are assigned a chat contact in another language and the language is not displayed
properly, check with your administrator.

You can spell check your chat messages in a secondary language before you send them.
When you open the Spell Checker (select Contact > Spell Check), select the appropriate
language from the Language drop-down menu.

In the following illustration, an agent is chatting with a customer in Chinese:
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Tip:
If you use another language, you may want to create some Agent
Resources in that language. See Managing Resources on page 171.
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Wrapping Up a Chat Contact

When you finish interacting with a customer in a chat session, you wrap up the session.
When you click the Wrap button, you enter the WrapUp state. While in WrapUp state, you
cannot receive another chat contact to replace this one. You may be required to enter
information about the chat session while in this state.

Note:

In certain cases, you may not see a Wrap-up dialog for any of the following
reasons:

e The chat contact was removed because you did not respond in the allotted
amount of time.

e Your supervisor removed the chat contact to put it back in a queue.

e The chat contact was cancelled in the server.

To wrap up a chat contact:

1. Ensure that you have addressed all your customer’s questions or problems and that
the customer understands that the session is about to end. Say thank you and good-
bye.

2. Click the Wrap button in the chat toolbar.
3. If you see a dialog box asking you to confirm your action, click Yes.

A Wrap-up dialog box may be displayed for you to fill in information about this contact.
Or you may see a Prompter script displayed in the Avaya Agent.

Tip:
You can set a preference to control whether this dialog box is displayed
when you wrap up a chat contact. See Setting Preferences on page 180.

4. If you see a dialog box or a Prompter script, answer all the questions appropriately. For
information about the dialog box or the script, see Wrapping Up Contacts on page 76.

When you have completed all the wrap-up tasks, the chat contact is removed from
your Chat task list.
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This chapter explains how to perform tasks related to email or chat that you generally
perform when you are not actively handling an email or chat contact.

The chapter includes the following topics:

e Managing Resources

e Importing Migrated Resources

e Setting Preferences

Managing Resources

Resources are previously prepared text, emails, and URLs (Internet addresses) that you
can send to customers whenever the information is needed. This saves you the time and
the tedium that it would take to type the same information repeatedly. For example, text
resources may consist of boilerplate text and small pieces of text that you can use in your
chat sessions, such as common phrases, greetings, closings, and answers to questions
you receive frequently. Email resources may contain answers to commonly asked
questions and may contain attachments. URL resources may lead your customer to
corporate Web sites, such as a page on exchange policies.

Your administrator may have prepared "global" resources for you and other agents to use.
You cannot change or delete global resources, unless you are an administrator. However,
you can create agent resources for your own use. No one else can see your agent
resources.

When you respond to email, you may also have a list of "Suggested Responses" in your
Resource Area. These are temporary resources related to an email contact. For more
information, see Using Suggested Responses on page 109.

This section contains the following topics:

e Resource Types and Examples

e Creating New Agent Resources

e Creating New Global Resources (Supervisors Only)

e Editing Your Resources
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e Viewing Your Resources

e Organizing Your Resources

For information on sending resources to a customer, see Using Resources in a Chat
Session on page 143 or Using Resources in Email on page 107.

Resource Types and Examples

Email

Global and agent resources come in three types: email, text, and URL. This section
explains each type and gives an example.

An Email resource contains the subject and text of an email message that you can use to
respond to customers quickly. You can add an attachment to this message as well. When
you send the resource to a customer, you can add to or modify the message as needed.

For example, you could create an email resource to respond to a question customers
frequently ask about the safety of a product.

Text Files

URLSs

You can use text files to store "canned" or "boilerplate" greetings and responses. This
saves you time and tedium when you are responding to email or when you are engaged in
a chat session. You can add to or modify the message before you send it to a customer.

For example, You could create a "Welcome" text file containing text like the following:

Hello. Welcome to XYZ support. My name is Joe, and I am here to
assist you.

A URL resource is a resource that contains a linked address to a Web site. When you send
this resource to a customer in a chat session with you, the customer’s browser opens to
display that Web site. In most email programs, if you send the resource to an email
customer, the customer’s browser opens to the Web site when they click the URL.

Example:
A URL resource named "Shopping Mecca Catalog" might be

http://www.shoppingmecca.com/catalog/
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Tip:
You can use a File Transfer Protocol (FTP) site as a URL resource, so that
customers can go to the site to download files. When you create such a
URL, begin it with ftp://.

Example:

A URL resource named "XYZ ftp site" could take the customer to an ftp site at your
company. The contents of the URL resource might look like the following:

ftp://ftp.XYZsupport.com/special

Creating New Agent Resources

You can create your own resources and store them in the Agent Resources folder. These
are saved with your user account and are available to you whenever you log in. Other
agents cannot see or use the resources you create.

You can create resources for specific tenants. A tenant may be a company, such as XYZ
Corp; a location, such as New York or Boston; or a workgroup, such as Sales or Support.
You can create resources in different languages, which is useful if you interact with
customers in more than one language.

If you need to, you can edit a resource just before you send it to a customer. This makes it
possible for you to adapt the prewritten resources to meet your customer’s individual
needs.

Tip:
You can drag and drop a copy of any resource to a new location. For
example, you can copy a resource in your Global Resources folder into your
Agent Resources folder. Then you can modify the copied resource if you
want. In some cases, this is faster than creating a new resource from the
beginning.

To create a resource:

1. Right-click the Agent Resources folder or any of its subfolders in the Resource Area of
the Web Agent.

2. From the pop-up menu, select Create resource and the type of resource you want to
create. For information on each type of resource, see Resource Types and

Examples on page 172.
The New resource dialog box is displayed, with your Login ID and today’s date and

time already entered. This read-only information will be displayed as a tooltip when you
hold your cursor over this resource.

3. If you want to create the resource for a specific tenant, select that tenant from the
Tenancy drop-down menu.
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4. If you want to create the resource in a language other than your primary language,
select the language from the Language drop-down menu.

5. Enter a unique name to identify this resource in the Name field.

6. Follow the step below that applies to the type of resource you are creating:

Resource

Notes

URL resource

Type the entire URL, beginning with http://, https://, Or
ftp://. Do not type any text other than the URL.

If you do not begin the address correctly, you will not see an
error message at this time. However, you will see an error
message when you try to send it to a customer. If you send a
URL with an incorrect address, the customer who receives it
will see an error message when their browser attempts to
locate the Web site.

Tip: When creating a URL resource, you can copy a URL
from your browser and paste it into a resource. Select the
entire address from the browser’s Location or Address box
and click Ctrl-C. Put your cursor in the scroll box of the New
resource dialog box and click Ctrl-V. The URL is pasted into
the dialog box.

Text resource

Type the message that you want customers to see.
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Resource

Notes

Email resource

Fill in the fields as follows:

e To — You should probably leave this field blank. Your
current customer’s address will be filled in here
automatically each time you send this resource.

e Cc — Enter addresses here that you want be entered in
the Cc field of emails using this resource. In this way, you
can inform someone in your company that a customer is
seeking help on this topic.

e Bcc — If you want another person or persons to receive a
copy of this email whenever you send it to a customer, but
you do not want your customers to see the address or
addresses, enter the email address or addresses here.

e Subject — Type the subject of this email so customers
who receive an email from this resource can see what the
email is about before they open it.

Tip: Click the buttons beside the To, Cc, and Bcec fields to
look up the email addresses of other employees of your
company or External Agents in the Unified Agent Directory
(UAD). See the description of the fields below. When you find
the name of a person you want to add to the field, double-
click the name.

If you want to attach a file or files:

1. Click the Attachments tab and then the Add
Attachments (paper clip) button.

2. Use the drop-down menu and the buttons at the top of
the Open dialog box to locate a file you want to attach.
The file can be on your local hard drive or on any drive
on the network to which you have access.

3. Click on the file you want to add and then click Open.

4. If you want to attach more files, click the Add
Attachments button again.

5. Click OK.

7. Read carefully everything that you have entered in the New resource dialog box.

Tip:

To spell check your resource, select the text that you have entered and click
Ctrl-C to copy it. Then select Tools > Compose new email. Put your cursor
in the Text Composition Area of the email and click Ctrl-V to paste the text.
Click the Spell Check button from the email toolbar and run the Spell
Checker. After you correct any errors, you can copy the message and paste
it back into the New resource dialog box.
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8. Click OK.

If you need to change anything in this resource after you click OK, right-click it and
select Edit resource.

9. Click the Save Resources button in the Resources toolbar.

The resource is saved with your login ID so it will continue to be available to you until
you delete it.

Creating New Global Resources (Supervisors Only)

If you are a supervisor, you can create Global Resources for agents or groups of agents.
You may want to create separate resources for different tenants or agents in different
language groups. Follow the instructions in Creating New Agent Resources on page 173,
adapting them as necessary. Begin by selecting the Global Resources folder or any of its
subfolders.

When you click Save in the Resources toolbar, the resources you created or modified in
the Global Resources folder are saved on a shared drive that has been set up for this
purpose. Usually, this is the Global_resources.xml file. Other agents should be able to see
the resources you create the next time they log in.

Editing Your Resources

You can change any part of a resource that you have created, such as the tenancy,
language, name, or contents. (You can only change Global Resources if you are a
supervisor.)

To edit a resource:
1. Right-click the resource you want to edit.
2. Select Edit resource.

The Edit resource dialog box is displayed with all the information contained in this
resource. Use the drop-down menus if you want to change the tenancy or language.

3. Change the resource name or contents as you want, selecting any text you want to
delete or replace. If this is an email resource, you can also change the header fields
(To, Cc, Bcc, and Subject), or add or delete an attachment.

4. Click OK.

The resource is updated.
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Deleting a Resource

You can delete any resource you created yourself. Only supervisors and administrators
can delete a Global Resource.

To delete a resource:
1. From the Web Agent, select the resource.
2. Right-click the resource and select Delete resource from the menu that appears.

The resource is removed from the Resource Area.

Viewing Your Resources

Resources are organized in a hierarchy of folders and subfolders in the Resource area of
the Web Agent. In this area, you can view the folders, subfolders, and the resources they
contain by selecting commands from three places. Most of the same commands are
available in all three places.

e A toolbar and drop-down Filter by menu at the top of the Resource area
e The Resources menu
e Pop-up menus displayed when you right-click a folder

To show the contents of all folders and subfolders in the Resource area, select Expand All
from the toolbar or from the Resources menu. To show only the folder or folders that
contain all the other folders, select Collapse All.

Note:

You may have only one main folder, called Resources, which contains all the
other folders. In this case, Collapse All displays only that folder.

To hide the subfolders and contents of any folder that is currently open, right-click the
folder and select Collapse folder from the pop-up menu. To show the subfolders and
contents of any folder that is currently closed, right-click it and select Expand folder from
the pop-up menu.

Tip:
Keyboard characters to the side of the folder icons indicate whether folders
are open, closed, or empty.
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To display only a particular type of resource within the open folders, click one of the
following items from the Filter by drop-down menu:

e Blank — Displays all types of resources for all tenants and all languages.

e Tenant — Displays only the resources for a specified tenant. A tenant may be any group
in an organization, such as a company, location, or workgroup.

e Language — Displays only the resources for a specified language.
e Text resources — Displays only text resources.
e URL resources — Displays only URL resources.
e Email resources — Displays only Email resources.
Note:
You cannot filter Suggested Responses or Email Templates.

To view the contents of a resource without opening it, select the Preview content check
box at the lower part of the Resources area, as shown in the following illustration. Use the
vertical and horizontal scroll bars to see more of the resource.

% B Policies
Returns
Exchanges
Privacy

& & Clothing

(€% Email templates

[Vl Preview content

To protect your privacy and maintain your confidend 2
the following polices. These policies describe the s{3

|1 | |:§:_:§

SR | »]

Shopping Mecca will not sell your personal infarma
4

Organizing Your Resources

You can create folders and subfolders to keep your Agent Resources organized. If you are
a supervisor, you can do this for Global Resources also. After you create a folder or
subfolder, you can drag and drop resources into it.

To organize your resources:

1. If you want to display the contents of all the resource folders, including subfolders and
resources, select Expand All from the toolbar.

2. Check the Filter by drop-down menu to be sure you are displaying all the resources
that you plan to organize into folders. If no text is displayed until you open this drop-
down menu, you are displaying all the resources, regardless of type.
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3. To create a new folder, right-click the existing folder in which you want to create your

folder. Then click Create folder in the pop-up menu.

The new folder, with the name "New resources," is added under the current folder with
the name already selected so that you can easily rename it.

4. Type a new name for the folder and press Enter.

The name you typed is displayed next to the folder icon.

5. If you have already created the resources for this folder, drag and drop them one at a

time into the new folder. You can also drag a folder or resource from an open folder
and drop it into another folder.

Importing Migrated Resources

Administrators of your contact center may have prepared resources with version 5.6 of
Avaya IC. If your administrator asks you to import these "migrated” resources, take the
following steps. Otherwise, you can ignore this section.

If you previously worked with version 5.6, you can import the agent resources you created
as well as the global resources that administrators created. Your agent resources are
located in a folder that has the name of your login ID. Your administrator should tell you
where the resources you will import are located.

To import migrated resources:

1

. Select Resources > Import.

The window at the right side of the Web Agent displays the Import resource file
button.

. Click the Import resource file button.

The Open dialog box is displayed.

. If you had agent resources in the previous version of Avaya IC, do the following:

a. Navigate through your folder until you find your resource file. Agent resources have
.wac at the end of their filenames.

b. Double-click the filename when you find it.

4. Use the drop-down menu to find the folder where the global resources are located.

5. Locate the global resources file. Global resources have .rsc at the end of their

filenames.

. Double-click the filename when you find it.

The resources are imported and displayed in the Resource area.
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Setting Preferences

You can use the Web Agent Preferences dialog box to set certain options about the
display of the Web Agent and the way you handle your email and chat contacts.

Note:

Except for User Interface settings, all preference changes you make take
place immediately. User Interface changes, such as changes to the size of
the font or icons, take place only when you exit the Web Agent and start it
again.

To set your preferences:
1. If the Web Agent is not currently displayed, click the Web Agent button in the task bar.

2. In the Web Agent, select Tools > Preferences.

The Web Agent Preferences dialog box opens. Note that it contains five tabs and
opens to the User Interface tab.

3. Click the tab with the category of preferences that you are interested in seeing or
changing. The tabs and their options are described in the following sections:

e User Interface Preferences on page 181

e Contact Preferences on page 182

e Email Preferences on page 183

e Chat Preferences on page 185

e Other Preferences on page 186
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User Interface Preferences

When you open the Preferences dialog box, the User Interface tab is displayed, as
shown in the following illustration.

Web Agent Preferences [ %]

User Interface | »# Contact r@ Email Chat ra Other|

Client Settings

[CJ Use large icons for menus and buttons

[¥] Word-wrap text

Font Settings

Menus [Labels Text|

Font Narme | SansSerif v| Style | Bold v| Size | 13 v|

Avaya Web Agent

0K Cancel

User Interface preferences are related to the display of the Web Agent. The changes you

make in the User Interface tab do not take effect in the Web Agent until you log out and
log back in again.

You may see two parts of this dialog box, Client Settings and Font Settings. The Client
Settings include:

e Use large icons for menus and buttons — With large icons, it is easier to see what the
icons represent.

e Word-wrap text — This selection makes the text you write in email or chat move to the
next line automatically whenever the text reaches the edge of the window.

The Font Settings section contains tabs and drop-down menus for you to choose the way
the text looks in different parts of the interface.

Tip:
To see a sample of the different font options, make selections from the drop-
down menus. The sample text in the changes according to your selections.

The selections are saved only when you click OK. You will see the changes
in the Web Agent the next time you log in.

The Font Settings include:
e Font Name — The name of the type face. You may see the following choices:

e Serif — A font with decorated letters, that is, letters with little strokes on their edges.
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e SansSerif — A font with plain letters, that is, letters without little strokes on their
edges. The font in this sentence is a SansSerif font.

e Monospaced — A font in which all letters have the same width. Many newspapers
use a monospaced font.

e Style — Whether the font is bold or plain.

A\ cAuTION:

If you are using Japanese characters and want to use a bold text style, you
must select a monospace font. If you want to use a serif or sansserif font
with Japanese characters, you must select the Plain text style or Avaya
Agent may not display chat and email preview text correctly.

e Size — The size of the font. Usually the smallest size you can choose is 8 and the largest
is 20.

Contact Preferences

The options in the Contact tab apply to both email and chat contacts. The options, as
shown in the following illustration, are as follows:

Web Agent Preferences [ %]

(User Interface [ Contact | = Email Chat ra Other|

Contact Arrival Settings

[CI WWait for agent confirmation befare accepting a contact
[vi Alert with sound when a new contact arrives
B Contact Handling Settings

[vi Display a confirmation before wrapping a contact

0K Cancel

e Wait for agent confirmation before accepting a contact — If you select this option, a
dialog box, called a "screen pop," is displayed whenever a new email or chat contact
arrives, allowing you to accept or reject the contact. If you reject the contact when the
dialog box is displayed, the contact is assigned to another agent.
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Note:

If you select this option and you do not click Yes or No in the allotted time
when the dialog box is displayed, the chat or email contact will be removed
from your task list. In addition, your agent state will change to Aux-work.

e Alert with sound when a new contact arrives — If you select this option, a sound is
played whenever a new email or chat contact is assigned to you. The sound is the
Microsoft® Windows default beep, defined in the properties for system sounds in the
Windows Control Panel.

e Display a confirmation before wrapping a contact — If you select this option,
whenever you click the Wrap button, a dialog box asks you to confirm that you want to
wrap up the email contact or chat contact. This prevents you from accidentally ending
the session with your customer.

Email Preferences

The options in the Email tab apply only to email you send from the Web Agent. The
options are as follows:

Web Agent Preferences - x|
(User Interface r'—,—\/ Contact r@ Email Chat ra Other|
E® Email Composition Settings

[CI Spell check before sending an email
[¥] Spell check original message text in reply
[vi Confirm befare sending an email

[vi Quate original message in email response

Cluote prefix to be used |>

[CJ Use default pool for new outbound email

Default pool for new outbound email |F'00I_aShisht_hreakme_usaw_avay v|

[¥l Use default character set for email

Default character set for outbound email |Latin [I1S0-8859-1] v|

B Email Contact Settings
[Vl Wrap contact after a "Normal Reply” response
[CI WWrap contact after a "Send to Extemal Agent” response

[C] WWrap contact after a "Regquest Additional Information” response

0K Cancel

e Spell check before sending an email — If you select this option, the Spell Checker is
displayed whenever you press the Send button. This reminds you to check the spelling
of each email message and allows you to correct any errors before the message is sent
to the customer.
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e Spell check original message text on reply — Check this box if you want to include
the customer’s original message when you spell check your email replies. If you do not
select this option, the Spell Checker will check only the new text in your reply.

Note:

If you do not select this preference, you should be careful when you use the
Change All feature. The Change All feature may not change all
occurrences of the word, possibly leaving misspelled words, if you do either
of the following things:

e If you clicked the Ignore button when the Spell Checker found this misspelled
word in previous text of this email, then it will continue to ignore the misspelled
words.

e If you cancel the spell check before it has finished checking the entire
message, the misspelled word might occur in text that was not checked.

e Confirm before sending an email — If you select this option, after you click the Send
button to send an email, a dialog box asks if you are certain that you want to send this
message. This gives you a last chance to check your emails before you send them.

e Quote original message in email response — This option inserts the customer’s
original message into your email replies. With this option, you can see what you are
responding to and your customer can see what they wrote you in their original message.
If you select this option, you can also select the following:

e Quote prefix to be used — You can change the keyboard character that is entered in
the text box at the start of each line in the original message. The default character is a
closed angle bracket (>).

e Use default pool for new outbound email — This option lets you set the queue (pool)
that will be used when you originate a new outbound email. The queue that is used for
your outbound emails is also used to route replies to those emails. For example, if a
support queue is used for your new outbound emails, replies to your new outbound
emails will be routed to the support queue. If you select this option, select the queue that
will be used for all of your new outbound emails from the drop-down menu.

Note:

If you do not select this option, whenever you start to send a new outbound
email, a dialog box like the following will ask you to select the queue.

Make selections before sending ﬂ
Specify inbound gueue(pool): Pool B0Z2support_aulab md_avay =

Pool B02support_aulab_rnd_avay |

Franl ashisht hreakme nsaw away
e Use default character set for email — You can change the character set used by

default in your new outbound email to the character set of another language. If you
select this option, select the character set from the drop-down menu.
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e Wrap contact after a "Normal Reply" response — If you select this option, your normal
email replies are automatically wrapped up after you send them. Normal replies are

email responses in which you leave Normal Email Reply selected in the drop-down
menu.

e Wrap contact after a "Send to External Agent" response — If you select this option,
your email replies when you select Send to External Agent from the drop-down menu
are automatically wrapped up after you send them.

e Wrap contact after a "Request Additional Information” response — If you select this
option, your email replies when you select Request Additional Info from the drop-
down menu are automatically wrapped up after you send them.

Chat Preferences

The options in the Chat tab, which apply only to chat sessions, are as follows:

(User Interface r'—,—\/ Cantact r@ Email Chat ra Other|
% Chat Settings
[CI Spell check text before a "Say"
“Q "Away From Desk" Settings
[C] Enable "Away From Desk" message
Time interval between "Away From Desk" messages (in seconds) E
“Away From Desk" message text [Please wait, | will be right back. ..
OK Cancel

e Spell check text before a "Say" — If you select this option, the Spell Checker is
displayed whenever you press the Say button, so you can check the spelling of each
chat message and correct any spelling errors before the Web Management software
sends the chat message to the customer.

e Enable "Away From Desk" message — If you select this option, whenever you have
not responded to the customer within the specified period of time, a message is sent to
the customer. This is useful if you plan to be available to handle multiple chat sessions
or multiple channels simultaneously, such as email and chat. After you select this check

box, you can change the time interval, and you can specify what the message says in
the text box.

Issue 2 February 2005 185



Performing Chat & Email Tasks

e Time interval between "Away From Desk" messages — The message referred to in
the description of the previous preference is sent each time the specified amount of time
passes, until you type a chat message to the customer.

e "Away From Desk" message text — This option lets you can change the text that is
sent to the customer whenever you do not respond within the time interval that is
specified.

Other Preferences

The options in the Other tab are as follows:

(User Interface r'—,—\/ Contact r@ Email Chat (£ Other
€3 Browser Settings

Internet Explorer Browser Path |C:fF'r0gram Files/internet Explorer/IEXPLORE.EXE |J
© Supervisor Settings

[C] Default mode "Visible" when monitating a chat session

[C] Start collaboration automatically when monitaring a chat session

%, Resource Settings

[vi Automatically save resources during logout

[vi Confirm before deleting a resource or folder

[C] Leave copy of original when copying resource to new location

[¥] Use resource when double-clicked {with chat, sends message immediately to customer)

0K Cancel

e Internet Explorer Browser Path — If you want to use a different installation of Internet
Explorer, click the button and navigate to the program.

e Default mode "Visible" when monitoring a chat session — (Supervisors only) If you
are a supervisor and you select this option, whenever you begin to monitor a chat
session, the system announces your presence to the agent in the Transcript area.

e Start collaboration automatically when monitoring a chat session — (Supervisors
only) If you are a supervisor and you monitor multiple sessions and you do not use
Shared Browsing in the sessions, you may want to select this option. Otherwise,
whenever you start to monitor a session, a browser opens to enable Shared Browsing in
that session, and whenever you leave a session, the browser closes.

e Automatically save resources during logout — If you select this option, any new
resources are always saved when you log out, and you do not get a message asking if
you want to save them.
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e Confirm before deleting a resource or folder — If you select this option, whenever you
start to delete a resource or a folder, a dialog box asks if you are certain you want to do
this.

e Leave copy of original when copying resource to new location — If you select this
option, whenever you drag and drop a resource from one folder to another, the original
resource remains in the original location while a copy of that resource is created in the
new location.

e Use resource when double-clicked — If you select this option, whenever you double-
click a resource, its contents are inserted into the email or sent to the chat customer
immediately. If you do not select this option, when you double-click a resource in a chat
session, the resource moves to the Text Entry area, where you have a chance to view or
change it before sending it to the customer.

Using Web Self-Service

The Web Self-Service database contains commonly requested information about products
and services that your contact center supports. This makes it possible for your customers
to find answers to their questions by themselves. The database is also referred to as the
FAQ (frequently asked questions) database.

You can also help your customers find answers in this database, in the following ways:
e For your chat customers:
- Use the Auto Sync feature to lead them to the appropriate documents
- Push URLs of the documents to them
e For your email customers:
- Email them the URLs of the appropriate documents
- Paste the contents of the documents in your email responses
e For your telephone customers:
- Read to them the URLSs or the contents of the appropriate documents
- Email them the URLSs or the contents of the documents
e For all your customers:

- Create resources using the contents of the document
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Finding Documents in Web Self-Service

Itis a good idea to learn your way around the Web Self-Service database so you can help
customers quickly. You can find topics and documents in the following two ways:

e Navigating the Topic Hierarchy on page 188

e Searching the Web Self-Service Database on page 189

Tip:
By default, your browser is displayed inside the Avaya Agent. To see more
of your browser, open the Avaya Agent menu and select Always on Top to
remove the check mark.

Navigating the Topic Hierarchy

One way to find specific topics and documents in the Web Self-Service database is to
navigate the topic hierarchy, as described in the following procedure.

To navigate the topic hierarchy:
1. In the Web Agent, select Tools > Submit FAQ.

2. If you want to find a document for a tenant other than the DefaultTenant, click Manage
FAQ on the left side of the page.

Your browser opens to the Manage FAQ page, asking you to select a tenant A tenant
may be a company, such as XYZ Corp; a location, such as New York or Boston; or a
workgroup, such as Sales or Support.

3. Select the tenant and then click Manage FAQ.
The FAQ Database page displays the root folders in the database of FAQ documents.

4. If you want to find documents in a different language from the one displayed, select
that language from the Select language drop-down menu at the top of the page.

5. Navigate through the folder hierarchy in the FAQ Database section to find the desired
topic.

Topics are indicated by folder icons. Folders may contain other folders, which may
contain still more folders, and so on. When you open a topic folder containing
documents, the documents are displayed under a line separating them from the folder.
Documents are marked by a document icon.

6. Click the name of any document that you want to see.

The contents of any text document you select are displayed beneath a line separating
it from the list of documents.

If the document is a URL, click the link beneath the topic title to display the Web page
containing the information.

188 Avaya Agent User Guide



Using Web Self-Service

Searching the Web Self-Service Database

You can search the Web Self-Service database for any available topics or documents that
match your search criteria.

To search the Web Self-Service database:

1.

In the Web Agent, select Tools > Search Web Self-Service.

Your browser opens to the Search FAQ page.

. If you want to search for a document associated with a tenant other than the

DefaultTenant, click Search FAQ on the left side of the page, select the tenant, and
then click Search FAQ.

. If the document you want to view is related to a specific language, make the

appropriate selection from the drop-down menu.

. Enter a term in the What are you searching for field.

Note:

The term you enter can be a phrase or a single keyword. You cannot use
any wildcards.

. Click Go.

All documents containing the term you entered are displayed in the Search page.

Submitting Documents to Web Self-Service

You can submit a document for addition to the Web Self-Service database, which is then

subject to your administrator’s approval or rejection. You can create the document on the
Submit a Document page, paste an existing document into that page, or enter a URL that
displays an HTML document.

Note:
If you are a supervisor, there are several additional fields available when you
submit a document. For a description of those fields, see Viewing, Editing,
or Deleting Proposed Documents on page 190.

To submit a document for the Web Self-Service database:
1. In the Web Agent, select Tools > Submit FAQ.

2. If you want to submit a document for a tenant other than the DefaultTenant, click

Manage FAQ on the left side of the page.

Your browser opens to the Manage FAQ page, asking you to select a tenant A tenant
may be a company, such as XYZ Corp; a location, such as New York or Boston; or a
workgroup, such as Sales or Support.
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3. Select the tenant and then click Manage FAQ.

4. If you want to find documents in a different language from the one displayed, select
that language from the Select language drop-down menu at the top of the page.

5. Select the topic to which you want to add a document.
6. At the bottom of the Manage FAQ page, click Submit.
The Submit a Document page is displayed
7. Write unique title for this document in the Document Title field.

8. If the document is an HTML page set up for the Web site, click Internet Link. Then
enter the URL with the complete address, such as http://www.avaya.com

9. If the document will be text, leave the Text button selected. Enter your text for the Web
Self-Service database in the Text box.

Tip:
If you want, you can copy from an existing document, such as a Microsoft®
Word document or an email, and then paste the copy into the text box.

10. Read what you have written to check it for errors.

Tip:
You can use the following trick to spell check your document. Select the
entire document in the Text box and click Ctrl-C to copy the text. Then go to
the Web Agent and select Tools > Compose new email. Click Ctrl-V to
paste the text you copied into the Text Entry area. Click the Spell Check
button and check the spelling. After you correct any errors, select and copy
the message. Return to your browser and the Submit a Document page.
Paste the text back into the Text box. (Later you can delete the email
composition text from the Web Agent.)

11. Scroll to the bottom of the Submit a Document page and click Submit.

Your document is added to the Proposed Documents list, which is the list of documents
waiting for approval from your supervisor. If you want to view, edit, or delete a
document you have submitted, see Viewing, Editing, or Deleting Proposed
Documents on page 190.

Viewing, Editing, or Deleting Proposed Documents

You can make changes to a document that you have proposed for the FAQ database, or
remove it before your supervisor has approved or rejected it.

If you are a supervisor, you can view, edit, and delete the proposed documents that agents
in your workgroup submit. In addition, as supervisor, it is your responsibility to read the
documents that agents in your submit to the database and either approve or reject them.
For information, see Approving or Rejecting Documents (Supervisors Only) on page 191.
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To view, edit, or delete proposed FAQ documents:
1. In the Web Agent, select Tools > Submit FAQ.
2. Select Manage Proposed FAQ from the left side of the page.

3. If the proposed FAQ that you want to see was entered for a different tenant or in a
different language, make an appropriate selection. Then click the Manage Proposed
FAQ button.

A list of pending FAQ documents for this tenant and language is displayed.
4. To view a proposed document, click its title.
5. If you are an agent, make any necessary changes and click the Update button.
6. If you are a supervisor:

a. Read the document and decide whether you want to accept it. If you do not want to
add the document, scroll to the bottom of the page and click the Reject button.
Otherwise, continue with this procedure.

b. Enter the ASCII title for the document. This title will always appear exactly as you
enter it regardless of what language is selected.

c. Make any necessary changes to the language-specific portions of the document
that were entered by the agent.

d. Enter the task type, mail account, and routing hint information for this document.
(For details about these fields, see IC Administration Volume 2: Agents, Customers,
& Queues.)

e. When you are done, click the Accept button.

Approving or Rejecting Documents (Supervisors Only)

As a supervisor, you must approve or reject documents submitted by members of your
workgroup.

To approve or reject proposed FAQ documents:
1. In the Web Agent, select Tools > Submit FAQ.
2. Select Manage Proposed FAQ from the left side of the page.

3. Select the tenant or language of the proposed documents you want to see and click
Manage Proposed FAQ.

A list of pending FAQ documents for this tenant is displayed.

4. To view a proposed document, click its title in the Pending column.
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5. Read the document and decide whether you want to accept it. If you do not want to
add the document, scroll to the bottom of the page and click the Reject button.
Otherwise, continue with this procedure.

6. Enter the ASCII title for the document. This title will always appear exactly as you enter
it regardless of what language is selected.

7. Make any necessary changes to the language-specific portions of the document that
were entered by the agent.

8. Enter the task type, mail account, and routing hint information for this document. (For
details about these fields, see /IC Administration Volume 2: Agents, Customers, &
Queues.)

9. When you are done, click the Accept button.
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Chapter 7: Handling Outbound Contact Calls

Your company might require you to make telephone calls to customers using the Avaya™
Outbound Contact Management feature. If so, you use information displayed on the
Outbound Contact tab to handle automated outbound calling.

Note:
Do not confuse Outbound Contact with Outbound List Processing. You
handle automated outbound calls using the Outbound Contact tab in
Avaya Agent. You make outbound calls manually using the Outbound Lists
tab, described in Chapter 8: Managing Outbound Lists.

Outbound Contact initiates telephone calls to customers while automatically displaying the
customer information. The software guides you through the process of handling each call,
from the initiation of the telephone call to recording its outcome.

This chapter provides you with step-by-step instructions on how to handle Outbound
Contact calls, under the following topics:

e Using Avaya Agent with Outbound Contact
e Getting Started with Outbound Contact
e Proceeding Through Agent Tasks

e Agent Blending

e Example: Using Outbound Contact

Using Avaya Agent with Outbound Contact

If you are assigned to use Outbound Contact, your supervisor has set up your calling
activities, called “jobs.” A job includes a list of customers to be called.

As you carry out these jobs, you use areas of the Avaya Agent to help you manage your
telephone calls to customers. For example, as you speak with customers, you can view
information about them on the Contact History Browser tab.

Issue 2 February 2005 193



Handling Outbound Contact Calls

The following illustration shows the Outbound Contact tab.

‘ !Aura ﬁl-nlj < 1

Media Outbound Contact |
-— 2

[& x| [mlEmn=]

Available jobs:

I AutalobT

il At ob2

i Predictiveob2
ﬂ Previeva] obl
B PreviewobZ

N o
Jain Job I Leave Job |
Refresh |

Handling a call in job:

Previewl obZ
Message 1. Outbound Contact tab
2. Outbound Contact toolbar
3. Available jobs bar
Note:

Your system administrator can customize the appearance, behavior, and
positioning of Avaya Agent. Therefore, your desktop might look and function
differently from the illustration above.

The following components in Avaya Agent help you manage your outbound calling activity:

e Outbound Contact tab — Shows the available jobs you can join and the activities you
can complete during each call. You can sort the list of job names in ascending order (A-
Z and 0-9) or descending order (Z-A and 9-0) by clicking the Available jobs bar.

e Prompter tab — Displays the script you follow during your conversation with the
customer. You enter information and select the appropriate responses from drop-down
lists, check boxes, or option buttons. Your script might include command buttons such
as Yes, No, OK, Cancel, Next, or Back.

e Contact History Browser tab — Lists information about previous contacts your
company has had with the same customer.
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Getting Started with Outbound Contact

When using Outbound Contact, you speak with customers and handle telephone calls
whether you are learning how to use this software, handling sensitive calls that require
time to review the customer information, or calling customers with a quick reminder.

Outbound Contact uses the dialing mode assigned to yourself, the job, and optionally the
customer record to identify how you will receive connections to customers. When your
supervisor defines your agent account, he or she assigns a dialing mode. When your
supervisor sets up a job, he or she assigns a dialing mode to the job. When setting up the
customer data to import, your contact center administrator potentially assigns a dialing
mode to the telephone number. The dialing mode determines how the software:

e Dials customer telephone numbers

e Connects you with customers

e Displays customer information
Outbound Contact has three dialing modes:

e Preview dialing mode — Outbound Contact notifies you of the telephone call before it
dials the customer’s telephone number. You can prepare for the call and view the
customer’s information on the Contact History Browser tab. Preview is the least
aggressive dialing mode.

e Automatic dialing mode — Outbound Contact places a call to the customer and notifies
you about the telephone call as it dials the number. The software displays a
conversation script on your desktop when you hear the ringing tone.

e Predictive dialing mode — Outbound Contact dials the customer telephone number,
displays the customer information, and connects you with the customer. You receive the
call as the software displays the customer's information on the Contact History
Browser tab. The script is displayed on the Prompter tab. Predictive is the most
aggressive dialing mode.

During the job, Outbound Contact uses the least aggressive of the dialing modes assigned
to yourself, the job, and the telephone number to determine how to establish the telephone
call, which affects when you receive the customer information. For example: If you as the
agent is set to preview mode, the outbound job is set to the predictive mode, and the
telephone number is set to automatic mode, then Outbound Contact uses the preview
mode to present you with the customer information before you choose to accept or reject
the telephone call.
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Logging In to Outbound Contact

The way you log in to Outbound Contact depends on whether you have a single login ID
and password for Avaya Agent, or you have one login ID and password for the work you do
from the Media tab and a different login ID and password for Outbound Contact.

If your Avaya IC system uses a feature called Business Advocate, you have a different
login ID and password for Outbound Contact. When you want to switch between doing
work on the Media tab and doing Outbound Contact jobs, you must log out of Avaya Agent
and log back in with the other login ID and password.

If you do not have a separate login ID and password for Outbound Contact, you log in to
Outbound Contact after you log in to Avaya Agent, as described below.

Note:

Whether you have one login ID or two, you must log in to Avaya Agent at the
workstation that has the Phone Type assigned to your login ID. Ask your
supervisor for help, if you cannot log in to Outbound Contact.

To log in to Outbound Contact:

e On the Media tab, click Agent to change the button to Available. When Avaya Agent
switches you to Outbound Contact, the Agent icon changes to Outbound Contact and
moves you to the Outbound Contact tab.

A\ cauTiON:

When handling outbound calls, complete each conversation using the
toolbar buttons on the Outbound Contact tab. Select the Close toolbar
button to end the conversation and complete the Wrap-up dialog box, and
select the Proceed toolbar button to complete the call.

Joining Outbound Jobs

Using the Outbound Contact tab, you select one or more jobs, join the jobs, and go “off
break” to become available to handle calls. Outbound Contact begins the process of
connecting you with customers.
To join a job:
1. In the Available jobs field, select the jobs your supervisor tells you to join.
Tip:

To display the list of jobs in ascending (A-Z and 0-9) or descending (Z-A and
9-0) order, click the Available jobs bar.
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e To select a series of consecutive jobs, press the Shift key, and then select the first
and the last job name.

e To select more than one job individually, press the Control key while you select
each job name.

2. Click Join Job on the toolbar.

The icon preceding the job name changes from a closed red lock to an crossed-out
agent ready for you to go “off break,” as shown in the following illustration:

é EM‘I]‘I Al-nlj
_ Media  Outbound Contact |
(&S ]se] = |2 =]

Axailable jobs:
i Autaabl
il St ob2
il Predictivelob2
ﬂ Presviewmlobl
ﬂ Presiew) ob

After you join one or more jobs, you are ready to use Outbound Contact.

Making Yourself Available for Outbound Contact Calls

After logging in, you need to make yourself available to receive Outbound Contact calls.
You will initially be “on break.”

To make yourself available:
e Click Off Break on the toolbar.

The icon preceding the job name changes from a crossed-out agent to an open blue lock.
You are ready to receive and handle outbound calls.

Outbound Contact displays customer information on your screen based on the least
aggressive dialing mode assigned to you, the job, and the telephone number. For more
information, see Getting Started with Outbound Contact on page 195.
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Proceeding Through Agent Tasks

After you log in to Avaya Agent and Outbound Contact, you handle most of the calling
activity from the toolbar on the Outbound Contact tab, as shown below.

& x| alalsln]-

As you proceed through each task, Outbound Contact enables and disables buttons that
show the tasks you can do next. Your outbound calling tasks include the following:

Button Action
_ Select and join one or more jobs that your supervisor started.
Jein. Select jobs from the Available jobs field.
Click Join Job on the toolbar.
Join Job
Click Off Break on the toolbar to tell Outbound Contact you are
l “off break” and are available to handle telephone calls. The On
Break toolbar button becomes enabled.
Off Break
If the telephone call is set to the preview dialing mode, you can
. | H. | accept or reject placing the call after previewing the customer
information on the Contact History Browser tab.
Click Accept on the toolbar to dial the number and speak with a
Acc_:ept customer. Outbound Contact enables the appropriate toolbar
Reject buttons.
Click Reject on the toolbar to not make this telephone call.
Outbound Contact enables Proceed. To continue with the next
call, click Proceed.
The Accept and Reject buttons are disabled for automatic and
predictive dialing modes.
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Button Action
0. During the job, you can read the script on the Prompter tab to
greet your customer and ask questions. During your
conversation, you move from question to question by clicking the
OK appropriate button.
Cancel |
Cancel
et
Next
< Back
Back

During your conversation, you might need to record information about placing a call to the

customer in the future.

e

No Contact

Ok

OK

During the calling activity, you might handle an outbound call that
did not connect with a customer because Outbound Contact
detected an answering machine, busy tone, fast busy tone,
special information tone, no answer, fax machine, or modem.
Click No Contact on the toolbar. In the No Contact dialog box,
identify why the call was unsuccessful. When you click OK,
Outbound Contact records the call result for you.

When you identify the call and click OK, Outbound Contact
reschedules the call to occur at a later time.

=

Reschedule

OK

During the telephone call, you can reschedule the call for a
different day or time of day, click Reschedule on the toolbar. In
the Reschedule dialog box, specify the time, date, and an agent
to handle the call. Click OK to continue with the next call.
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Button Action
If the customer asks not to receive a telephone call again, click
ﬁ| Do Not Call on the toolbar. In the Do Not Call dialog box, you
can add a reason for the customer’s request. Click OK to
continue with the next call.
Do Not Call
OK
When you complete your conversation, click Close on the
Fg. | toolbar.
_— Depending on Avaya Agent is set up, Outbound Contact displays
the Wrap-up dialog box for you to record the call result. Select a
Close category, a reason, and an outcome code. Then click OK.
OK
Click Proceed on the toolbar to record the result of the telephone
= call and indicate that you are ready to speak with the next
customer.
Note: Depending on how Avaya Agent is set up, Outbound
Proceed Contact may do this for you.
During the day, you can take a break, join additional jobs, or leave one or more jobs
without logging out of the Outbound Contact.
Click On Break on the toolbar to indicate that you want to change
$ your calling activity from being available to unavailable.
You become unavailable after you complete the conversation and
end the call.
On Break When you become unavailable, Outbound Contact changes the
toolbar button to Off Break.
To log off from a job, you must be “on break.” To log off, select
Leawe Job | one or more jobs from the Available jobs field and click Leave
Job. Outbound Contact no longer connects you with telephone
calls on the job you leave.
Leave Job
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Viewing Customer Information

Depending on the dialing mode, you can view the next customer’s information either
before or when Outbound Contact connects you to the customer. For more information,
see Getting Started with Outbound Contact on page 195.

If the telephone call will occur using the preview dialing mode, Outbound Contact notifies
you of the telephone call and displays the customer information and script. This makes it
possible for you to prepare for the telephone call.

You decide whether to accept or reject placing the call before Outbound Contact dials the
customer telephone number. If you reject the call, the software passes you information for
the next customer that matches your profile.

e Click Accept to place the telephone call to the customer. Outbound Contact dials the
customer’s telephone number and connects you with the customer.

e Click Reject to not make the telephone call to the customer. Outbound Contact retrieves
the next appropriate customer information and displays it on your screen.

If the call will occur in the automatic dialing mode, you see the customer information while
Outbound Contact dials the customer telephone number. Typically, you do not have the
option to accept or reject the call.

If the call will occur in the predictive dialing mode, you see customer information when
Outbound Contact connects you to a customer.

Identifying a Cancelled or an Unsuccessful Call

Occasionally, you may not be able to handle a call that Outbound Contact dialed. This may
occur if you need to cancel a preview dialed call that is ringing or if Outbound Contact
cannot successfully contact the customer. If Outbound Contact cannot contact the
customer, you hear an answering machine, a telephony tone, network message, or dead
air through your headset.

In these circumstances, you click No Contact on the toolbar, identify the reason for the
unsuccessful call in the No Contact dialog box, and click OK. Outbound Contact marks the
customer information to reschedule the telephone call for a later time.

Note:
If you need to cancel a preview call that is ringing, end the call from the
Outbound Contact toolbar. Do not end the call from the Ringing dialog box. If
you do not complete end the call from Outbound Contact, you will be
reconnected to the call you just cancelled.
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The No Contact dialog box looks like this.

. Mo Contact

" Fast busy

" Special Information Tane

ak

=10] x|

" Mo answer
" Fax machine

£ Modem

LCancel

The meaning of the No Contact reasons are the following:

Tone Description

Answering An answering machine answered the telephone call.

machine

Busy The telephone number is in use.

Fast Busy The public switched telephone network (PSTN), rather than the
telephone, is busy.

Special You hear a series of special tones, a code, or an announcement

Information Tone
(SIT)

when connected to the telephone number.

No Answer

No one answered the telephone call within the number of rings your
call center would consider to be a no answer.

Fax machine

A fax machine answered the telephone call.

Modem

A telephone modem answered the telephone call.

Note:

If you do not complete the following steps to record the No Contact outcome,
Outbound Contact will record the result of the telephone call as if you
completed the telephone call with the customer. Outbound Contact will not
reschedule the call for a later time.
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To record the No Contact outcome:
1. Click No Contact on the toolbar.
2. In the No Contact dialog box, select the reason for the unsuccessful call and click OK.

If you need to cancel a preview call that is ringing, select No Answer for the reason.
Outbound Contact will reschedule the call for a later time.

3. Click Proceed on the toolbar when you are ready to speak with another customer.

Outbound Contact connects you with the next customer.

Handling the Conversation

After you receive a call, begin your conversation with the customer by reading the script
associated with the job and recording the customer’s responses. Avaya Agent displays the
script on the Prompter tab. You might need to click the Prompter tab to begin. The script
text is based on your conversation and the customer’s responses to your questions.

During the conversation, the customer might ask that you reschedule the call or that you
do not place a call to the customer in the future.

Rescheduling a Call

You can reschedule a call to occur later in the day or on another day while handling a call.
You can also specify whether a specific agent or any agent can handle the call. Outbound
Contact records the customer’s request after you end the conversation.

Note:

Outbound Contact calls the customer based on the customer’s local time.
For this reason, make sure that the agent is available at the rescheduled
time.
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To reschedule a call:

1. Click Reschedule on the toolbar.

Outbound Contact displays the Reschedule Call dialog box completing the fields with
the current date and time, as shown in the following illustration:

. Reschedule Call [X]

Date and Timel Assign Agent

Date: Cancel |
I 052502 - I

Tirne:

: =
10:31 =

Meszage:

2. On the Date and Time tab:
e To set the date, select the date from the Date field drop-down list.
e To set the time, click the up or down arrow button to scroll to an earlier or later time
of day. You can also type the time in the hour and minute fields.

Note:
Outbound Contact displays time based on the time format for your locale.
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3. On the Assign Agent tab, select an agent to handle the rescheduled call, as shown in
the following illustration:

. Reschedule Call

Date and Time | oK |

Ay
PaulHenry

Cancel

SarriMrite
Caral-B
Sally_425

Meszage:

Select a specific agent name or select Any in the list box to have Outbound Contact
assign the rescheduled call to the next available agent.

4. Click OK to close the Reschedule dialog box.
5. Click Proceed on the toolbar.

Outbound Contact marks the call result and connects you with the next customer. You
do not need to complete the Wrap-up dialog box.

Adding the Customer to the Do Not Call List
If the customer requests never to receive a call again, follow this procedure.

To add the customer to the Do Not Call list:
1. Click Do Not Call on the toolbar.

Outbound Contact displays the Do Not Call dialog box with the customer’s telephone
number as shown in the following illustration.

. Do Hot Call M= E3

Customer [11410004939] azked to be
placed in the Do Mat Call list

LCancel |

Description:
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2. In the Description field, type an explanation why the customer wants to be added to
the Do Not Call list.

3. Click OK.

Outbound Contact ends the call, adds the customer’s telephone number to the Do Not
Call list, and records the customer’s request in the database. You do not need to
complete the Wrap-up dialog box.

4. Click the Proceed button.

Receiving Direct Calls

Occasionally, you may receive an incoming call while you are on an outbound job. This
telephone call is referred to as a direct call. A person outside the contact center, another
agent, or your supervisor can initiate a direct call. The direct call appears the same as an
inbound call that you receive on the Media tab.

In Outbound Contact, you can receive a direct call on each available telephone line that is
set up for your telephone. You can move between an outbound call and direct calls. Before
you can handle another Outbound Contact call, you must complete all new or incomplete

direct calls.

You will be notified that there is an incoming direct call. Outbound Contact displays a
message on the Outbound Contact tab.

When a direct call arrives, the telephone number and status appear on the Media tab.

If you are not currently on an outbound telephone call, you can answer the direct call using
the Softphone or telephone handset, or automatically when Auto Answer is set up.

To answer a direct call:

If you are currently handling an Outbound Contact or another direct call, follow this
procedure to answer a direct call:

1. If necessary, excuse yourself to the original customer.

2. Click the Media tab and place the original customer on hold. For more information, see
Placing a Voice Contact on Hold on page 89.

. Using the Answer button your the telephone, answer the direct call.
. When you are finished talking with the direct caller, click the Media tab.

. Click Hangup to end the direct call.

o 0~ W

. In the Wrap-up dialog box, select the appropriate category, reason, and outcome
codes for the direct call and click OK.

7. On the Media tab, select the original customer in the phone task list and click
Reconnect to retrieve the customer from being on hold.

8. Click the Outbound Contact tab.
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9. Complete the outbound call. For more information, see Completing a Call with the
Wrap-up Dialog Box on page 208.

10. Click Proceed on the toolbar to prepare for the next call.

Outbound Contact records the event and connects you with the next customer.

Transferring, Conferencing, and Consulting an Outbound Contact Call

You may need to transfer an outbound call or a direct call to another agent who is more
qualified to handle it, or to your supervisor to handle a customer who needs more attention.

You use the Media tab to transfer the call, conference the call with another agent, or
consult with another agent and transfer the call. Depending on the type of transfer,
Outbound Contact transfers the customer information to the person to whom you placed
the telephone call. For example:

e If you transfer, consult, or conference an Outbound Contact telephone call to another
Outbound Contact agent, the second Outbound Contact agent receives the transferred
call with the customer information. The transferred call appears like a direct call.

e If a customer places a direct call to your telephone set or if an agent transfers a direct
call to you, you do not receive the customer information.

For a description of each type of transfer, see Involving Other Agents in a Voice Contact on
page 90.

Note:

When transferring an Outbound Contact call, you must complete the call
using the Wrap-up dialog box available from the Outbound Contact tab.

To transfer an outbound call:

1. Tell the customer that you would like to transfer the call and explain the type of transfer
that you will do.

2. Transfer the call as indicated in Involving Other Agents in a Voice Contact on page 90.

3. If you are still connected to the customer after transferring the call, end the
conversation and hang up the connection.

4. Click the Outbound Contact tab to complete the call, using the Close and Proceed
toolbar buttons. For details, see
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Completing a Call with the Wrap-up Dialog Box

Before you complete a call, you must end your conversation, record the customer’s
responses, and update the customer information. To complete the call, you record the
result of the call using a category, result, and outcome code.

A\ cauTON:

If you do not complete the Wrap-up dialog box before you click Proceed,
your contact center will not have a record of the business outcome of the
call.

To complete and end the call:
1. Click Close on the toolbar.

Outbound Contact displays the Wrap-up dialog box, open to the Outbound Result
category.

2. Complete the Wrap-up dialog box. For details, see Wrapping Up Contacts on page 76.

a. Select one category code from the Categories field.
b. If appropriate, select one reason code from the Reasons field.

c. Select the appropriate outcome from the Outcomes field that describes the result of
the call. If you select more than one outcome code, Outbound Contact records the
first code you select and Operational Analyst will report on the first Outcome code
you select.

d. Click the down arrow to complete the selection.
e. Click OK.
Outbound Contact disables all buttons except Proceed.
3. Click Proceed on the toolbar when you are ready for the next call.
Outbound Contact ends the script and connects you with the next customer.

Depending on the dialing mode, you can preview the next customer’s information
before connecting with the customer.

Handling Nuisance Calls

If you see “Nuisance Call” in the message box when you speak with a customer, Outbound
Contact previously called the customer in predictive dialing mode during the job but there
was no agent available at that time to speak to the customer.

Tip:
During your conversation, you can apologize for the problem that caused
the nuisance call. Your supervisor can tell you exactly what you should say
to customers who have received a nuisance call.
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Going On and Off Break

When you go “on break,” you signal the Outbound Contact that you are unavailable to
handle additional outbound calls. When you want to resume handling outbound calls, you
go “off break” to signal the software that you are available for calls.

Taking a Break

You can indicate that you want to go “on break,” any time during the job while you are off
break. Your break becomes effective after you complete the conversation and end the
outbound or direct call.

To take a break:

e Click On Break on the toolbar.

Outbound Contact makes the Off Break button available indicating that you are unable to
handle outbound calls or speak with customers. The icon preceding the selected jobs in
the Available jobs field changes from an open blue lock to a crossed-out agent.

Returning to Work

After your break, you resume handling outbound calls or receiving direct calls by going “off
break.”

To return to work:

e Click Off Break on the toolbar.

Outbound Contact makes the On Break button available. The icon preceding the selected
jobs in the Available jobs field changes from a crossed-out agent to a open blue lock.

Leaving Outbound Jobs

You can leave one or more jobs at the same time. For example, you would leave a job
when your supervisor wants you to concentrate on a specific calling activity, you are going
on a break, or your workday is ending.
To leave a job:

1. Complete the current call.

2. Click On Break on the toolbar.

The icon preceding the selected jobs in the Available jobs field changes from an open
blue lock to a crossed-out agent once you are “on break.”
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3. Select the job or jobs you want to leave.

e To select a series of consecutive jobs, press the Shift key, and then click the first
and the last job name.

e To select more than one job individually, press the Control key while you click each
job name.

4. Click Leave Job.

The icon preceding the job in the Available jobs field changes from a crossed-out
agent to a closed red lock.
Note:

You are still logged in to Avaya Agent. You can continue to use the Avaya
Agent channels that are set in the Media tab.

Logging out of Outbound Contact
After you leave one or more outbound jobs, you can log out of Outbound Contact by
logging out of Avaya Agent.

For more information on logging out of Avaya Agent, see Logging Out of Avaya Agent on
page 46.

To log out of Outbound Contact:
1. Leave each outbound job.

2. On the Media tab, click Agent until the icon changes to Agent Aux status
(Unavailable).

3. On the Avaya Agent menu, select Exit.

Agent Blending

You might be assigned to handle work on inbound, email, and chat channels using the
Media tab and Outbound Contact calls using the Outbound Contact tab. If you are
available for all channels, Outbound Contact suspends you from working on any channel
except Outbound Contact when you are handling outbound calls. Similarly, when you
handle work on other channels, you cannot handle Outbound Contact work.

When handling Outbound Contact work, you can handle the outbound calls and receive
direct calls without handling inbound contacts on the Media tab.
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Outbound Contact alternates the activities you can do based on the skills assigned to you
and outbound jobs. Outbound Contact uses the Agent Blending parameters set for the
jobs to help determine:

e Whether you can blend your work across Outbound Contact and other channels
e When you move out of the Outbound Contact channel

e When you return to the Outbound Contact channel

Releasing You from Outbound Contact

When one of the other channels has a need for agents that are on outbound calling,
Outbound Contact puts you “on break” and “releases” you and other agents from the
outbound calling activities.

In this case, after you complete your current call, Outbound Contact performs the following
actions:

e Places you “on break” for each outbound job you joined
e Makes the Media tab active

When you are released from Outbound Contact, you can receive incoming contacts or
manage Outbound List contacts.

Acquiring You from Channels

When the other channels have an excess of agent capacity, Outbound Contact “acquires”
agents or makes some agents available for outbound calling again based on the job
requirements.

Avaya Agent performs the following actions so that Outbound Contact can acquire you:
e Displays the word “Outbound” below the status bar on the Media tab

e Resets your channel load for each channel to zero

e Moves you to the Outbound Contact tab

e Returns you to the jobs you originally joined

Note:

To join additional jobs, select each job in the Available jobs field. Then,
click Join Job.
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To resume your Outbound Contact activities:
e Click the Off Break button.
You can now resume handling automated outbound calls.

For more information, see Joining Outbound Jobs on page 196 and Making Yourself
Available for Outbound Contact Calls on page 197.

Example: Using Outbound Contact

In the following example, your supervisor assigned you to the Automobile Preference
campaign. One of the jobs you joined is named Auto Manufacturer. While handling calls
during this job, the job name is displayed in the field below the list of available jobs. During
this job, you speak with a potential customer who attended the annual Automobile Show.

The example assumes you are capable of handling predictive calls and that all customers
are called using the predictive dialing mode. Outbound Contact calls each customer and
connects you with the customer and their information immediately. During your
conversation, you record their responses to the Show script.

The following is an example of the steps you complete:

1. Log in to Avaya Agent by selecting the Avaya Agent shortcut from the Windows Start
menu. For example, select Start > Programs > Avaya Interaction Center 7.0 >
Interaction Center.

The Avaya Agent Login dialog box is displayed.

2. On the Avaya Agent Login tab, type your login ID and password.
The Avaya Agent displays the agent desktop as follows:
e Contact History Browser displays prior contacts with the customer.
e EDU Viewer displays call information.
e Prompter displays the script you use during the job.

3. Click the Outbound Contact tab to begin your calling activities.

Outbound Contact displays a list of jobs that matches your skills.
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Example: Using Outbound Contact

Select the jobs your supervisor tells you to join in the Available jobs field and click
Join Job.

Outbound Contact joins you to the jobs and begins placing telephone calls to
customers.

Avaya Agent displays the customer's information on the Contact History Browser,
Prompter, and EDU Viewer tabs. The software displays the customer number in each.

The toolbar buttons (Accept, Reject, Reschedule, Do Not Call, Close, and Proceed)
become enabled.

. Greet the customer and click the Prompter tab.

Avaya Agent displays the Show script, a simple survey of prospective car buyers, in
the Prompter.

. During your conversation, you read the script and record the customer’s answers.

Soon after you begin your conversation, the customer asks you to reschedule the call
later in the week, any time after 5 p.m. The customer asks to speak with you, not
another agent, on the rescheduled call.

. Before closing your conversation, click the Reschedule button on the toolbar to set up

when the customer would like to be called back later in the week (any time after 5
p.m.). Indicate that the customer would like to speak with you.

a. Reschedule the date and time of the call on the Date and Time tab.

b. Click your name on the list on the Assign Agent tab, and click OK.

. To complete the call and speak with the next customer, click Proceed on the toolbar.

Outbound Contact displays new customer information on the desktop as it connects
you with the customer.

. During the next call, the customer requests to be put in the contact center’s Do Not Call

list for this campaign.

a. End the conversation.

b. Click Do Not Call on the toolbar.

c. Provide an explanation for this request and click OK.

To complete the call and speak with the next customer, click Proceed on the toolbar.

After two hours, it is time for your morning break. You want to make yourself
unavailable to speak with customers but you do not want to leave any of the jobs.

Click On Break on the toolbar.

At the end of the current call, Outbound Contact updates the icons that are associated
with each job you joined. A crossed-out agent replaces the blue open lock.

When you return from your morning break, click Off Break on the toolbar.

Outbound Contact updates the icons that precede each job replacing the crossed-out
agent with the blue open lock.
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13. When you complete your calling activity, you complete your call, make yourself
unavailable for outbound calls, and leave the jobs, as follows:

a. Click On Break on the toolbar.
b. If there is a current call, complete the call and click Proceed on the toolbar.

c. On the Outbound Contact tab, select the jobs to leave from the Available jobs
field.

d. Click Leave Job.

Outbound Contact removes you from each job. As you leave a job, the software
changes the icon that precedes the job from a crossed-out agent to a red closed
lock.
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The Outbound List Processing component of Avaya Agent handles customer lists for
outbound campaigns that you dial manually. With Outbound List Processing, you initiate
telephone calls using Softphone.

Note:

Do not confuse Outbound List Processing with Avaya™ Outbound Contact
Management. You make outbound calls manually using the Outbound Lists
tab. You handle automated outbound calls using the Outbound Contact

tab, described in Chapter 7: Handling Outbound Contact Calls on page 193.

This chapter contains the following topics:
e Overview of Outbound List Processing
e Making Calls with Outbound Lists

Overview of Outbound List Processing

Your system administrator can create multiple customer lists in ListQ. These lists pass to
the Outbound Lists tab. Each outbound list contains a group of customers who are
related, such as customers who are located in the same area or who purchased the same
product. You may use the outbound lists during outbound campaigns to call customers and
notify them about upcoming sales and marketing events.

When you select an outbound list, Outbound List Processing selects the first customer on
the list and displays basic information about that customer on the Outbound Lists tab.
The lists provide you with information like the following, which you can use during your
interaction with the customer:

e Campaign name
e Marketing event
e List name

e Customer information
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When you click the Avaya Agent Outbound Lists tab, the display looks like this:

Media Outbound Lists |

Campaign: /
IEvergreen

Marketing Event:

IEvergreen gum dizcount 4— 3

List Name:

ISupermarke’( Weekly Bingo \
4

Customer Infa:

2

M= . Prunella Scales
46 Harper Drive
Milwaukee, W STIES 3 5

[212) 675-4930

1 —P- Call Count: ID_
Last Call Attempt Info:
Mo Previous Calls 6
Result:
[<Select When Firished- ~jl—— 7

1. The number of times this customer has been called from this particular list
2. The name of the marketing campaign associated with this list
3. The name of the specific marketing event associated with this list
4. The name of the list
5. Customer’s name with some brief details selected by the system administrator
6. Information about the previous call
made to this customer
7. When the call is completed, click a result from this drop down list
8. List Management buttons
9. Next Customer button

10. Place Call button
11. Done button
12. Cancel icon

As you complete calls to customers, Outbound List Processing cycles through the next

customers in the list. The Outbound Lists tab displays the name of the associated
campaign, the marketing event, the list name, and the customer information.
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Depending on how your system administrator configured Avaya Agent, Outbound List
Processing may also do the following:

e Sort the lists by priority and select a customer from the highest priority list

e Set the maximum number of times to call a customer for a specific list, and when that

limit is reached, set the customer’s status to Unreachable and not call the customer
again

e Set the length of time between attempts to call a customer if the result of a call is Busy,
Answering Machine, or No Answer

Note:

If your system administrator set up the list to coordinate with ListQ, you can
view the customer’s record information in ListQ.

Making Calls with Outbound Lists

If you are using Outbound List Processing, you use a list of customers in the Outbound
Lists tab and Softphone to make calls.

To use Outbound List Processing to contact customers:

1. Log in to Avaya Agent. For logging in details, see Logging In and Logging Out on
page 41.

2. Click the Outbound Lists tab and bring that component to the front.
3. To start your call, click Next Customer.

Outbound List Processing selects the first customer from the list and fills the
Outbound Lists tab with the customer’s information. Depending on your system
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configuration, Avaya Agent may display the customer record information or leave the
customer list information visible in the appropriate ListQ focus.

B Customer/List Administration(2) M= B3 |] [\iessa sg'wj
Focus Edit Wiew Tools Window Help
Media DuthoundL\slsI
p = - = = j EEgial
4&4"5|@ﬂ|§%|ﬂ§$m‘&?ﬂ@m £:§||7‘D Campaign:
,ListiList Member Events, Evergreen

Marketing Event:

[Everareen gum discount

List Name:

Supermarket Weekly Bingo C:

<Al customes Info:
4] v [\ List A Costorner A Address /A Organization /. Ial | ¥ [ Ms. Prunela Scales
“List 46 Harper Drive
_ (| T =
Mame ISupermarket YWeekly Bingo Card Status | 1-4ctive 'I
- Q 212) B75-4930
Marketing Event |Evergreen gum discount C] Fricrity | 4-Critical 'I ‘ 12
Target |Outbuund List#1 E] Mext Call Delay Ij_ Minutes vI Impoit Customers
o - |0
Script |Cnﬂee Preference Quiz C] Callback Limit Iz_ Call Count: l_
(Assigned Agents List Members Last Call Attempt Info:
Agent | Status Customer | Status | Next Call o Previous Cals
Gina Tato| 1-Active Prunella Scales | 1-Callable
Ralph Vawter | 1-Callable
Beth Prima 1-Callable —_—
Assigned Work, Result
ssigned Warkgroups <Select Vhen Finishsd- =
‘Workgroup | Status
=SB0
Customer Address
| o | ot s (o e )
| Recondis] Updated \ | Tuesday 5/3/00 1053 4 |
sl
8

k] e
& [subiect [Time [Tupe ﬁ

4. To dial your call to the customer, click the Place Call button.
5. When the customer answers, read the script in Prompter.

6. Record the customer’s information and responses in the script fields.
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7. Click the appropriate outcome of the conversation from the Result list.

Media Cutbound Lists |

Campaign:

IEvergreen

Marketing Event:
|Evergreen gum discount

List Name:

ISupermarket ‘Weekly Bingo C:

Customer Info:

Mz, Prunella Scales
46 Harper Drive
Milovaukes, Wi 57965

(212) 6754930

Call Count: IU_

Last Call Attempt Info:
Mo Previous Calls

Result:

1-Mizzion Accomplished
2-Busy

F-Answering Machine
4-Mio Ansswver
a-Request Callback
5-Remave From List

8. When you are finished, click the Done button.

9. To call the next customer on your list, repeat from Step 3.
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Appendix A: Troubleshooting

On occasion, Avaya Agent or one of its features may fail to work properly. Find the
description of your problem and follow the solution to return to normal

e Avaya Agent Problems on page 221

e Inbound Voice Problems on page 223

e Outbound Contact Problems on page 226

e Avaya Agent on Citrix Problems on page 229

Avaya Agent Problems

You may have the following problems with Avaya Agent. Carry out the listed solution for
each problem.

e Avaya Agent Stops Responding on page 221

e Avaya Agent and Java Plugin Control Panel Stop Responding on page 222

e Cannot Log In to Avaya Agent on page 223

Avaya Agent Stops Responding

Problem: Occasionally, you may have trouble with the display of the Avaya Agent. You
may not be able to use the software as you usually do.

Solution: You can restore the Avaya Agent to its normal condition by ending certain
processes that your computer’s operating system uses to support the Avaya Agent.

Note:

You must have administrative privileges to do the following procedure.
Contact your administrator if you do not have these privileges or if you need
assistance with the following procedure. If you cannot get an administrator’s
assistance, shut down your machine and restart it.
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To restore the Avaya Agent to its normal condition:

1. Exit from the Avaya Agent if you can.

Note:

If you cannot exit from the Avaya Agent, open the Windows Task Manager
and end the application task.

. Open the Windows Task Manager.
. In turn, end the qui, vtel, and mshta processes.

. Log in to the Avaya Agent.

a A~ O N

. If the Avaya Agent is too large, take the following steps:

a. Hold your cursor over the Windows task bar until you see an arrow with two ends,
one pointing up and one pointing down.

b. Click your mouse and drag the cursor upwards, until the task bar becomes larger.
c. Repeat Step a.

d. Click your mouse and drag the cursor downwards, until the task bar returns to its
original size.

The Avaya Agent should operate correctly and it should be the normal size again.

Note:
If the Avaya IC system had a problem and was restarted, you may see
Switch To/Retry dialog boxes. If this happens, you should not click your
mouse. Instead, you should sit and wait a moment or two to give the system
a chance to recover.

Avaya Agent and Java Plugin Control Panel Stop Responding
Problem: After you log into Avaya Agent then open the Sun JVM control panel, both
Avaya Agent and the Sun JVM control panel stop responding.

Solution: To restore Avaya Agent to its normal condition, set the Hardware Acceleration
display setting to None for your machine.

Note:
You may need administrative privileges to do the following procedure.

Contact your administrator if you do not have these privileges or if you need
assistance with the following procedure.
To restore Avaya Agent to its normal condition:
1. Select Start > Settings > Control Panel to open the Windows Control Panel.

2. Double-click Display.

222 Avaya Agent User Guide



Inbound Voice Problems

. In the Display Properties dialog box, select the Settings tab.
. In the Settings tab, select Advanced.

. In the monitor dialog box, select the Troubleshoot tab.

o 0 B~ W

. Click the slider for Set Hardware Acceleration, and drag it all the way to the left until it
is next to None.

7. Select OK.
8. Select OK.

9. Close the Control Panel.

Cannot Log In to Avaya Agent

Problem: After a problem that caused you to exit Avaya Agent, you attempt to log back in
to Avaya Agent. You see the Core Server(s) Failure Notification dialog box.

Solution: You may need to use the Windows Task Manager to kill the vtel process before
you can log back in. Ask your administrator how to do this.

Inbound Voice Problems

You may have the following problems when managing your inbound voice contacts. Carry
out the listed solution for each problem.

e Cannot Log Into Telephony Server

e Current Voice Contact Not Highlighted

e Core Server Failure

e Agent State Changed When Logging In After Server Error

e Unavailable for Voice After Server Error

e Cannot Answer a Consult Transfer

e Softphone Stops Responding

Note:

If you are using a DEFINITY telephone switch with the Auto-In mode, see
Using the Auto-In Work Mode on page 87 for troubleshooting information.
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Cannot Log Into Telephony Server

Problem: When you log into Avaya Agent, you receive the message "Must LoginVESP
before LoginTelephony".

Solution: Contact your system administrator. Either the VESP server or the EDU server is
not responding, and Avaya IC cannot access the telephony server.

Current Voice Contact Not Highlighted

Problem: If you move your cursor away from the Phone task list, the current voice contact
is no longer highlighted.

Solution: Even when the active contact is not highlighted, you can tell which contact is the
active contact by the angle bracket.

Core Server Failure

Problem: You see the Core Server(s) Failure Notification dialog box.
Solution: Do the following steps to try to restore the connection to the servers:
1. Complete any active calls and hang up.
2. Click Retry in the dialog box.

3. If the connection to the servers is restored, the text in the dialog box says "Avaya
Agent has successfully reconnected with the "Core Servers." If you see this message,
click OK.

4. If the connection to the servers is not restored, click Retry again.

5. If the connection is still not restored, contact your administrator.

CTI - Server Failure in Phone Task List

Problem: You see CTI - Server Failure in your Phone task list.

Solution: The message informs you that there may be a Telephony issue. To fix this
problem, reset your softphone by right-clicking and selecting Softphone - Reset. If the
problem persists, log out of Avaya Agent and log back in.

If you still see the CTI - Server Failure message when you log back in, contact your
administrator.
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Agent State Changed When Logging In After Server Error

Problem: After a Telephony Server failure, you log out and log back in. Your Voice channel
is not in the same state that it was in before the server error.

Solution: Your Voice channel will be in the state that it is always in when you log in.
Change your state back to what it was before the error. If you were in WrapUp state before
the server error, select the voice contact and enter the necessary data in the Wrap-up
dialog box or the Prompter script. You will need to re-enter any data that was not saved
before the server error.

Unavailable for Voice After Server Error

Problem: You see Core Server(s) Failure Notification dialog box and you click the Retry
button. When the connection is restored, you click the Agent button and the icon changes
to Available. However, the Status Control bar shows that you are still Unavailable for
Voice.

Solution: Contact your administrator.

Solution: To fix this problem, reset your softphone by right-clicking and selecting
Softphone - Reset. If the problem persists, log out of Avaya Agent and log back in.

If you are still listed as Unavailable for Voice when you log back in, contact your
administrator.

Cannot Answer a Consult Transfer

Problem: In the situation described below, you may not be able to complete a Consult
Transfer to another agent, or another agent may not be able to complete a Consult
Transfer to you. (Consult Transfers are described in Involving Other Agents in a Voice
Contact on page 90.)

1. An agent tries to transfer a voice contact to you with the Consult feature, but for some
reason cancels the transfer.

2. You get a Wrap-up dialog box for the transferred contact but leave the dialog box
open.

3. The same agent tries again to do a Consult transfer to you.
4. You cannot answer the call because the Answer button never becomes enabled.

Solution: You must click OK in the Wrap-up dialog box. Then you will be able to answer
the call.
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Softphone Stops Responding

Problem: Softphone may not be able to perform a telephone operation or it may appear to
be "locked up" for a certain length of time.

Solution: If you use both your physical telephone and Softphone, the problem may be that
your Softphone and your physical telephone are set differently. To stop this problem from
happening again, ask your administrator to confirm that the preset state settings for your
physical telephone and Softphone are identical.

In other cases when your Softphone fails, you must take the following steps to re-establish
and synchronize the connection between Softphone and your physical telephone.

To reset the communication between your Softphone and the telephone:
1. If you are in a voice contact, complete your voice contact with the physical telephone.

2. Set your agent state to Unavailable. For information, see Changing Your Agent
State on page 51.

Note:

The Softphone - Reset option clears all current activity from the Softphone
and terminates all calls. You must complete Steps 1 and 2 before using
Softphone - Reset.

3. Right-click in an empty part of the Avaya Agent.
4. In the pop-up menu, click Softphone - Reset.
5. Click OK.

If this does not resolve the problem, contact your administrator.

Outbound Contact Problems

You may have the following problems when managing your Outbound Contact calls. Carry
out the listed solution for each problem.

e Avaya Agent Stops During Outbound Contact Calls

e Error Message During Outbound Contact Calls

e No licence available for Outbound Contact

e Network communications error after log in
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Avaya Agent Stops During Outbound Contact Calls

Problem: The Avaya Agent suddenly stops working or suddenly exits while you are
making calls with Outbound Contact.

Solution: Take the following steps.

To restore Avaya Agent and return to your Outbound Contact jobs:
1. Exit from Avaya Agent if it is running and if you exit.
Note:

If you cannot exit from the Avaya Agent, open the Windows Task Manager
and end the application task.

2. Log in to Avaya Agent.

3. If you get an error message when trying to log back in, wait a moment and then try
again.

4. Change your agent state for the incoming media channels.

5. Select and join jobs, as you did before.

Error Message During Outbound Contact Calls

Problem: Occasionally, when handling Outbound Contact telephone calls, the contact
center’s Telephony Server may shut down and restart while you are handling an Outbound
Contact call. When this occurs, Avaya Agent displays a Core Communication Failure
Notification in a dialog box.

Solution: To rejoin your Outbound Contact jobs, take the following steps.

To continue handling predictive outbound calls:

1. End your conversation with the customer normally and hang up the call using the
physical telephone.

2. In the error message dialog box, click Retry.

3. If the application displays a dialog box with additional notification messages, click
Retry.

4. Log in to Outbound Contact. Complete Steps 4a through 4c.
a. Click the Media tab.
b. Click Agent until the button changes to Aux-work (Busy).
c. Click the Outbound Contact tab.
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5. Select the jobs you were working on, as follows:
a. Select the jobs from the Available jobs field.
b. Click Join Job.

6. Click Off Break on the toolbar to receive outbound calls.

No licence available for Outbound Contact

Problem: When you log in to Avaya Agent, you receive a message box that states there is
no license available and that asks you whether you want to continue to log in.

Solution: Take the following steps.

Tip:
If you select the No option and receive a network communications error from
Outbound Contact, see Network communications error after log in on
page 228.

To log in to Outbound Contact:
1. Select the Yes option to stop the current log in attempt.
2. Log back in to Avaya Agent.

3. If you receive the same message box, advise your supervisor that you cannot work in
Outbound Contact because there is no license available.

Network communications error after log in

Problem: After you log in to Avaya Agent to work on an Outbound Contact job in automatic
dialing mode, all buttons on the Outbound Contact toolbar are available, including buttons
for preview dialing mode. However, when you select a button, you receive the following
error:

Critical Error: A critical network communications error occurred. Either a
communication error was between the application and the dialer or within the dialer.
Retry the action. If this error occurs again, contact your system administrator.

Solution: This error typically appears when you log in to Avaya Agent when no licenses
are available.
To resolve network communications error in Outbound Contact:

1. Log out of Avaya Agent.

2. Log back in to Avaya Agent.
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3. If you see a message box that states there is no license available, select the Yes
option to stop the current log in attempt.

4. Advise your supervisor that you cannot work in Qutbound Contact because there is no
license available.

Avaya Agent on Citrix Problems

Problem: You can have an issue with maximizing Avaya Agent after you minimize the
application.

Solution: To resolve this issue:
1. Right-click on the minimized Avaya Agent application.

2. Select Close from the menu.

3. When Avaya Agent maximizes, in the dialog box that asks to confirm the exit, select
No.
All future minimization and maximization actions of Avaya Agent will work as expected.
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